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Notes, Notices, and Cautions
 NOTE: A NOTE indicates important information that helps you make better use of 

your Tablet-PC. 

 NOTICE: A NOTICE indicates either potential damage to hardware or loss of data 
and tells you how to avoid the problem.

 CAUTION: A CAUTION indicates a potential for property damage, personal injury, 
or death.

____________________

Information in this document is subject to change without notice.
© 2007–2008 Dell Inc. All rights reserved.

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly 
forbidden.

Trademarks used in this text: Dell, the DELL logo, Latitude, TravelLite, Wi-Fi Catcher, and  
ExpressCharge, are trademarks of Dell Inc.; Intel, Pentium, and Celeron are registered trademarks of 
Intel Corporation; Bluetooth is a registered trademark owned by Bluetooth SIG, Inc. and is used by 
Dell under license; TouchStrip is a trademark of Zvetco Biometrics, LLC; Blu-ray Disc is a trademark 
of the Blu-ray Disc Association; Microsoft, Windows, Windows Server, MS-DOS, Aero, Windows Vista. 
and the Windows Vista start button are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Other trademarks and trade names may be used in this document to refer to either the entities claiming 
the marks and names or their products. Dell Inc. disclaims any proprietary interest in trademarks and 
trade names other than its own.
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1
Resources

Finding Information
 NOTE: Some features or media may be optional and may not ship with your 

Tablet-PC. Some features or media may not be available in certain countries.

 NOTE: Additional information may ship with your Tablet-PC.

What Are You Looking For? Find It Here

• A diagnostic program for my Tablet-PC

• Drivers for my Tablet-PC 

• My device documentation

Drivers and Utilities Media

NOTE: The Drivers and Utilities media may 
be optional and may not ship with your 
Tablet-PC 
Resources 13
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• Notebook System Software (NSS) Documentation and drivers are already 
installed on your Tablet-PC. You can use 
the Drivers and Utilities media to reinstall 
drivers (see "Reinstalling Drivers and 
Utilities" on page 146) or to run the Dell 
Diagnostics (see "Dell Diagnostics" on 
page 121).

Readme files may be included on your 
media to provide last-minute updates 
about technical changes to your 
Tablet-PC or advanced technical-
reference material for technicians or 
experienced users.

NOTE: 
Drivers and documentation updates can be 
found at support.dell.com.

What Are You Looking For? Find It Here
14 Resources



book.book  Page 15  Tuesday, May 13, 2008  5:03 PM
• How to set up my Tablet-PC

• Basic troubleshooting information

• How to run the Dell Diagnostics

Quick Reference Guide

NOTE: This document may be optional and 
may not ship with your Tablet-PC.

NOTE: This document is available as a PDF 
at support.dell.com.

• Warranty information

• Terms and Conditions (U.S. only)

• Safety instructions

• Regulatory information

• Ergonomics information

• End-User License Agreement

Dell™ Product Information Guide

What Are You Looking For? Find It Here
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• How to set up my Tablet-PC

• Summary of your Tablet-PC features

• Available accessories for your Tablet-PC

Quick Reference Card

NOTE: This document is available as a PDF 
at support.dell.com. This publication may 
not be included with your system. 

What Are You Looking For? Find It Here
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• Service Tag and Express Service Code 

• Microsoft® Windows® License Label

Service Tag and Microsoft® Windows® 
License

NOTE: Your Tablet-PC’s Service Tag label is 
located on the bottom of your Tablet-PC 
near the memory and Mini-Card cover (see 
"Bottom View" on page 40).

NOTE: You can also find your Service Tag 
information through the System Setup 
program. See "System Setup Screens" on 
page 142.

Your Tablet-PC’s Service Tag contains 
both a Service Tag number and an Express 
Service Code.

• Use the Service Tag to identify your 
Tablet-PC when you use 
support.dell.com or contact support. 

• Enter the Express Service Code to direct 
your call when contacting support.

NOTE: Your Tablet-PC’s Microsoft® 
Windows® License label is located under 
the main battery in the battery bay of your 
Tablet-PC (see "Removing the Main Battery" 
on page 158).

• Use the product key on the license label 
if you need to reinstall your operating 
system.

NOTE: As an increased security measure, 
the newly designed Microsoft Windows 
license label incorporates a missing portion 
or "hole" to discourage removal of the label. 

What Are You Looking For? Find It Here
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• Solutions — Troubleshooting hints and 
tips, articles from technicians, online 
courses, and frequently asked questions

• Community — Online discussion with 
other Dell customers

• Upgrades — Upgrade information for 
components, such as the system 
memory, the hard drive, and the 
operating system

• Customer Care — Contact information, 
service call and order status, warranty, 
and repair information

• Service and Support — Service call 
status and support history, service 
contract, online discussions with 
technical support

• Dell Technical Update Service — 
Proactive e-mail notification of software 
and hardware updates for my Tablet-PC

• Reference — Tablet-PC documentation, 
details on my Tablet-PC configuration, 
product specifications, and white papers

• Downloads — Certified drivers, patches, 
and software updates

Dell Support Website — support.dell.com

NOTE: Select your region or business 
segment to view the appropriate support 
site.

• Notebook System Software (NSS) — If 
you reinstall the operating system for 
your Tablet-PC, you should also reinstall 
the NSS utility. NSS provides critical 
updates for your operating system and 
support for processors, optical drives, 
USB devices, and so on. NSS is necessary 
for correct operation of your Dell 
Tablet-PC. The software automatically 
detects your Tablet-PC and operating 
system, and installs the updates 
appropriate for your configuration.

To download Notebook System Software:
1 Go to support.dell.com and click 

Drivers & Downloads.
2 Enter your Service Tag or Product Type 

and Product Model, and click Go. 
3 Scroll to System and Configuration 

Utilities→ Dell Notebook System 
Software and click Download Now.

4 Select Drivers & Downloads and click 
Go.

NOTE: The support.dell.com user interface 
may vary depending on your selections.

What Are You Looking For? Find It Here
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• Software upgrades and troubleshooting 
hints — Frequently asked questions, hot 
topics, and general health of your 
computing environment

Dell Support Utility (Windows Vista®) 

The Dell Support Utility is an automated 
upgrade and notification system installed 
on your Tablet-PC. This support provides 
real-time health scans of your computing 
environment, software updates, and 
relevant self-support information. Access 
the Dell Support Utility from the 
icon in the Windows Notification area. For 
more information, see "Dell Support Utility 
for Windows Vista" on page 125.

• How to find information about your 
Tablet-PC and its components

• How to connect to the Internet

• How to add user accounts for different 
people

• How to transfer files and settings from 
another Tablet-PC

Windows Welcome Center

The Windows Welcome Center 
automatically appears when you use the 
Tablet-PC for the first time. You can 
choose to have it appear every time you 
start your Tablet-PC, or turn it off. Once 
turned off, to access the Welcome Center:

• Windows Vista — Click Start → 
Welcome Center.

• Windows XP — Click Start→ Help and 
Support→ Welcome to Tablet PC. 

• How to use Microsoft Windows Vista 
and Windows XP

• How to work with programs and files

• How to personalize my desktop

Windows Help and Support
1 Click Start  (or Start in Windows 

XP)→ Help and Support.
2 In Search Help, type a word or phrase that 

describes your problem, and then press 
<Enter> or click the magnifying glass.

3 Click the topic that describes your 
problem.

4 Follow the instructions on the screen.

What Are You Looking For? Find It Here
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• Information on tablet features and 
functionality, network activity, the Power 
Management Wizard, hotkeys, and 
other items controlled by Dell QuickSet

Dell QuickSet Help

To view Dell QuickSet Help, press the 
QuickSet tablet settings button (see "Front 
View" on page 27), or right-click the 
QuickSet icon in the Microsoft® 
Windows® Notification area, and select 
Help. The Windows Notification area is 
located in the lower-right corner of your 
screen.

• How to reinstall my operating system Operating System Media

The operating system is already installed 
on your Tablet-PC. To reinstall your 
operating system, use the Operating 
System media. See "Reinstalling the 
Operating System" on page 152.

After you reinstall your operating system, 
use the Drivers and Utilities media to 
reinstall drivers for the devices that came 
with your Tablet-PC.

Your operating system product key is on 
the Microsoft® Windows® License Label 
located in your Tablet-PC’s main battery 
bay (see "Removing the Main Battery" on 
page 158).

NOTE: The color of your media varies 
based on the operating system you ordered.

What Are You Looking For? Find It Here
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Getting Help

Obtaining Assistance

 CAUTION: Before working inside your Tablet-PC, follow the safety instructions 
located in the Product Information Guide.

If you experience a problem with your Tablet-PC, complete the following steps 
to troubleshoot and diagnose the problem:

1 See "Troubleshooting" on page 121 for information and procedures that 
pertain to the problem your Tablet-PC is experiencing.

2 Run Dell Diagnostics. See "Dell Diagnostics" on page 121.

3 Fill out the "Diagnostics Checklist" on page 25. This checklist helps you to 
organize information Dell’s support services will need to troubleshoot your 
Tablet-PC.

4 Use Dell's extensive suite of online services available at Dell Support 
(support.dell.com) for help with installation and troubleshooting 
procedures. See "Online Services" on page 22 for a more extensive list of 
Dell Support online services and features.

5 If the preceding steps have not resolved the problem, see "Contacting 
Dell" on page 26.

 NOTE: Call Dell Support from a telephone at or near the Tablet-PC so that the 
support staff can assist you with any necessary procedures.

 NOTE: Dell's Express Service Code system may not be available in all countries.

When prompted by Dell's automated telephone system, enter your 
Express Service Code to route the call directly to the proper support 
personnel. If you do not have an Express Service Code, open the Dell 
Accessories folder, double-click the Express Service Code icon, and follow 
the directions.

For instructions on using the Dell Support, see "Technical Support and 
Customer Service" on page 22.

Dell Support Service

 NOTE: Some of the following services are not always available in all locations 
outside the continental U.S. Call your local Dell representative for information on 
availability.
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Technical Support and Customer Service

Dell's support service is available to answer your questions about Dell™ 
hardware. Our support staff uses Tablet-PC-based diagnostics to provide fast, 
accurate answers.

To contact Dell's support service, see "Before You Call" on page 24, and then see 
the contact information for your region or go to support.dell.com.

DellConnect

DellConnect is a simple online access tool that allows a Dell service and support 
associate to access your Tablet-PC through a broadband connection, diagnose 
your problem and repair it all under your supervision. For more information, go 
to support.dell.com and click DellConnect.

Online Services

You can learn about Dell products and services on the following websites:

www.dell.com

www.dell.com/ap (Asian/Pacific countries only)

www.dell.com/jp (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la (Latin American and Caribbean countries)

www.dell.ca (Canada only)

You can access Dell Support through the following websites and e-mail 
addresses:

• Dell Support websites

support.dell.com

support.jp.dell.com (Japan only)

support.euro.dell.com (Europe only)

• Dell Support e-mail addresses

mobile_support@us.dell.com 

support@us.dell.com 

la-techsupport@dell.com (Latin America and Caribbean countries only)
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apsupport@dell.com (Asian/Pacific countries only)

• Dell Marketing and Sales e-mail addresses

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your e-mail address as your password.

AutoTech Service

Dell's automated support service—AutoTech—provides recorded answers to the 
questions most frequently asked by Dell customers about their portable and 
desktop computers.

When you call AutoTech, use your touch-tone telephone to select the subjects 
that correspond to your questions. For the telephone number to call for your 
region, see "Contacting Dell" on page 26.

Automated Order-Status Service

To check on the status of any Dell products you have ordered, you can go to 
support.dell.com, or you can call the automated order-status service. A 
recording prompts you for the information needed to locate and report on your 
order. For the telephone number to call for your region, see "Contacting Dell" on 
page 26.

Problems With Your Order
If you have a problem with your order, such as missing parts, wrong parts, or 
incorrect billing, contact Dell for customer assistance. Have your invoice or 
packing slip handy when you call. For the telephone number to call for your 
region, see "Contacting Dell" on page 26.

Product Information
If you need information about additional products available from Dell, or if you 
would like to place an order, visit the Dell website at www.dell.com. For the 
telephone number to call for your region or to speak to a sales specialist, see 
"Contacting Dell" on page 26.
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Returning Items for Warranty Repair or Credit
Prepare all items being returned, whether for repair or credit, as follows:

1 Call Dell to obtain a Return Material Authorization Number, and write it 
clearly and prominently on the outside of the box.

For the telephone number to call for your region, see "Contacting Dell" on 
page 26.

2 Include a copy of the invoice and a letter describing the reason for the 
return.

3 Include a copy of the Diagnostics Checklist (see "Diagnostics Checklist" 
on page 25), indicating the tests that you have run and any error messages 
reported by the Dell Diagnostics (see "Dell Diagnostics" on page 121).

4 Include any accessories that belong with the item(s) being returned 
(power cables, software, guides, and so on) if the return is for credit.

5 Pack the equipment to be returned in the original (or equivalent) packing 
materials.

You are responsible for paying shipping expenses. You are also responsible for 
insuring any product returned, and you assume the risk of loss during shipment 
to Dell. Collect On Delivery (C.O.D.) packages are not accepted.

Returns that are missing any of the preceding requirements will be refused at 
Dell’s receiving dock and returned to you.

Before You Call

 NOTE: Have your Express Service Code ready when you call. The code helps Dell’s 
automated-support telephone system direct your call more efficiently. You may also 
be asked for your Service Tag (located on the bottom of your Tablet-PC).

Remember to fill out the Diagnostics Checklist (see "Diagnostics Checklist" on 
page 25). If possible, turn on your Tablet-PC before you call Dell for assistance 
and call from a telephone at or near the Tablet-PC. You may be asked to type 
some commands at the keyboard, relay detailed information during operations, 
or try other troubleshooting steps possible only at the Tablet-PC itself. Ensure 
that the Tablet-PC documentation is available. 

 CAUTION: Before working inside your Tablet-PC, follow the safety instructions in 
your Product Information Guide.
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Diagnostics Checklist

Name:

Date:

Address:

Phone number:

Service Tag (bar code on the bottom of your Tablet-PC):

Express Service Code:

Return Material Authorization Number (if provided by Dell support technician):

Operating system and version:

Devices:

Expansion cards:

Are you connected to a network? Yes No

Network, version, and network adapter:

Programs and versions:

See your operating system documentation to determine the contents of the 
system’s start-up files. If the Tablet-PC is connected to a printer, print each file. 
Otherwise, record the contents of each file before calling Dell.

Error message, beep code, or diagnostic code:

Description of problem and troubleshooting procedures you performed:
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Contacting Dell
For customers in the United States, call 800-WWW-DELL (800-999-3355). 

 NOTE: If you do not have an active Internet connection, you can find contact 
information on your purchase invoice, packing slip, bill, or Dell product catalog. 

Dell provides several online and telephone-based support and service options. 
Availability varies by country and product, and some services may not be 
available in your area. To contact Dell for sales, technical support, or 
customer service issues:

1 Visit support.dell.com.

2 Verify your country or region in the Choose A Country/Region drop-down 
menu at the bottom of the page. 

3 Click Contact Us on the left side of the page.

4 Select the appropriate service or support link based on your need.

5 Choose the method of contacting Dell that is convenient for you.
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2
About Your Tablet-PC

 NOTICE: To avoid damaging your display, ensure that your Tablet-PC is in notebook 
mode and that the display is closed when you travel.

Front View

1 grip 2 display

3 ambient light sensor (with Dual-bulb 
CCFL LCD option only)

4 device status lights

5 digital array microphone 6 biometric reader

2

3

13

1

4

12

9

11
6

7

10

15

16

17

18

14

5

8

About Your Tablet-PC 27



book.book  Page 28  Tuesday, May 13, 2008  5:03 PM
G R I P — Use to open the display.

D I S P L A Y — For more information about your display, see "Using the Display" on 
page 87.

A M B I E N T  L I G H T  S E N S O R — Depending on the display option you chose when 
ordering your Tablet-PC, your Tablet-PC may or may not have an ambient light sensor. 
The ambient light sensor detects available environmental light and automatically 
increases or decreases the display backlighting to compensate for low-light and high-
light environments. Press <Fn> and the left-arrow key to enable or disable the sensor 
(see "Adjusting Brightness on the Dual-bulb (CCFL) LCD" on page 88).

D E V I C E  S T A T U S  L I G H T S

7 touch pad 8 touch pad buttons

9 track stick buttons 10 keyboard

11 track stick 12 rotating hinge

13 digital array microphone 14 power button

15 Windows® security button 16 screen rotate button

17 QuickSet tablet settings button 18 e-mail application shortcut button
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If the Tablet-PC is connected to an electrical outlet, the  light operates as follows:

• Solid blue: The battery is charging.

• Flashing blue: The battery is charged and in maintenance charge mode.

• Off: The battery is adequately charged (or external power is not available to charge the 
battery).

If the Tablet-PC is running on a battery, the  light operates as follows:

• Off: The Tablet-PC is turned off, or the system is running on battery power and the 
battery is adequately charged to sustain the system. 

• Flashing amber: The battery charge is low.

• Solid amber: The battery charge is critically low.

D I G I T A L  A R R A Y  M I C R O P H O N E — Digital directional microphones for conferencing 
and chat.

B I O M E T R I C  R E A D E R — Helps to keep your Dell™ Tablet-PC secure. When you slide 
your finger over the reader, it uses your unique fingerprint to authenticate your user 
identity. For information on how to activate and use the security management 
software that controls the biometric reader, see "Security Management Software" on 
page 116.

T O U C H P A D — Provides the functionality of a mouse (see "Touch Pad" on page 85).

T O U C H P A D B U T T O N S /T R A C K S T I C K  B U T T O N S — When you use the touch pad and 
track stick, use these buttons to move the cursor on the display (see "Customizing the 
Touch Pad and Track Stick or Pointer" on page 86).

Turns on when the Tablet-PC reads or writes data.

 NOTICE: To avoid loss of data, never turn off the Tablet-PC while the 
 light is flashing.

Turns on steadily or blinks to indicate battery charge status.

Turns on when wireless devices are enabled.

Turns on when Bluetooth® wireless technology is enabled. To enable or 
disable Bluetooth wireless technology, move the wireless switch to the "on" 
position (see "Dell Wi-Fi Catcher™ Network Locator" on page 109 for 
more information).

NOTE: Bluetooth wireless technology is an optional feature on your 
Tablet-PC, so the  icon turns on only if you ordered Bluetooth wireless 
technology with your Tablet-PC. For more information, see the 
documentation that came with your Bluetooth wireless device.
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K E Y B O A R D — The keyboard includes a numeric keypad as well as the Windows logo 
key. For information on supported keyboard shortcuts, see "Using a Keyboard" on 
page 82.

T R A C K  S T I C K — Provides the functionality of a mouse (see "Customizing the Touch 
Pad and Track Stick or Pointer" on page 86).

R O T A T I N G H I N G E — Rotate the hinge to transform the PC into tablet mode. See 
"Using Tablet Mode" on page 55.

P O W E R B U T T O N — Press the power button to turn on the Tablet-PC or exit a power 
management mode (see "Power Management Modes" on page 77).

 NOTICE: To avoid losing data, turn off your Tablet-PC by performing a Microsoft® 

Windows® operating system shutdown rather than by pressing the power button. 
See "Turning Off Your Tablet-PC" on page 155 for instructions on performing an 
operating system shutdown.

If the Tablet-PC stops responding, press and hold the power button until the 
Tablet-PC turns off completely (which may take several seconds).

The power button is surrounded by a backlit ring which is illuminated blue when you 
turn on the Tablet-PC, and blinks when the Tablet-PC is in a power-management 
mode.

W I N D O W S S E C U R I T Y  B U T T O N — If you are using your Tablet-PC in tablet mode, you 
can press the Windows security button to access the Windows Task Manager dialog 
box or a login screen, the same way you use the <Ctrl><Alt><Del> key 
combination in notebook mode. See "Using Tablet Buttons" on page 62 for more 
information.

S C R E E N R O T A T E  B U T T O N — While the Tablet-PC is in tablet mode, you can use the 
screen rotate button to change the display orientation from portrait to landscape 
mode. See "Using Tablet Buttons" on page 62 for more information.

Q U I C K SE T  T A B L E T  S E T T I N G  B U T T O N — Access Dell QuickSet to view and configure 
options for your Tablet-PC and pen. See "Using Tablet Buttons" on page 62 for more 
information.

E - M A I L  A P P L I C A T I O N  S H O R T C U T  B U T T O N — Launches your e-mail application. See 
"Using Tablet Buttons" on page 62 for more information.
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K E Y B O A R D S T A T U S L I G H T S

Three keyboard status lights on your Tablet-PC indicate when the following functions 
are activated by the corresponding key combination. 

Key 
Combination 

Function

<Fn><F4> Turns on when the numeric keypad is enabled. 
Located above the upper edge of the keyboard.

<Caps Lock> Turns on when the uppercase letter function is 
enabled. Located on the <Caps Lock> key.

<Fn><F5> Turns on when the scroll lock function is enabled. 
Located above the upper edge of the keyboard.
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Left Side View

P E N — To eject the pen from the compartment, press and release the end of the pen.

P E N I N D I C A T O R  LED — Indicates pen status. See "Ejecting and Storing the Pen" on 
page 65.

E X T E R N A L  W I R E L E S S  WAN A N T E N N A — If your Tablet-PC supports wireless wide 
area network (WWAN) connectivity, you must extend and orient the external WWAN 
antenna for optimal signal strength.

1 pen indicator LED 2 pen 

3 external wireless WAN antenna

NOTE: The external antenna is 
provided with WWAN cards only and 
is not included in the standard 
computer configuration. The 
computer comes with a plug that you 
need to remove prior to installing the 
antenna and WWAN card.

4 IEEE 1394 connector

5 USB connector 6 air vent

7 speaker

4 6 75321
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IEEE 1394  C O N N E C T O R  

USB C O N N E C T O R 

A I R  V E N T S — The Tablet-PC uses an internal fan to create airflow through the vents, 
which prevents the Tablet-PC from overheating.

 CAUTION: Do not block, push objects into, or allow dust to accumulate in the air 
vents. Do not store your Tablet-PC in a low-airflow environment, such as a closed 
briefcase, while it is running. Restricting the airflow can damage the Tablet-PC or 
cause a fire. The Tablet-PC turns on the fan when the Tablet-PC gets hot. Fan noise 
is normal and does not indicate a problem with the fan or the Tablet-PC.

S P E A K E R — To adjust the volume of the integrated speaker, use the volume-control 
keyboard shortcuts (see "Key Combinations" on page 82).

Connect FireWire devices, such as a camera, external hard 
drive, or external CD-ROM drive. Supports hot swapping, 
multiple speeds on the same bus, and time-based data 
transfer. This provides bandwidth for multimedia 
operations.

Connect USB devices, such as a mouse, keyboard, or 
printer.
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Right Side View

W I R E L E S S R A D I O  O N/O F F  S W I T C H — When enabled through Dell QuickSet, this 
switch can scan for a wireless local area network (WLAN) in your vicinity. You can also 
use it to rapidly turn off or on any wireless devices such as WLAN cards and internal 
cards with Bluetooth wireless technology (see "Dell Wi-Fi Catcher™ Network Locator" 
on page 109). When moved toward the front of the Tablet-PC, the switch is off; when 
moved toward the back of the Tablet-PC, the switch is on.

B A C K L I T  WI-F I  C A T C H E R ™ B U T T O N — Scans for WLAN networks (see "Dell Wi-Fi 
Catcher™ Network Locator" on page 109). The light operates as follows:

1 wireless radio on/off switch 2 Wi-Fi Catcher™ button

3 USB connector 4 ExpressCard slot

5 Secure Digital (SD) card slot 6 headphones connector

7 microphone connector 8 security cable slot

1 wireless radio on/off switch 2 Wi-Fi Catcher™ button

1 4 5 82 3 76

1 2
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• Flashing blue: Searching for networks

• Solid blue: Strong network found

• Solid yellow: Weak network found

• Flashing yellow: Error

• Off: Wireless radio switch is off, no signal is found, or Microsoft Windows is running. 

USB C O N N E C T O R 

E X P R E S S CA R D S L O T — Supports one ExpressCard, such as the optional smart-card 
reader. For more information, see "Using Cards" on page 89.

SE C U R E  DI G I T A L  (SD)  C A R D  S L O T — Supports one Secure Digital memory card, a 
storage device used in portable devices such as digital cameras, handheld computers, 
PDAs, and GPS units.

A U D I O  C O N N E C T O R S

Connect USB devices, such as a mouse, keyboard, or 
printer.

Attach headphones to the  connector. 

Attach a microphone to the  connector.
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S E C U R I T Y  C A B L E  S L O T — Lets you attach a commercially available antitheft device 
to the Tablet-PC (see "Security Cable Lock" on page 111).

Back View

1 AC adapter connector 2 video connector

3 tablet back button 4 scroll control button

5 network connector 6 powered USB connector

7 rotating hinge 8 tablet grip

9 pen tether slot

1 2 53 4 6 97 8
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AC A D A P T E R  C O N N E C T O R

The AC adapter converts AC power to the DC power required by the Tablet-PC. You 
can connect the AC adapter with your Tablet-PC turned either on or off.

 CAUTION: The AC adapter works with electrical outlets worldwide. However, 
power connectors and power strips vary among countries. Using an incompatible 
cable or improperly connecting the cable to the power strip or electrical outlet 
may cause fire or equipment damage.

 NOTICE: When you disconnect the AC adapter cable from the Tablet-PC, grasp the 
connector, not the cable itself, and pull firmly but gently to avoid damaging the 
cable. When you wrap the AC adapter cable, ensure that you follow the angle of the 
connector on the AC adapter to avoid damaging the cable.

Connects an AC adapter to the Tablet-PC.
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V I D E O C O N N E C T O R

T A B L E T  B A C K  B U T T O N — Use to navigate while in tablet mode. See "Using the Back 
Button" on page 62. 

S C R O L L  C O N T R O L  B U T T O N — Use to navigate while in tablet mode. See "Using the 
Scroll Control" on page 62.

 NOTICE: To avoid damaging the Tablet-PC, do not plug a telephone line into the 
network connector or USB connectors.

N E T W O R K C O N N E C T O R  (RJ-45)

P O W E R E D  USB C O N N E C T O R

R O T A T I N G H I N G E — Converts Tablet-PC between notebook and tablet modes.

P E N T E T H E R  S L O T — Use to connect a tether between the Tablet-PC and the pen.

Connects video devices, such as a monitor.

Connects video devices, such as a monitor.

Connects video devices, such as a monitor.
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Top View

Turns on steadily or blinks to indicate battery charge status.

Turns on when you turn on the Tablet-PC and blinks when the Tablet-PC is 
in a power management mode.
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Bottom View

 NOTE: Your Tablet-PC’s Microsoft® Windows® License label is located under the 
main battery in the battery bay of your Tablet-PC (see "Removing the Main Battery" 
on page 158).

A I R  V E N T S — The Tablet-PC uses an internal fan to create airflow through the vents, 
which prevents the Tablet-PC from overheating.

1 air vent 2 docking-device connector

3 memory module and Mini-Card 
cover

4 fan vent

5 main battery 6 battery-bay latch releases (2)

7 battery charge gauge/health gauge 8 battery bay (beneath main battery)

2 3

6

4

7

5

1

8
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 CAUTION: Do not block, push objects into, or allow dust to accumulate in the air 
vents. Do not store your Tablet-PC in a low-airflow environment, such as a closed 
briefcase, while it is running. Restricting the airflow can damage the Tablet-PC or 
cause a fire. The Tablet-PC turns on the fan when the Tablet-PC gets hot. Fan noise 
is normal and does not indicate a problem with the fan or the Tablet-PC.

D O C K I N G- D E V I C E  C O N N E C T O R — Lets you attach your Tablet-PC to a media base or 
battery slice. See "Docking Your Tablet-PC to the Media Base" on page 211 and 
"Docking Your Tablet-PC to the Battery Slice" on page 219 for more information.

M E M O R Y  M O D U L E  A N D M I N I -CA R D C O V E R — Covers the compartment that 
contains the memory module and any Mini-Cards installed on your Tablet-PC (see 
"Memory" on page 42 and "Communications" on page 43).

B A T T E R Y C H A R G E  G A U G E / H E A L T H  G A U G E — Provides information on the battery 
charge (see "Checking the Battery Charge" on page 74).

B A T T E R Y — When a battery is installed, you can use the Tablet-PC without 
connecting the Tablet-PC to an electrical outlet (see "Using a Battery" on page 73).

B A T T E R Y- B A Y  L A T C H  R E L E A S E S — Release the battery (see "Before Working Inside 
Your Tablet-PC" on page 156 for instructions). 

Pen View 

1 right-click pen button 2 erase pen button 3 pen tether slots

3

1

2
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Specifications
 NOTE: Offerings may vary by region. For more information regarding the 

configuration of your Tablet-PC, click Start  (or Start in Windows XP)→ Help and 
Support, and then select the option to view information about your Tablet-PC.

Processor

Processor type Intel® Core™ Duo or Intel® Core™ Solo 

L1 cache 64 KB (internal) each processor core

L2 cache up to 4 MB

External bus frequency 533 MHz or 667 MHz

System Information

System chipset AMD RS600ME/SB600

Data bus width 64 bits

DRAM bus width 64 bits

Processor address bus width 32 bits

Flash EPROM 2 MB

PCI bus 32 bits

Memory

Integrated memory on system board 1 GB

Optional memory:

Memory module connector one user-accessible SODIMM socket

Memory module capacities 1 GB and 2 GB

Maximum system memory capacity 3 GB

Memory type 3.3-V SODIMM

Storage

Internal hard drive:

Form factor 1.8-inch PATA HDD or optional 1.8-inch 
PATA Solid State HDD
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Speed 4200-rpm

Max size 100 GB

32 GB (optional 1.8-inch PATA Solid State 
HDD only)

Dell D/Bay (external):

Power requirement powered USB port

Optical drive support CD-ROM, DVD+/-RW, DVD-ROM

Ports and Connectors

Audio microphone connector, stereo 
headphone/speakers connector

IEEE 1394 4-pin serial connector

Mini-card two Mini-card slots

Network adapter RJ-45 port

USB two 4-pin USB 2.0-compliant connectors

Powered USB 5-pin power supply and 4-pin USB 
2.0-compliant connector

Video 15-hole connector

Communications

Network adapter 10/100/1000 Ethernet LAN with ASF 2.0 
support on system board

Wireless internal WLAN, WWAN (with optional 
Mini-Card), and Bluetooth® wireless 
support

Video

Video type integrated on system board, 128-bit 
hardware accelerated

Data bus integrated video

Video controller integrated graphics (UMA) AMD RS600

Storage
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Video memory up to 256 MB shared Video Memory (512 
MB + system memory)

LCD interface LVDS

Audio

Audio type two-channel high definition audio (Azalia) 

Audio controller IDT STAC9205 Codec

Stereo conversion 24-bit (analog-to-digital and digital-to-
analog)

Interfaces:

Internal high definition audio (Azalia)

External microphone-in connector, stereo 
headphones/speakers connector

Speaker one 4-ohm speaker 

Internal speaker amplifier 2-Watt channel into 4 ohms

Volume controls keyboard shortcuts, program menus

Stereo Digital Microphone Array 

Windows Vista®

Windows XP

supports Windows Vista native microphone 
processing

includes Knowles Intellisonic microphone 
processing

Display

Both LED backlit thin-and-light 
LCD and Dual-bulb (CCFL) LCD 
options:

Panel design 12.1 inches WXGA

Display area 261.12 mm (H) x 163.20 mm (V)

12.1 inches diagonal

Aspect ratio 16:10

Number of pixels 1280 x 3 (RGB) x 800 dots

Video (continued)
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Pixel pitch 0.204 x 0.204 nominal

Display mode normally white

Viewing angles:

Horizontal +/- 70 degrees

Vertical +/- 70 degrees

LED backlit thin-and-light LCD 
option:

Luminescence 220 nits Typ

Dual-bulb (CCFL) LCD option:

Luminescence 400 nits Typ

Tablet Input Devices

Digitizer

Interface capacitive touch

Input resolution 1000 dpi

Position report rate 133 PPS

Coordinate accuracy (average) +/- 0.4 mm

Coordinate jitter (maximum) +/- 0.4 mm

Pen

Dimensions:

Length 133 mm (5.2 inches)

Diameter 9 mm (0.35 inches)

Type two-button, battery-less

Notebook Input Devices

Keyboard:

Number of keys 84 (U.S. and Canada); 85 (U.K., Europe); 89 
(Japan); 86 (Brazil)

Display (continued)
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Layout QWERTY/AZERTY/Kanji

Touch pad:

X/Y position resolution (graphics 
tablet mode)

240 cpi

Size:

Width 56.7-mm (2.23-inch) sensor-active area

Height 35.9-mm (1.41-inch) rectangle

Track Stick:

X/Y position resolution (graphics 
tablet mode)

160 count/sec @ 100 gf

Biometric Reader

Type UPEK TCS3 TouchStrip™ strip sensor with 
CMOS active capacitive pixel-sensing 
technology

Array size 248 x 2 pixels

Battery

Type 4-cell "smart" lithium ion (28 WHr)

6-cell "smart" lithium ion (42 WHr)

Dimensions:

Depth 96.84 mm (3.81 inches)

Height 13.7 mm (0.54 inch)

Width 264.27 mm (10.4 inches)

Weight 0.26 kg (0.57 lb) (4 cell)

0.34 kg (0.74 lb) (6 cell) 

Voltage 11.1 VDC

Charge time (approximate) 4 hours (with computer off)

Notebook Input Devices
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Operating time Battery operating time varies depending on 
operating conditions and can be significantly 
reduced under certain power-intensive 
conditions

See "Using a Battery" on page 73 for more 
information on battery life.

Life span (approximate) 300 discharge/charge cycles

Temperature range:

Operating 0° to 35°C (32° to 95°F)

Storage –40° to 65°C (–40° to 149°F)

AC Adapter

Input voltage 90–264 VAC

Input current (maximum) 1.1 A

Input frequency 47–63 Hz

Output current 3.3 A (maximum at 4-second pulse); 
2.3 A (continuous)

Output power 45 W, 65 W (optional), or Auto Air 65 W 
(optional)

Rated output voltage 19.5 VDC

Dimensions:

Height 16.0 mm (0.63 inches)

Width 63.0 mm (2.48 inches)

Depth 88.0 mm (3.46 inches)

Weight (with cables) 0.195 kg (0.43 lb)

Temperature range:

Operating 0° to 40°C (32° to 104°F) 

Storage –10° to 70°C (–50° to 158°F)

Battery (continued)
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Physical

Height:

With LED backlit thin-and-light 
LCD

With Dual-bulb CCFL LCD

25.4 mm (1.0 inches) (system closed/LED 
standard configuration)

29.85 mm (1.2 inches) (system closed/DLV 
standard configuration)

Width 297.0 mm (11.7 inches)

Depth 218.6 mm (8.6 inches)

Weight 1.62 kg (3.57 lb) (with 4-cell battery/LED 
standard configuration)

1.93 kg (4.25 lb) (with 6-cell battery/DLV 
standard configuration)

Environmental

Temperature range:

Operating 0° to 35°C (32° to 95°F)

Storage –40° to 65°C (–40° to 149°F)

Relative humidity (maximum):

Operating 10% to 90% (non-condensing)

Storage 5% to 95% (non-condensing)

Maximum vibration (using a 
random-vibration spectrum that 
simulates user environment):

Operating 0.9 GRMS

Storage 1.3 GRMS

Maximum shock (measured with 
hard drive in head-parked position 
and a 2-ms half-sine pulse):

Operating 122 G

Storage 163 G
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Altitude (maximum):

Operating –15.2 to 3048 m (–50 to 10,000 ft)

Storage –15.2 to 10,668 m (–50 to 35,000 ft)

Airborne contaminant level G2 or lower as defined by 
ANSI/ISA-S71.04-1985

Environmental (continued)
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3
Setting Up and Using Your 
Tablet-PC

Transferring Information to a New Tablet-PC
Microsoft® Windows® provides a wizard to help you transfer files and other 
data from one Dell™ computer to another—for example, from an old 
computer or Tablet-PC to a new computer or Tablet-PC. 

Transferring Information in Windows Vista® 
1 Click Start , and then click Transfer files and settings→ Start 

Windows Easy Transfer.

2 In the User Account Control dialog box, click Continue.

3 Click Start a new transfer or Continue a transfer in progress.

Follow the instructions provided on the screen by the Windows Vista Easy 
Transfer wizard.

Transferring Information in Windows XP 
You can transfer the data to the new computer over a network or serial 
connection, or you can store it on removable media, such as a writable CD, 
for transfer to the new computer. 

 NOTE: You can transfer information from an old computer to a new computer by 
directly connecting a serial cable to the input/output (I/O) ports of the two 
computers. To transfer data over a serial connection, you must access the Network 
Connections utility from the Control Panel and perform additional configuration 
steps, such as setting up an advanced connection and designating the host 
computer and the guest computer.

For instructions on setting up a direct cable connection between two computers, 
see Microsoft Knowledge Base Article #305621, titled How to Set Up a Direct Cable 
Connection Between Two Computers in Windows XP. This information may not be 
available in certain countries. 
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For transferring information to a new computer, you must run the Files and 
Settings Transfer Wizard. You can use the Operating System media (if 
available) for this process or you can create a wizard disk with the Files and 
Settings Transfer Wizard.

Running the Files and Settings Transfer Wizard With the Operating System Media

 NOTE: This procedure requires the Operating System media. This media is optional 
and may not be included with certain computers.

To prepare a new computer for the file transfer:

1 Open the Files and Settings Transfer Wizard: click Start→ All Programs→ 
Accessories→ System Tools→ Files and Settings Transfer Wizard. 

2 When the Files and Settings Transfer Wizard welcome screen appears, 
click Next.

3 On the Which computer is this? screen, click New Computer→ Next.

4 On the Do you have a Windows XP CD? screen, click I will use the wizard 
from the Windows XP CD→ Next.

5 When the Now go to your old computer screen appears, go to your old or 
source computer. Do not click Next at this time.

To copy data from the old computer:

1 On the old computer, insert the Windows XP Operating System media.

2 On the Welcome to Microsoft Windows XP screen, click Perform 
additional tasks.

3 Under What do you want to do?, click Transfer files and settings→ Next.

4 On the Which computer is this? screen, click Old Computer→ Next.

5 On the Select a transfer method screen, click the transfer method you 
prefer.

6 On the What do you want to transfer? screen, select the items you want to 
transfer and click Next.

After the information has been copied, the Completing the Collection 
Phase screen appears.

7 Click Finish.

To transfer data to the new computer:
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1 On the Now go to your old computer screen on the new computer, click 
Next.

2 On the Where are the files and settings? screen, select the method you 
chose for transferring your settings and files and click Next.

The wizard reads the collected files and settings and applies them to your 
new computer.

When all of the settings and files have been applied, the Finished screen 
appears.

3 Click Finished and restart the new computer.

Running the Files and Settings Transfer Wizard Without the Operating System 
Media

To run the Files and Settings Transfer Wizard without the Operating System 
media, you must create a wizard disk that will allow you to create a backup 
image file to removable media. 

To create a wizard disk, use your new computer with Windows XP and 
perform the following steps:

1 Open the Files and Settings Transfer Wizard: click Start→ All Programs→ 
Accessories→ System Tools→ Files and Settings Transfer Wizard.

2 When the Files and Settings Transfer Wizard welcome screen appears, 
click Next.

3 On the Which computer is this? screen, click New Computer→ Next.

4 On the Do you have a Windows XP CD? screen, click I want to create a 
Wizard Disk in the following drive→ Next.

5 Insert the removable media, such as a writable CD, and click OK.

6 When the disk creation completes and the Now go to your old 
computer message appears, do not click Next.

7 Go to the old computer.

To copy data from the old computer:

1 On the old computer, insert the wizard disk.

2 Click Start→ Run.

3 In the Open field on the Run window, browse to the path for fastwiz (on 
the appropriate removable media) and click OK.
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4 On the Files and Settings Transfer Wizard welcome screen, click Next.

5 On the Which computer is this? screen, click Old Computer→ Next.

6 On the Select a transfer method screen, click the transfer method you 
prefer.

7 On the What do you want to transfer? screen, select the items you want to 
transfer and click Next.

After the information has been copied, the Completing the Collection 
Phase screen appears.

8 Click Finish.

To transfer data to the new computer:

1 On the Now go to your old computer screen on the new computer, click 
Next.

2 On the Where are the files and settings? screen, select the method you 
chose for transferring your settings and files and click Next. Follow the 
instructions on the screen.

The wizard reads the collected files and settings and applies them to your 
new computer.

When all of the settings and files have been applied, the Finished screen 
appears.

3 Click Finished and restart the new computer.

 NOTE: For more information about this procedure, search support.dell.com for 
document #154781 (What Are The Different Methods To Transfer Files From My Old 
Computer To My New Dell™ Computer Using the Microsoft® Windows® XP 
Operating System?).

 NOTE: Access to the Dell™ Knowledge Base document may not be available in 
certain countries.

Using Notebook Mode
Your Tablet-PC can be used either in notebook mode or tablet mode. To use 
your Tablet-PC in notebook mode, open the display until it reaches a 
comfortable viewing angle, and use the keyboard and display as you would 
those of any other notebook computer.
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 NOTE: You can use all the pen and touch screen input methods (see "Controlling 
Your Tablet-PC in Tablet Mode" on page 62) while in notebook mode except for the 
scroll control and back button, which are not accessible with the display in this 
configuration. 

Using Tablet Mode
 NOTICE: To avoid damaging your display, ensure that your Tablet-PC is in notebook 

mode and that the display is closed when you travel.

Your Tablet-PC converts from notebook mode to tablet mode with a 180-
degree clockwise twist of the display’s rotating hinge. 

Converting Your Tablet-PC Between Notebook and Tablet Modes
To convert your Tablet-PC to tablet mode:

 NOTICE: Forcing the hinge beyond the 180-degree point will damage your 
Tablet-PC.
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 NOTICE: Ensure that the display does not scrape the keycaps as you rotate the 
display, or you may cause damage to your keyboard.

1 Open the display of the Tablet-PC until it reaches a 90-degree angle, 
perpendicular to the base.

2 Brace the base with one hand on the palm rest, grasp the top of the display 
with the other hand, and, following the directional arrow inscribed on the 
hinge cover, turn the rotating hinge clockwise 180 degrees until you feel 
the display engage securely.

3 Lay the display assembly on the base with the display facing upwards.

1 display 2 display assembly

3 rotating hinge 4 directional arrow

4

3

1

2
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When you convert your Tablet-PC between notebook and tablet modes, the 
screen orientation of your Tablet-PC will automatically change according to 
the settings you have established in the Dell QuickSet application or the Pen 
and Tablet settings application, most commonly from landscape (notebook 
mode) to portrait (tablet mode). See "QuickSet" on page 71 for more 
information on customizing your Tablet-PC settings.

To convert your Tablet-PC from tablet mode to notebook mode:

 NOTICE: Forcing the hinge beyond the 180-degree point will damage your 
Tablet-PC. 

 NOTICE: Ensure that the display assembly does not scrape the keycaps as you 
rotate the display, or you may cause damage to your keyboard.

1 Lift the display until it reaches a 90-degree angle, perpendicular to the 
base.
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2 Brace the base with one hand on the palm rest, grasp the top of the display 
with the other hand, and, following the directional arrow inscribed on the 
grip, turn the rotating hinge counter-clockwise 180-degrees until you feel 
the display assembly engage securely in the notebook mode configuration. 
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3 Adjust the display to a comfortable viewing angle. 

Right- and Left-handed Use
Your Tablet-PC can be adjusted for either right- or left-handed use. Several 
settings within the operating system enable you to customize the Tablet-PC 
depending on whether you are right- or left-handed.

• Right-handed use: 

Hold the Tablet-PC on your left forearm with your left hand on the grip, 
and the scroll control and back button within reach of your fingers. You 

1 display assembly 2 rotating hinge

3 directional arrow on grip

3

2

1
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can hold the pen in your right hand or use a right-hand finger to operate 
the tablet buttons and display.

• Left-handed use: 

Hold the Tablet-PC on your right forearm with your right hand on the grip. 
You can hold the pen in your left hand, manipulate the scroll control and 
back buttons with your left hand, or use a left-hand finger to operate the 
tablet buttons and display.
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Screen Orientation
You can change the display orientation of your Tablet-PC from portrait to 
landscape in several different ways:

• Press the screen rotate tablet button to rotate the screen 90-degrees 
clockwise.

• Right-click the QuickSet icon in the Notification area, click Tablet 
Settings→ Display, then choose the orientation you want from the Screen 
Orientation pull-down menu.

• In Windows Vista, click Start → Control Panel→ Mobile PC→ 
Tablet PC Settings→ Display.

• In Windows XP, click Start→ Control Panel→ Printers and Other 
Hardware→ Tablet and Pen Settings and then click the Display tab. 
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• In Windows Vista, press the Windows Logo key and <x> to open 
Windows Mobility Center, and then click the button in the Screen 
Orientation window until the display is in the desired orientation.

Controlling Your Tablet-PC in Tablet Mode
In tablet mode, you can control your Tablet-PC using the following methods:

• Using the scroll control

• Using the back button

• Using the tablet buttons

• Using the pen

• Using touch

Using the Scroll Control

• To scroll through a list of items or a set of pages one at a time, shift the 
scroll control up or down and release. The control automatically returns to 
the center/neutral position when released.

• To rapidly scroll through a list of items or a set of pages, shift the control 
up or down and hold it, releasing it when you wish to stop scrolling.

• To select objects, press and release the scroll control when it is in the 
center/neutral position.

• To launch context sensitive menus, press and hold the scroll control until a 
complete circle is drawn on the display, and then release. This is equivalent 
to clicking the right mouse button on a notebook computer.

Using the Back Button

Use the back button, located adjacent to the scroll control, to move backward 
in applications that support navigation, such as web browsers and Windows 
Explorer, and to close the active window. 

• To move backward, press and release the back button.

• To close the active window, press and hold the back button.

• To customize the back button behavior, use the Tablet and Pen Settings.

Using Tablet Buttons

Your Tablet-PC has four tablet buttons located beside the power button.
62 Setting Up and Using Your Tablet-PC



book.book  Page 63  Tuesday, May 13, 2008  5:03 PM
1 power button 2 Windows security button

3 screen rotate button 4 QuickSet tablet settings button

5 e-mail application shortcut button

1 2 3 4 5
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W I N D O W S S E C U R I T Y  B U T T O N 

S C R E E N R O T A T E  B U T T O N 

Q U I C K SE T  T A B L E T  S E T T I N G S B U T T O N 

E - M A I L  A P P L I C A T I O N  S H O R T C U T  B U T T O N 

Disabling and Enabling Tablet Buttons

You can disable and enable the tablet buttons using the Dell QuickSet 
application. To access QuickSet, click the QuickSet icon in the Notification 
area, or press the QuickSet tablet settings button.

If you are using your Tablet-PC in tablet mode, you can 
press the Windows security button to access the Windows 
Task Manager dialog box or a login screen, the same way 
you use the <Ctrl><Alt><Del> key combination in 
notebook mode.

While the Tablet-PC is in tablet mode, you can use the 
screen rotate button to change the display orientation from 
portrait to landscape mode:

• Each time you press and release the screen rotate button, 
the screen image rotates clockwise 90 degrees.

• If you press and hold the screen rotate button, the display 
switches off. The computer will not recognize input until 
you press and hold the screen rotate button a second time, 
or use the pen to wake the Tablet-PC. This feature 
provides a convenient way to prevent inadvertent input 
while carrying your Tablet-PC.

Press this button to view and configure options for the 
Tablet-PC and the pen through Dell QuickSet. You can 
configure this button using Tablet PC Settings (Windows 
Vista) or Tablet Settings (Windows XP). 

Launches either Microsoft Outlook or Outlook Express if 
you have one of these applications installed on your 
Tablet-PC. You can configure this button using Tablet PC 
Settings (Windows Vista) or Tablet Settings (Windows 
XP). 
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You can change the actions assigned to the back button, the tablet settings 
button, the e-mail application shortcut button, and the scroll control 
(Windows Vista). 

To access the settings for these buttons: 

• In Windows Vista, click Start → Control Panel→ Mobile PC→ Tablet 
PC Settings→ Set tablet buttons to perform certain tasks. 

• In Windows XP, click Start→ Control Panel→ Printers and Other 
Hardware→ Tablet and Pen Settings, and then click the Tablet Buttons 
tab. 

Using the Pen

Ejecting and Storing the Pen

Press and release the pen to eject it from the pen compartment. To protect 
the pen when you are not using it, insert the pen, tip first, into the pen 
compartment on the Tablet-PC. Press to engage the pen in its compartment.

When you remove the pen from the pen compartment, the pen indicator 
LED blinks quickly to indicate that the pen has been removed.

1 pen indicator LED 2 pen compartment

3 pen

3

1
2
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If the pen is not in its compartment when the Tablet-PC shuts down or enters 
sleep or hibernate mode, the pen indicator LED blinks slowly to remind you 
to replace the pen in the compartment. The behavior of the pen indicator 
LED can be enabled or disabled through the QuickSet tablet settings 
application (see "Dell QuickSet Help" on page 20 for instructions on 
accessing QuickSet).

Replacing the Pen Tip

Your Tablet-PC ships with several of each of two types of pen tips: hard 
(simulates the feel of a ballpoint pen) and soft (simulates the feel of a felt-tip 
pen). 

To replace a pen tip: 

1 Use the pen-tip remover tool to grasp the pen tip, then firmly pull the tip 
from the pen. 

1 pen 2 erase pen button

3 right-click pen button 4 pen tip

5 pen-tip remover tool

1

3

4
5

2
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2 With your fingers, place a new tip into the pen, and insert the tip until it is 
fully seated in the pen.

Calibrating the Pen

The pen can function at the default calibration or at a calibration set by you 
or by another user. Dell recommends that you use the pen only while it is 
calibrated to your personal calibration settings. Calibration optimizes pen 
performance for each user.

To calibrate the pen:

1 Press the QuickSet tablet settings button, click Control Tablet PC 
Settings→ Pen and Input Settings.

2 At the bottom of the General tab, tap the Calibrate button.

3 Follow the instructions on the screen. The calibration markers are 
displayed on the screen as plus signs (+). Tap the pen in the exact center 
of each of the calibration markers. 

 NOTE: Be sure to calibrate the pen for use in both portrait and landscape display 
orientations.

Using the Pen Like a Mouse

You can use the pen with your Tablet-PC the same way you use a mouse or 
touch pad with a notebook computer. When you hold the pen near the 
display, you see a small cursor. Moving the pen moves the cursor.

• To click, tap once. 

• To double-click, tap the display twice. 

• To open a menu, tap the menu name, and then the menu item.

• To drag an item, such as a file or icon, touch the pen to the item and drag 
it to another destination on the display.

• There are two ways to right-click (to open a context-sensitive menu):

– Hold down the right-click pen button and then tap the display. When 
you hold down the right-click pen button, the cursor is surrounded 
with a circle.
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– Touch the pen on the screen and hold it in place momentarily until 
Windows draws a complete circle around the cursor. When the circle 
is complete, lift the pen to display the context menu. If you move or 
lift the pen before the circle is complete, the right-click action is 
cancelled.

To get help and practice using the pen as a mouse by using the online training 
and tutorials: 

• In Windows Vista, click Start → All Programs→ Tablet PC→ Tablet 
PC Pen Training, and then click Using a pen instead of a mouse. 

• In Windows XP, click Start→ Get Going with Tablet PC, and then click 
Start. This tutorial provides pen training.

Entering, Editing, and Erasing Text With the Pen

The handwriting recognition software makes it easy to enter text into your 
applications with the pen. Some applications, such as Windows Journal, allow 
you to write with the pen directly into the application window. 

When an application does not directly support pen input, you can use the 
Tablet PC Input Panel to enter text into your application. If you tap in an 
editable area, the Tablet PC Input Panel icon appears. Tap the icon and the 
Input Panel slides out from the edge of the display. You can also open the 
Input Panel by tapping the Input Panel tab, which is docked at the edge of 
the screen when the Input Panel is hidden.

The Input Panel allows you to enter and edit text in different modes. You can 
write words just like you write on paper, you can write one character at a time, 
or you can "type" by tapping the pen on the keys of an image of a keyboard. To 
change the input mode, right-click the QuickSet icon in the Notification 
area, click Pen and Input Settings→ Input Mode, and then select the desired 
input mode.

Edit text in the Input Panel using gestures, such as lining through text you 
want to delete, or tapping buttons.

Erase text in the Input Panel using the erase pen button, or by lining through 
text you want to delete.

To get help and practice writing and editing with Input Panel: 

• In Windows Vista, click Start → All Programs→ Tablet PC→ Tablet 
PC Pen Training, and tap each of the Input Panel topics.
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• In Windows XP, click Start→ Get Going with Tablet PC and then click 
Start. This tutorial provides Input Panel training. You can access additional 
tutorials by clicking Start→ All Programs→ Tablet PC→ Tablet PC 
Tutorials. 

Using Pen Flicks in Windows Vista 

Pen flicks enable you to use the pen to perform actions that normally require 
a keyboard, such as pressing <Page Up> or using the directional arrow keys. 
Pen flicks are quick, directional gestures; you quickly draw a short line in one 
of eight directions. When a pen flick is recognized, the Tablet-PC performs 
the action assigned.

The horizontal and vertical pen flicks are, by default, assigned to navigational 
actions, corresponding to the keys <Left-Arrow>, <Right-Arrow>, 
<Page Up>, and <Page Down>. The default assignments for the diagonal 
pen flicks are editing actions: delete, copy, paste, and undo.

To customize pen flicks, click Start → Control Panel→ Mobile PC→ Pen 
and Input Devices and click the Flicks tab. You can choose to turn pen flicks 
off, use the navigational pen flicks only, or use the navigational and editing 
pen flicks. You can also assign a new action to any of the eight pen flicks and 
adjust how easily your pen flicks are recognized.

To learn more about pen flicks and practice using them, click Start → All 
Programs→ Tablet PC→ Pen Flicks Training.

Setting Pen Preferences

You can customize several pen behaviors in the operating system to help make 
using your Tablet-PC more comfortable. For example, if your double-taps are 
sometimes not recognized because you do not tap them fast enough, you can 
set a slower speed so that you have more time to tap. 

In Windows Vista, you can customize the visual feedback that displays for 
each type of tap, and you can customize the actions assigned to pen flicks.

To access pen preferences and options: 

• In Windows Vista, click Start → Control Panel→ Mobile PC→ Pen 
and Input Devices.

• In Windows XP, click Start→ Control Panel→ Printers and Other 
Hardware→ Tablet and Pen Settings.
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The pen preferences and options you set are specific to the pen and the 
Tablet-PC.

Setting Pointer Device (Mouse) Preferences 

Pointer device preferences, such as pointer speed, click speed, and pointer 
(mouse) trails, are set in the Mouse Properties window. These preferences 
apply to any pointer device in the system. 

To access pointing device preferences: 

• In Windows Vista, click Start → Control Panel→ Hardware and 
Sound→ Mouse.

• In Windows XP, click Start→ Control Panel→ Printers and Other 
Hardware→ Mouse. 

Using Touch
Your Tablet-PC is able to distinguish between the pen and your fingertip 
(touch mode). When you use touch mode, a translucent image of a computer 
mouse, called the touch pointer, floats beneath your finger. The touch pointer 
has left and right mouse buttons that you can tap with your finger. You use 
the area beneath the buttons to drag the touch pointer.

Your Tablet-PC ships with a digitizer utility which you can use to set one of 
four modes for using touch:

• Pen only — Touch mode is disabled.

• Touch only — Pen input is disabled.

• Auto mode — If the pen is close to the display, pen mode is active. If the 
pen is not within range, double-tap the display with your finger to enter 
touch mode. Touch mode remains active until the pen is close to the 
display again. 

• Dual mode — Microsoft Vista switches automatically between the pen 
and touch modes, based on its internal programming.

To access the digitizer utility from the Windows Notification area and set the 
input mode, right-click  in Windows Vista or  in Windows XP, click 
Properties, and then click the Digitizer Options tab. Click the radio button 
for the input mode you want to set, and click Apply.

In Windows Vista, to learn more about touch mode and practice using it, 
click Start → All Programs→ Tablet PC→ Tablet PC Touch Training.
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Accessing Management Tasks and User 
Information 
You can use QuickSet, the Control Panel, Help and Support, and the 
Windows Vista Mobility Center to access online information, customize 
settings, and manage tasks. 

QuickSet

 NOTICE: If you uninstall QuickSet from your Tablet-PC you will also delete the 
tablet button drivers. To reinstall QuickSet and the tablet button drivers, go to 
support.dell.com.

QuickSet gives you easy access to settings and controls for customizing your 
Tablet-PC. You can access Dell QuickSet from the QuickSet icon in the 
Windows Notification area or through the Windows Mobility Center.

Depending on what you want to do, you can start QuickSet by either clicking, 
double-clicking, or right-clicking the QuickSet icon in the Windows 
Notification area. 

The Windows Notification area is located in the lower-right corner of your 
screen.

Clicking the QuickSet Icon

 NOTE: The following features may not be available on certain computers.

Click the QuickSet icon to:

• Control internal network adapter activity.

• Manage hot key pop-ups:

• Enable or disable the appearance of the Brightness Meter on your 
screen.

• Enable or disable the appearance of the Volume Meter on your 
screen.

• Turn the Wireless Activity Indicator on or off.

• Enable or disable hardware buttons on your Tablet-PC.
Setting Up and Using Your Tablet-PC 71



book.book  Page 72  Tuesday, May 13, 2008  5:03 PM
Double-Clicking the QuickSet Icon

Double-click the QuickSet icon to launch QuickSet and access the QuickSet 
launch panel. The main menu provides links to QuickSet features that help 
you configure settings for:

• Network connectivity

• Display settings

• System settings

Right-Clicking the QuickSet Icon

Right-click the QuickSet icon to:

• Select Open to launch QuickSet.

• View the Dell QuickSet Help file.

• View the version and copyright date of the QuickSet application program 
installed on your computer.

• Control Tablet-PC settings.

Control Panel
To access the Control Panel, click Start  (or Start in Windows XP) and 
then click Control Panel. The Control Panel contains several categories of 
tasks for managing your Tablet-PC. Clicking each category displays more 
information. To display these tasks as task icons, click Switch to Classic View 
in Windows XP or Classic View in Windows Vista. 

Help and Support
To access Help and Support, click Start  (or Start in Windows XP) and 
then click Help and Support. Help and Support provides information for 
understanding how to manage your Tablet-PC. 

Windows Vista Mobility Center
The Windows Mobility Center contains a set of tiles through which you can 
configure settings on your computer. There are additional tiles that have been 
customized by Dell.

You can access the Windows Mobility Center using any of the following 
methods:
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• Double-click the QuickSet icon in the Windows Notification area and 
click Mobility Center.

• Click the Start button and point to the Mobility Center.

• Click Start→ All Programs→ Accessories, and point to Mobility Center.

• Right-click the battery icon in the Windows Notification area, and point to 
Mobility Center.

• Double-click the Mobility Center icon in the Control Panel.

You can access the QuickSet categories through the Mobility Center. Click 
one of the tiles, such as Networking, Display Settings, or System 
Configuration, in the Customized by Dell Inc. section, and the QuickSet 
application launches with the corresponding category open.

Using a Battery
 CAUTION: Using an incompatible battery may increase the risk of fire or 

explosion. Replace the battery only with a compatible battery purchased from 
Dell. The battery is designed to work with your Dell Tablet-PC. Do not use a battery 
from other Tablet-PCs with your Tablet-PC. 

 CAUTION: Do not dispose of batteries with household waste. When your battery 
no longer holds a charge, call your local waste disposal or environmental agency 
for advice on disposing of a lithium-ion battery. See "Battery Disposal" in the 
Product Information Guide.

 CAUTION: Misuse of the battery may increase the risk of fire or chemical burn. 
Do not puncture, incinerate, disassemble, or expose the battery to temperatures 
above 65°C (149°F). Keep the battery away from children. Handle damaged or 
leaking batteries with extreme care. Damaged batteries may leak and cause 
personal injury or equipment damage. 

Battery Performance

 NOTE: For information about the Dell warranty for your Tablet-PC, see the Product 
Information Guide or separate paper warranty document that shipped with your 
Tablet-PC.

For optimal Tablet-PC performance and to help preserve BIOS settings, 
operate your Dell™ Tablet-PC with the main battery installed at all times. 
One battery is supplied as standard equipment in the battery bay.
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 NOTE: Because the battery may not be fully charged, use the AC adapter to 
connect your new Tablet-PC to an electrical outlet the first time you use the 
Tablet-PC. For best results, operate the Tablet-PC with the AC adapter until the 
battery is fully charged. To view battery charge status, check the Power Meter in 
Power Options (see "Accessing Power Options Properties" on page 79).

Battery operating time varies depending on operating conditions. You can use 
an optional battery slice (see "Battery Slice (Optional)" on page 217) to 
significantly increase operating time.

 NOTE: Battery operating time (the time the battery can hold a charge) decreases 
over time. Depending on how often the battery is used and the conditions under 
which it is used, you may need to purchase a new battery during the life of your 
Tablet-PC.

 NOTE: It is recommended that you connect your Tablet-PC to an electrical outlet 
when writing to a CD or DVD.

Operating time is significantly reduced when you perform operations 
including, but not limited to, the following:

• Using optical drives.

• Using wireless communications devices, ExpressCards, media memory 
cards, or USB devices.

• Using high-brightness display settings, 3D screen savers, or other power-
intensive programs such as complex 3D graphics applications.

• Running the Tablet-PC in maximum performance mode. See "Configuring 
Power Management Settings" on page 79 for information about accessing 
Windows Power Options Properties or Dell QuickSet, which you can use 
to configure power management settings.

You can check the battery charge before you insert the battery into the 
Tablet-PC. You can also set power management options to alert you when the 
battery charge is low.

Checking the Battery Charge
The following features provide information on the battery charge: 

• Dell QuickSet Battery Meter 

• Microsoft Windows Power Meter window and Power icon (  in 
Windows Vista and  in Windows XP) 

• Battery charge gauge and health gauge 
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• Low-battery warning 

Dell™ QuickSet Battery Meter

If Dell QuickSet is installed, press <Fn><F3> to display the QuickSet 
Battery Meter. The Battery Meter displays status, battery health, charge level, 
and charge completion time for the battery in your Tablet-PC. 

For more information about QuickSet, right-click the QuickSet icon in the 
Windows Notification area, and click Help.

Power Meter
The Power Meter indicates the remaining battery charge. To check the Power 
Meter, move your cursor over the Power icon (  in Windows Vista and  
in Windows XP) in the Notification area to display the Power icon pop-up.

If the computer is connected to an electrical outlet, the Power icon pop-up 
displays the (plugged in charging) message.

Charge Gauge

By either pressing once or pressing and holding the status button on the 
charge gauge on the battery, you can check:

• Battery charge (check by pressing and releasing the status button)

• Battery health (check by pressing and holding the status button)

The battery operating time is largely determined by the number of times it is 
charged. After hundreds of charge and discharge cycles, batteries lose some 
charge capacity—or battery health. That is, a battery can show a status of 
"charged" but maintain a reduced charge capacity (health). 

Check the Battery Charge

To check the battery charge, press and release the status button on the battery 
charge gauge to illuminate the charge-level lights. Each light represents 
approximately 20 percent of the total battery charge. For example, if the 
battery has 80 percent of its charge remaining, four of the lights are on. If no 
lights appear, the battery has no charge.
Setting Up and Using Your Tablet-PC 75



book.book  Page 76  Tuesday, May 13, 2008  5:03 PM
Check the Battery Health

 NOTE: You can check battery health in one of two ways: by using the charge gauge 
on the battery as described below and by using the Battery Meter in Dell QuickSet. 
For information about QuickSet, right-click the icon in the Windows Notification 
area, and click Help.

To check the battery health using the charge gauge, press and hold the status 
button on the battery charge gauge for at least 3 seconds. If no lights appear, 
the battery is in good condition, and more than 80 percent of its original 
charge capacity remains. Each light represents incremental degradation. If 
five lights appear, less than 60 percent of the charge capacity remains, and you 
should consider replacing the battery. 

Low-Battery Warning

 NOTICE: To avoid losing or corrupting data, save your work immediately after a 
low-battery warning. Then connect the Tablet-PC to an electrical outlet, or dock the 
Tablet-PC onto an optional battery slice. If the battery runs completely out of power, 
hibernate mode begins automatically.

A pop-up window warns you when the battery charge is approximately 90 
percent depleted. If both the main battery and the battery slice are installed, 
the low-battery warning means that the combined charge of both batteries is 
approximately 90 percent depleted. The Tablet-PC enters hibernate mode 
when the battery charge is at a critically low level.

You can change the settings for the battery alarms in QuickSet or the Power 
Options Properties window. See "Configuring Power Management Settings" 
on page 79 for information about accessing QuickSet or the Power Options 
Properties window.

Conserving Battery Power
Perform the following actions to conserve battery power:

• Connect the Tablet-PC to an electrical outlet when possible because 
battery life is largely determined by the number of times the battery is 
used and recharged.

• Place the Tablet-PC in sleep mode or hibernate mode when you leave the 
Tablet-PC unattended for long periods of time. See "Power Management 
Modes" on page 77.
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• Use the Power Management Wizard or the Power Options Properties 
window to select options to optimize your computer’s power usage. These 
options can also be set to change when you press the power button, close 
the display, or press <Fn><Esc>.

 NOTE: See "Configuring Power Management Settings" on page 79 for information 
on conserving battery power.

Power Management Modes

Sleep Mode in Windows Vista 

Sleep mode conserves power by turning off the display and the hard drive 
after a predetermined period of inactivity (a time-out). When the Tablet-PC 
exits sleep mode, it returns to the same operating state it was in before 
entering sleep mode.

 NOTICE: If your Tablet-PC loses AC and battery power while in sleep mode, it may 
lose data.

To enter sleep mode in Windows Vista, click Start , and move your mouse 
over the right triangle beside the lock option to open the Power Options 
Properties window, and then click Sleep.

Depending on how you set the power management options in the Power 
Options Properties window or the QuickSet Power Management Wizard, you 
may also use one of the following methods:

• Press the power button

• Close the display

• Press <Fn><Esc>

To exit sleep mode, press the power button or open the display, depending on 
how you set the power management options. You cannot make the Tablet-PC 
exit sleep mode by pressing a key or touching the touch pad or track stick.

Hibernate Mode

Hibernate mode conserves power by copying system data to a reserved area on 
the hard drive and then completely turning off the Tablet-PC. When the 
Tablet-PC exits hibernate mode, it returns to the same operating state it was 
in before entering hibernate mode.
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 NOTICE: You cannot remove devices or undock your Tablet-PC while your 
Tablet-PC is in hibernate mode.

Your Tablet-PC enters hibernate mode if the battery charge level becomes 
critically low.

To Manually Enter Hibernate Mode in Windows Vista

Click Start , and move your mouse over the right triangle beside the Lock 
icon to open the Power Options Properties window, and then click 
Hibernate. 

 NOTE: In Windows Vista, if your Tablet-PC has Hybrid Sleep enabled, then 
Hibernate is not displayed.

To Manually Enter Hibernate Mode in Windows XP 

To manually enter hibernate mode in Windows XP, you must enable 
hibernate mode. 

To enable hibernate mode: 

1 Click Start→ Control Panel→ Performance and Maintenance→ Power 
Options. 

2 Click the Hibernate tab. 

3 Select Enable hibernation. 

4 Click Apply and Ok. 

To enter hibernate mode: 

1 Press the <Ctrl><Alt><Del> key combination. 

2 Select Shut Down→ Hibernate. 

Alternative Methods for Entering Hibernate Mode

Depending on how your power management options are set, you can also use 
one of the following methods to enter hibernate mode:

• Press the power button

• Close the display

• Press <Fn><Esc>
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 NOTE: Some ExpressCards may not operate correctly after the Tablet-PC exits 
hibernate mode. Remove and reinsert the card (see "Removing an ExpressCard" on 
page 91), or simply restart (reboot) your Tablet-PC.

To Exit Hibernate Mode

To exit hibernate mode, press the power button. The Tablet-PC may take a 
short time to exit hibernate mode. You cannot make the Tablet-PC exit 
hibernate mode by pressing a key or touching the touch pad or track stick. For 
more information on hibernate mode, see the documentation that came with 
your operating system.

Configuring Power Management Settings
You can use the QuickSet Power Management Wizard or Windows Power 
Options Properties to configure the power management settings on your 
Tablet-PC. For more information about QuickSet, right-click the QuickSet 
icon in the Windows Notification area and click Help.

Accessing Power Options Properties

• Click the Windows Power  icon in the Notification area to display the 
Power icon pop-up window. 

• Select one of the following from the Select a Power Plan section:

• Dell Recommended

• Power Saver

• High Performance

• Any custom power plan you have created

• To access additional power options, click More Power Options at the 
bottom of the pop-up.

Charging the Main Battery
When you connect the Tablet-PC to an electrical outlet or install a battery 
while the Tablet-PC is connected to an electrical outlet, the Tablet-PC checks 
the battery charge and temperature. If necessary, the AC adapter then charges 
the battery and maintains the battery charge.
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 NOTE: With Dell™ ExpressCharge™, when the Tablet-PC is turned off, the AC 
adapter charges a completely discharged battery to 80 percent in about 1 hour and 
to 100 percent in approximately 2 hours. Charge time is longer with the Tablet-PC 
turned on. You can leave the battery in the Tablet-PC for as long as you like. The 
battery’s internal circuitry prevents the battery from overcharging.

If the battery is hot from being used in your Tablet-PC or being in a hot 
environment, the battery may not charge when you connect the Tablet-PC to 
an electrical outlet.

The battery is too hot to start charging if the  light flashes alternately 
green and orange. Disconnect the Tablet-PC from the electrical outlet and 
allow the Tablet-PC and the battery to cool to room temperature. Then 
connect the Tablet-PC to an electrical outlet to continue charging the battery.

For information about resolving problems with a battery, see "Power 
Problems" on page 133.

Removing the Main Battery

 CAUTION: Using an incompatible battery may increase the risk of fire or 
explosion. Replace the battery only with a compatible battery purchased from 
Dell. The battery is designed to work with your Dell™ Tablet-PC. Do not use a 
battery from other Tablet-PCs or computers with your Tablet-PC. 

 CAUTION: Before performing these procedures, turn off the Tablet-PC, disconnect 
the AC adapter from the electrical outlet and the Tablet-PC, disconnect any modem 
from the wall connector and Tablet-PC, and remove any other external cables from 
the Tablet-PC.

 NOTICE: You must remove all external cables from the Tablet-PC to avoid possible 
connector damage.

To remove the battery:

1 If the Tablet-PC is connected to a docking device such as the optional 
media base or battery slice (docked), undock it. See "Undocking Your 
Tablet-PC From the Media Base" on page 212 or "Undocking Your 
Tablet-PC From the Battery Slice" on page 220.

2 Ensure that the Tablet-PC is turned off or suspended in a power 
management mode.

3 Slide the battery-bay latch releases on the bottom of the Tablet-PC, and 
then remove the battery from the bay.
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Installing the Main Battery
1 If the Tablet-PC is connected to a docking device such as the optional 

media base or battery slice (docked), undock it. See "Undocking Your 
Tablet-PC From the Media Base" on page 212 or "Undocking Your 
Tablet-PC From the Battery Slice" on page 220.

2 Turn the Tablet-PC upside-down.

3 Align the battery with the battery bay sides, then slide the battery into the 
bay and ensure that the two latch releases engage.

Storing a Battery
Remove the battery when you store your Tablet-PC for an extended period of 
time. A battery discharges during prolonged storage. After a long storage 
period, recharge the battery fully (see "Charging the Main Battery" on 
page 79) before you use it.

1 battery release latches (2) 2 battery

1 2
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Using a Keyboard

Numeric Keypad

The numeric keypad functions like the numeric keypad on an external 
keyboard. Each key on the keypad has multiple functions. The keypad 
numbers and symbols are marked in blue on the right of the keypad keys. To 
type a number or symbol, hold down <Fn> and press the desired key.

• To enable the keypad, press <Num Lk> in Windows Vista or 
<Fn><Num Lk> in Windows XP. 

• To disable the keypad, press <Num Lk> or <Fn><Num Lk> again. 

Key Combinations

System Functions

<Ctrl><Shift><Esc> Opens the Task Manager window.

numeric keypad
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Battery

Display Functions

Power Management

Speaker Functions

<Fn><F3> Displays the Dell™ QuickSet Battery Meter.

<Fn><F8> Switches the video image to the next display 
option. The options include the integrated display, 
an external monitor, and both displays 
simultaneously.

<Fn><F7> Scales between wide-screen and standard aspect 
ratio video resolutions.

<Fn> and left-arrow key Activates the ambient light sensor, which controls 
brightness of the display based on light level in the 
current environment.

<Fn> and up-arrow key Increases brightness on the integrated display only 
(not on an external monitor).

<Fn> and down-arrow key Decreases brightness on the integrated display 
only (not on an external monitor).

<Fn><Esc> Activates a power management mode. You can 
reprogram this keyboard shortcut to activate a 
different power management mode using the 
Advanced tab in the Power Options Properties 
window.

<Fn><F1> Puts the Tablet-PC into hibernate mode. Dell 
QuickSet is required (see "QuickSet" on page 71).

<Fn><Insert> Increases the volume of the integrated speakers 
and external speakers, if attached.

<Fn><End> Decreases the volume of the integrated speakers 
and external speakers, if attached.

<Fn><Delete> Enables and disables the integrated speakers and 
external speakers, if attached.
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Microsoft® Windows® Logo Key Functions

 NOTE: Some of the following key functions only apply to Windows Vista. 

Windows logo key and <Tab> Cycle through programs on the Windows 
Notification area by using Windows Flip 3-D (only 
if using the Aero™ interface).

<Ctrl> and Windows logo key 
and <Tab>

Use the arrow keys to cycle through programs on 
the Windows Notification area by using Windows 
Flip 3-D (only if using the Aero™ interface).

Windows logo key and spacebar Bring all gadgets to the front and select Windows 
Sidebar (if using Windows Sidebar).

Windows logo key and <g> Cycles through Windows Sidebar gadgets (if using 
Windows Sidebar).

Windows logo key and <u> Opens the Ease of Access Center.

Windows logo key and <x> Opens the Windows Mobility Center.

Windows logo key and any 
number key

Opens the Quick Launch shortcut that is in the 
position that corresponds to the number. For 
example, use the Windows logo key and <1> to 
launch the first shortcut in the Quick Launch 
menu.

Windows logo key and <m> Minimizes all open windows.

Windows logo key and 
<Shift><m>

Restores all minimized windows. This key 
combination functions as a toggle to restore 
minimized windows following the use of the 
Windows logo key and <m> key combination. 

Windows logo key and <e> Runs Windows Explorer.

Windows logo key and <r> Opens the Run dialog box.

Windows logo key and <f> Opens the Search Results dialog box.

Windows logo key and 
<Ctrl><f>

Opens the Search Results-Computer dialog box (if 
the Tablet-PC is connected to a network).

Windows logo key and 
<Fn><F12>

Opens the System Properties dialog box.
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To adjust keyboard operation, such as the character repeat rate: 

• In Windows Vista, click Control Panel→ Hardware and Sound, and either 
click Keyboard or click one of the two options under the Keyboard link. 

• In Windows XP, click Control Panel→ Printers and Other Hardware→ 
Keyboard. 

For information about the Control Panel, see Windows Help and Support. To 
access Help and Support, click Start  (or Start in Windows XP)→ Help 
and Support.

Touch Pad
The touch pad detects the pressure and movement of your finger to allow you 
to move the cursor on the display. Use the touch pad and touch pad buttons 
as you would use a mouse.

1 touch pad 2 touch pad buttons

1

2
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• To move the cursor, lightly slide your finger over the touch pad.

• To select an object, lightly tap once on the surface of the touch pad or use 
your thumb to press the left touch pad button.

• To select and move (or drag) an object, position the cursor on the object 
and tap twice on the touch pad. On the second tap, leave your finger on 
the touch pad and move the selected object by sliding your finger over the 
surface. 

• To double-click an object, position the cursor on the object and tap twice 
on the touch pad or use your thumb to press the left touch pad button 
twice.

You can also use the track stick to move the cursor. Press the track stick left, 
right, up, or down to change the direction of the cursor on the display. Use the 
track stick and track stick buttons as you would use a mouse.

Customizing the Touch Pad and Track Stick or Pointer 

You can use the Control Panel mouse options to adjust settings for the mouse 
and the track stick (Windows Vista) or pointer (Windows XP). 

• In Windows Vista, click Control Panel→ Mouse. 

• In Windows XP, click Control Panel→ Printers and Other Hardware→ 
Mouse. 

Changing the Track Stick or Pointer Cap
You can replace your track stick or pointer cap if it wears down from 
prolonged use or if you prefer a different color. You can purchase additional 
caps by visiting the Dell website at dell.com.
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1 Pull the cap off the track stick.

2 Align the new cap over the square track-stick post and gently press the cap 
down onto the post.

 NOTICE: The track stick cap can damage the display if it is not properly seated on 
the post.

3 Test the track stick to ensure that the cap is seated properly.

Using the Display
Your Tablet-PC has two display options available:

• LED backlit thin-and-light LCD (optimized for indoor viewing)

• Dual-bulb (CCFL) LCD (optimized for outdoor viewing)

Depending on which display option you selected, how you adjust the 
brightness on your display will differ.
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Adjusting Brightness on the LED Backlit Thin-and-Light LCD
When a Dell Tablet-PC equipped with the LED backlit thin-and-light LCD 
display is running on battery power, you can conserve power by setting the 
display brightness to the lowest comfortable setting by pressing <Fn> and 
the up- or down-arrow key on the keyboard.

 NOTE: Brightness key combinations only affect the display on your Tablet-PC, not 
monitors or projectors that you attach to your Tablet-PC or docking device. If your 
Tablet-PC is connected to an external monitor and you try to change the brightness 
level, the Brightness Meter may appear, but the brightness level on the external 
device does not change.

You can press the following keys to adjust display brightness:

• Press <Fn> and the up-arrow key to increase brightness on the integrated 
display only (not on an external monitor).

• Press <Fn> and the down-arrow key to decrease brightness on the 
integrated display only (not on an external monitor).

 NOTE: If your operating system display default is set to a specific value, you may 
have to reset your manual selections after using sleep, standby, or hibernate mode.

Adjusting Brightness on the Dual-bulb (CCFL) LCD
The Dual-bulb LCD includes an integrated ambient light sensor (see "Front 
View" on page 27).

1 ambient light sensor

1
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The ambient light sensor is located on the front of the Tablet-PC display. The 
sensor detects available environmental light and automatically increases or 
decreases the display backlighting to compensate for low-light and high-light 
environments.

You can enable or disable the ambient light sensor feature by pressing the 
<Fn> and left-arrow key combination.

 NOTE: Do not cover the ambient light sensor with any adhesive labels. If covered 
up, the sensor—when enabled—automatically sets the display brightness to the 
minimum level.

The ambient light sensor is disabled when your Tablet-PC is shipped to you. 
If you enable the sensor and then use any of the display brightness key 
combinations, the sensor is disabled and the display brightness is increased or 
decreased accordingly. 

Dell QuickSet allows you to enable or disable the ambient light sensor 
feature. You can also adjust maximum and minimum brightness settings that 
are activated when you enable the ambient light sensor feature. For more 
information about QuickSet, right-click the QuickSet icon in the Windows 
Notification area, and click Help.

 NOTE: Rebooting the Tablet-PC returns the ambient light sensor to the setting it 
was before it was adjusted. 

 NOTE: The ambient light sensor adjusts the display backlighting on your Tablet-PC 
display only. It does not control the brightness on any external monitors or 
projectors.

Using Cards

ExpressCards
ExpressCards provide additional memory, wired and wireless 
communications, multimedia, and security features. ExpressCards support 
two form factors:

• ExpressCard/34 (34-mm wide)

• ExpressCard/54 (54-mm wide in an L-shape with a 34-mm connector)

The 34-mm card fits into both the 34-mm and 54-mm card slots. The 54-mm 
card only fits into a 54-mm card slot.
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 NOTE: An ExpressCard is not a bootable device.

Installing an ExpressCard

You can install an ExpressCard while the Tablet-PC is running. The Tablet-PC 
automatically detects the card.

ExpressCards are generally marked with a symbol (such as a triangle or an 
arrow) or a label to indicate which end to insert into the slot. The cards are 
keyed to prevent incorrect insertion. If card orientation is not clear, see the 
documentation that came with the card. 

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

To install an ExpressCard:

1 Hold the card with the top side of the card facing up.

2 Slide the card into the slot until the card is completely seated in its 
connector. 

If you encounter too much resistance, do not force the card. Check the 
card orientation and try again.

1 ExpressCard/34 2 ExpressCard/54

1 2
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The Tablet-PC recognizes the ExpressCard and automatically loads the 
appropriate device driver. If the configuration program tells you to load the 
manufacturer's drivers, use the CD that came with the ExpressCard.

Removing an ExpressCard

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

Press the card into the slot to eject the card. 

Smart Cards

 NOTE: You can use smart cards with your Tablet-PC only if you have also 
purchased the optional smart-card reader that installs into the ExpressCard slot.
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About Smart Cards

Smart cards are portable credit-card shaped devices with internal integrated 
circuits. The top surface of the smart card usually contains an embedded 
processor under the gold contact pad. The combination of the small size and 
integrated circuits make smart cards valuable tools for security, data storage, 
and special programs. Using smart cards can improve system security by 
combining something a user has (the smart card) with something only the 
user should know (a PIN) to provide more secure user-authentication than 
passwords alone.

For more information about how to secure your Tablet-PC, see "Securing Your 
Tablet-PC" on page 111.

Installing a Smart Card

You can install a smart card in the Tablet-PC while the Tablet-PC is running. 
The Tablet-PC automatically detects the card.

To install a smart card:

 NOTE: You can use smart cards with your Tablet-PC only if you have also 
purchased the optional smart-card reader that installs into the ExpressCard slot.

1 Hold the card so that the gold contact pad is facing upward and pointing 
toward the smart-card reader’s slot.

1 gold contact pad 2 smart card (top)

1

2
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2 Slide the smart card into the smart card slot until the card is completely 
seated in its connector. The smart card will protrude approximately 1/2 
inch from the slot.

If you encounter too much resistance, do not force the card. Check the card 
orientation and try again.

Secure Digital (SD) Cards
Secure Digital (SD) cards are storage media used in portable devices such as 
digital cameras, handheld computers, PDAs, and GPS units.

Installing an SD Card

1 Hold the card so that the gold contact pad is facing upward and pointing 
toward the SD card slot. The SD card slot is located above the 
ExpressCard slot.

2 Slide the SD card into the SD card slot until the card is completely seated 
in its connector. The SD card will protrude approximately 1/2 inch from 
the slot. 

If you encounter too much resistance, do not force the card. Check the card 
orientation and try again.
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4
Using Your Tablet-PC With a 
Projector 
You can use the Tablet-PC display in the notebook or tablet position and set 
the display orientation to either landscape or portrait. The position and 
orientation of the Tablet-PC display affect how a projector displays the image 
from the Tablet-PC. In addition to the display position and orientation, you 
can adjust the projected image using the Tablet-PC clone and extended 
desktop modes. 

Display Positions
Your Tablet-PC display operates in two positions: classic notebook and tablet. 

Classic Notebook
Classic notebook is the standard position with the display raised above the 
keyboard and touch pad. In this position, the display has a landscape 
orientation and you use the keyboard and touch pad as input devices. 

Tablet 
To use your Tablet-PC in tablet position, raise the display and rotate it 180 
degrees, and then fold the display over the keyboard with the display facing 
upwards. In this position, you use either touch or the digitizer pen as input 
devices; that is, you touch the screen with either your finger or the digitizer 
pen. 

In tablet position, the display image has a portrait orientation. You can switch 
the display image between portrait and landscape orientation using the 
Screen Rotate button. See "Using Tablet Buttons" on page 62 for more 
information on the Screen Rotate button. 
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 NOTE: When the Tablet-PC display has a portrait orientation and you are using 
clone mode, the projector displays an image that is rotated sideways and not 
viewable. To correct the displayed image, change the Tablet-PC display to 
landscape orientation using the Screen Rotate button or use the projector’s menu 
options or other features to rotate the displayed image. See "Using Tablet Buttons" 
on page 62 for more information on the Screen Rotate button. 

Display Modes 
The Tablet-PC includes the clone and extended desktop modes for adjusting 
the image displayed by a projector. 

Clone Mode (Mirrored) 
The clone mode enables the projector to display the exact image that is on 
the Tablet-PC display. In clone mode, the projector displays mouse cursor 
movement and handwriting or drawing with the digitizer pen. Clone mode is 
useful when using the mouse cursor as a pointing device or when you want 
the projector to display user activity that is occurring on the Tablet-PC. 

 NOTE: When you initially connect the Tablet-PC to a projector, the Microsoft 
Windows operating system asks you to specify default display settings. To enable 
clone mode, select Duplicate my desktop on all displays (mirrored). To send the 
Tablet-PC display to the projector, use the <Fn><F8> key combination. You can 
change the default display settings at a later time. 

Considerations for Using Portrait or Landscape Orientation in Clone Mode 

Because clone mode displays the exact image from the Tablet-PC, using the 
landscape or portrait orientation affects the image displayed by the projector. 

Landscape is the typical orientation in clone mode and is displayed normally 
by the projector. 

When the Tablet-PC display is in tablet position and you are using a portrait 
orientation in clone mode, the projector displays an image that is rotated 
sideways and not viewable. To correct the projected image you can: 

• Use the Screen Rotate button to change the Tablet-PC display to 
landscape orientation. See "Using Tablet Buttons" on page 62 for more 
information on the Screen Rotate button. 

• Use the projector’s menu options or other features to rotate the projected 
image. 
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Considerations for Display Resolution and Aspect Ratio in Clone Mode 

If the projector has a lower display resolution and aspect ratio than the 
Tablet-PC display, then the Tablet-PC graphics subsystem uses the lowest 
display resolution and aspect ratio. Changing to a lower display resolution and 
aspect ratio alters the image quality. 

For example, if the Tablet-PC has a display resolution of 1280 x 800 pixels 
with a 16:10 aspect ratio and the projector is using a 1024 x 768 display 
resolution with a 4:3 aspect ratio, then you may notice that: 

• The projected image is not as sharp as it would be with a 1280 x 800 
display resolution. The loss of sharpness is particularly noticeable when 
reading text. 

• Round objects appear flattened. This alteration is a result of shifting from 
the 16:10 to the 4:3 aspect ratio. 

Extended Desktop Mode
Extended desktop mode enables you to configure two displays that each have 
their own attributes. You can use the Tablet-PC display in tablet mode with 
portrait orientation using a 1280 x 800 resolution, and the projector can use 
the standard landscape orientation at a lower resolution and aspect ratio. 

When using extended desktop mode, you start applications on the Tablet-PC 
and then "drag" the applications that you want to be viewed from the 
projector to the extended desktop. Extended desktop mode is useful when 
you want to maintain user activity on the Tablet-PC without displaying this 
activity with the projector. 

 NOTE: When you initially connect the Tablet-PC to a projector, the Windows 
operating system asks you to specify default display settings. To enable extended 
desktop mode, select Show different parts of my desktop on each display 
(extended). To send the Tablet-PC display image to the projector, use the <Fn><F8> 
key combination. You can then "drag" the applications you want to project from the 
Tablet-PC to the extended desktop (the projector). You can change the default 
display settings at a later time. 

Changing the Display Settings for the Projector
To change the default display settings: 

1 Open the ATI CATALYST® Control Center: 
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• In Windows® Vista®, right-click the desktop and select ATI 
CATALYST® Control Center. 

• In Windows XP, select Start→ All Programs→ Catalyst Control 
Center→ Advanced→ Catalyst Control Center - Advanced. 

2 Select Displays Manger under Graphics Settings. 

The projector is displayed as an icon in the right-hand pane under 
Desktop and Display Setup. 

3 Right-click the projector icon and select Clone Desktop 1 with monitor 
for clone mode or Extend Main onto monitor for extended desktop 
mode. 

Afterwards, you may access these settings by using the <Fn><F8> key 
combination.
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5
Setting Up and Using Networks
Setting up a computer network provides connectivity between your 
Tablet-PC and the Internet, another computer, or a network. For example, 
with a network set up in a home or small office you can print to a shared 
printer, access drives and files on another computer, browse other networks, or 
access the Internet. You can set up a local area network (LAN) using a 
network or broadband modem cable or set up a wireless LAN (WLAN). 

Microsoft Windows provides a wizard to help guide you through the process 
of networking computers. For more information about networking, see 
"Windows Help and Support" on page 19.

Connecting a Network or Broadband Modem
Before you connect your Tablet-PC to a network, the Tablet-PC must have a 
network adapter installed and a network cable connected to it.

1 Connect the network cable to the network adapter connector on the back 
of your Tablet-PC.

 NOTE: Insert the cable connector until it clicks into place, and then gently 
pull the cable to ensure that it is securely attached.

2 Connect the other end of the network cable to a network connection 
device or a network wall connector.

 NOTE: Do not use a network cable with a telephone wall connector.
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Network Setup Wizard

Windows Vista

1 Click Start  and then click Connect To→ Set up a connection or 
network.

2 Select an option under Choose a connection option.

3 Click Next, and then follow the instructions in the wizard.

Windows XP 

1 Click Start and then click Control Panel.

2 Click Network and Internet Connections. 

3 Select a network setup task and follow the instructions in the wizard.

Wireless Local Area Network (WLAN)
A WLAN is a series of interconnected computers that communicate with 
each other over the air waves rather than through a network cable connected 
to each computer. In a WLAN, a radio communications device called an 
access point or wireless router connects network computers and provides 
Internet, or network, access. The access point or wireless router and the 
wireless network adapter in the computer or Tablet-PC communicate by 
broadcasting data from their antennas over the air waves.
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What You Need to Establish a WLAN Connection
Before you can set up a WLAN, you need:

• High-speed (broadband) Internet access (such as cable or DSL)

• A broadband modem that is connected and working

• A wireless router or access point

• A wireless network adapter for each computer or Tablet-PC that you want 
to connect to your WLAN

• A network cable with a network (RJ-45) connector 

Checking Your Wireless Network Adapter
Depending on what you selected when you purchased your Tablet-PC, the 
Tablet-PC has a variety of configurations. To confirm that your Tablet-PC has 
a wireless network adapter and to determine the type of card, use one of the 
following:

• The Windows Start button (  in Windows Vista) and the Connect To 
option

• The order confirmation for your Tablet-PC

Start Button and Connect To Option

To view your wireless network adapter: 

• In Windows Vista, click Start → Connect To→ View network 
computers and devices.

• In Windows XP, click Start→ Connect To→ Wireless Network 
Connection. 

If Wireless Network Connection does not appear, your Tablet-PC may not 
have a wireless network adapter installed. 

If Wireless Network Connection appears, you have a wireless network adapter. 
To view detailed information about the wireless network adapter:

1 Right-click Wireless Network Connection.

2 Click Properties.

The Wireless Network Connection Properties window appears. The 
wireless network adapter’s name and model number are listed on the 
General tab.
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The Order Confirmation for Your Tablet-PC

The order confirmation that you received when you ordered your Tablet-PC 
lists the hardware and software that shipped with your Tablet-PC.

Setting Up a New WLAN Using a Wireless Router and a Broadband 
Modem

1 Contact your Internet service provider (ISP) to obtain specific information 
about the connection requirements for your broadband modem.

2 Ensure that you have wired Internet access through your broadband 
modem before you attempt to set up a wireless Internet connection (see 
"Connecting a Network or Broadband Modem" on page 99).

3 Install any software required for your wireless router. Your wireless router 
may have been shipped with an installation media. Installation media 
usually contains installation and troubleshooting information. Install the 
required software according to the instructions provided by the router 
manufacturer. 

4 Shut down your Tablet-PC and any other wireless-enabled computers in 
the vicinity through the Windows Start button (  in Windows Vista) 
menu. 

5 Disconnect your broadband modem power cable from the electrical outlet.

6 Disconnect the network cable from the Tablet-PC and the broadband 
modem.

7 Disconnect the AC adapter cable from your wireless router to ensure that 
there is no power connected to the router.

 NOTE: Wait for a minimum of 5 minutes after disconnecting your broadband 
modem before you continue with the network setup.

8 Insert a network cable into the network (RJ-45) connector on the 
unpowered broadband modem.

9 Connect the other end of the network cable into the Internet network (RJ-
45) connector on the unpowered wireless router.

10 Ensure that no network or USB cables, other than the network cable 
connecting the broadband modem and the wireless router, are connected 
to the broadband modem.
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 NOTE: Restart your wireless equipment in the order described below to prevent a 
potential connection failure.

11 Turn on only your broadband modem and wait for at least 2 minutes for 
the broadband modem to stabilize. After 2 minutes, proceed to step 12.

12 Turn on your wireless router and wait for at least 2 minutes for the wireless 
router to stabilize. After 2 minutes, proceed to the step 13.

13 Start your Tablet-PC and wait until the boot process completes.

14 See the documentation that came with your wireless router to do the 
following in order to set up the wireless router:

a Establish communication between your Tablet-PC and your wireless 
router.

b Configure your wireless router to communicate with your broadband 
router.

c Find out your wireless router’s broadcast name. The technical term for 
the name of your router’s broadcast name is Service Set Identifier 
(SSID) or network name.

15 If necessary, configure your wireless network adapter to connect to the 
wireless network (see "Connecting to a WLAN" on page 103).

Connecting to a WLAN

 NOTE: Before you connect to a WLAN, ensure that you have followed the 
instructions in "Wireless Local Area Network (WLAN)" on page 100.

 NOTE: The following networking instructions do not apply to internal cards with 
Bluetooth® wireless technology or cellular products.

This section provides general procedures for connecting to a network using 
wireless technology. Specific network names and configuration details vary. 
See "Wireless Local Area Network (WLAN)" on page 100 for more 
information about how to prepare for connecting your Tablet-PC to a WLAN. 

Your wireless network adapter requires specific software and drivers for 
connecting to a network. The software is already installed. 

 NOTE: If the software is removed or corrupted, follow the instructions in the user 
documentation for your wireless network adapter. Verify the type of wireless 
network adapter installed in your Tablet-PC and then search for that name on the 
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Dell™ Support website at support.dell.com. For information on the type of wireless 
network adapter that is installed in your Tablet-PC, see "Checking Your Wireless 
Network Adapter" on page 101.

Determining the Wireless Network Device Manager

Depending on the software installed on your Tablet-PC, different wireless 
configuration utilities may manage your network devices:

• Your wireless network adapter’s client utility

• The operating system

To determine which wireless configuration utility is managing your wireless 
network adapter: 

• In Windows Vista, click Start → Connect To→ Manage wireless 
networks. Double-click a profile to open the wireless network properties 
screen. 

• In Windows XP, click Start→ All Programs→ Dell Wireless→ Dell 
Wireless WLAN Card Utility. 

For specific information about the wireless configuration utility installed on 
your Tablet-PC, see your wireless network documentation in "Windows Help 
and Support" on page 19.

Completing the Connection to the WLAN

When you turn on your Tablet-PC and a network (for which your Tablet-PC 
is not configured) is detected, a pop-up appears in the lower-right corner of 
the Windows desktop. 

Follow any instructions that appear on your screen.

Once you have configured your Tablet-PC for the wireless network that you 
selected, another pop-up notifies you that your Tablet-PC is connected to 
that network. 

Thereafter, whenever you log on to your Tablet-PC within the range of the 
wireless network that you selected, the same pop-up notifies you of the 
wireless network connection. 

 NOTE: If you select a secure network, you must enter a WEP or WPA key when 
prompted. Network security settings are unique to your network. Dell cannot 
provide this information. 

 NOTE: Your Tablet-PC can take up to 1 minute to connect to the network. 
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Monitoring the Status of the Wireless network adapter Through Dell QuickSet

The wireless activity indicator provides you with an easy way to monitor the 
status of your Tablet-PC’s wireless devices. To turn the wireless activity 
indicator on or off, click the QuickSet icon in the taskbar and select Hotkey 
Popups. If Wireless Activity Indicator Off is not checked, the indicator is on. 
If Wireless Activity Indicator Off is checked, the indicator is off.

The wireless activity indicator displays whether your Tablet-PC’s integrated 
wireless devices are enabled or disabled. When you turn the wireless 
networking function on or off, the wireless activity indicator changes to 
display the status. 

For more information about the Dell QuickSet wireless activity indicator, 
right-click the QuickSet icon in the taskbar and select Help.

Mobile Broadband/Wireless Wide Area Network 
(WWAN)
A Mobile Broadband network, also known as a wireless wide area network 
(WWAN), is a high-speed digital cellular network that provides Internet 
access over a much wider geographical area than a WLAN, which typically 
covers only from 100 to 1000 feet. Your Tablet-PC can maintain Mobile 
Broadband network access as long as the Tablet-PC is within a cellular-data 
coverage zone. Contact your service provider for coverage of a high-speed 
digital cellular network.

 NOTE: Even if you are able to make a call from your cellular phone in a specific 
geographical location, that location may not necessarily be within a cellular-data 
coverage zone.

What You Need to Establish a Mobile Broadband Network Connection

 NOTE: Depending on your Tablet-PC, you can use either a Mobile Broadband 
ExpressCard or Mini-Card, but not both, to establish a Mobile Broadband network 
connection.

To set up a Mobile Broadband network connection, you need: 

• A Mobile Broadband ExpressCard or Mini-Card (depending on your 
Tablet-PC’s configuration)

 NOTE: For instructions on using ExpressCards, see "ExpressCards" on 
page 89
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• An activated Mobile Broadband ExpressCard or activated Subscriber 
Identity Module (SIM) for your service provider

• An extended whip antenna.

• The Dell Mobile Broadband Card Utility (already installed on your 
Tablet-PC if you purchased the card when you purchased your Tablet-PC, 
or on the CD that accompanied your card if purchased separately from 
your Tablet-PC)

If the utility is corrupted or deleted from your Tablet-PC, see the Dell 
Mobile Broadband Card Utility user’s guide for instructions. The user’s 
guide is available through Windows Help and Support (see "Windows 
Help and Support" on page 19) or on the CD that accompanied your card 
if you purchased it separately from your Tablet-PC.

Checking Your Dell Mobile Broadband Card
Depending on what you selected when you purchased your Tablet-PC, the 
Tablet-PC has a variety of configurations. To determine the type of Mobile 
Broadband card installed on your Tablet-PC, see one of the following:

• Your order confirmation

• Microsoft Windows Help and Support or My Computer. 
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Windows Vista 

1 Click Start → Help and Support→ Use Tools to view your computer 
information and diagnose problems.

2 Under Tools, click My Computer Information→ Find information about 
the hardware installed on this computer.

On the My Computer Information - Hardware screen, you can view the type 
of Mobile Broadband card installed in your Tablet-PC as well as other 
hardware components.

 NOTE: The Mobile Broadband card is listed under Modems.

Windows XP 

1 Click Start→ My Computer→ View System Information.

2 Click the Hardware tab. 

3 Click Device Manager. The Device Manager displays the hardware 
components installed on the system. 

Connecting to a Mobile Broadband Network

 NOTE: These instructions only apply to Mobile Broadband ExpressCards or Mini-
Cards. They do not apply to internal cards with wireless technology.

 NOTE: Before you connect to the Internet, you must activate Mobile Broadband 
service through your cellular service provider. For instructions and for additional 
information about using the Dell Mobile Broadband Card Utility, see the user's guide 
available through Windows Help and Support (see "Windows Help and Support" on 
page 19). The user's guide is also available on the Dell Support website at 
support.dell.com and on the CD included with your Mobile Broadband card, if you 
purchased the card separately from your Tablet-PC.

Use the Dell Mobile Broadband Card Utility to establish and manage a 
Mobile Broadband network connection to the Internet:

1 Click the Dell Mobile Broadband Card Utility icon on the Windows 
desktop, to run the utility.

2 Click Connect. 

 NOTE: The Connect button changes to the Disconnect button. 

3 Extend the external whip antenna and adjust orientation to achieve 
optimal signal strength.
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4 Follow the instructions on the screen to manage the network connection 
with the utility.

Or

1 Click Start  (or Start in Windows XP)→ All Programs→ Dell 
Wireless. 

2 Select the option for Broadband and follow the instructions on the screen.

3 Extend the external whip antenna and adjust orientation to achieve 
optimal signal strength.

Enabling/Disabling the Dell Mobile Broadband Card

 NOTE: If you are unable to connect to a Mobile Broadband network, ensure that 
you have all the components for establishing a Mobile Broadband connection (see 
"What You Need to Establish a Mobile Broadband Network Connection" on 
page 105), and then verify that your Mobile Broadband card is enabled by verifying 
the setting of the wireless switch.

You can turn your Tablet-PC’s wireless devices on and off with the wireless 
switch on the left side of the Tablet-PC (see "Left Side View" on page 32). 

If the switch is in the "on" position, move the switch to the "off" position to 
disable the switch and the Mobile Broadband card. If the switch is in the "off" 
position, move the switch to the "on" position to enable the switch and the 
Dell Mobile Broadband card. For information about the wireless switch 
positions, see "Dell Wi-Fi Catcher™ Network Locator" on page 109.

To monitor the status of your wireless device, see "Monitoring the Status of 
the Wireless network adapter Through Dell QuickSet" on page 105.

Managing Your Network Settings Through the Dell QuickSet Location 
Profiler
The Dell QuickSet Location Profiler helps you manage network settings that 
correspond to your Tablet-PC’s physical location. It includes two categories of 
profile settings:

• Location Profile Settings

• General Mobility Settings
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You can use Location Profile Settings to create profiles for accessing the 
Internet with your Tablet-PC in your office, home, or other public places with 
Internet services. General Mobility Settings allows you to change the way 
network connections are handled. The profiles consist of different network 
settings and equipment that you need when using your Tablet-PC in different 
locations.

For more information about Dell QuickSet, right-click the QuickSet icon in 
the taskbar and select Help.

Dell Wi-Fi Catcher™ Network Locator
The wireless switch on your Dell Tablet-PC uses the Dell Wi-Fi Catcher 
Network Locator to scan specifically for WiFi WLAN in your vicinity. 

To scan for WiFi WLAN, slide and hold the switch in the "momentary" 
position for a few seconds. The Wi-Fi Catcher Network Locator functions 
regardless of whether your Tablet-PC is turned on or off, in hibernate, sleep, 
or standby mode, as long as the switch is configured through Dell QuickSet or 
the BIOS (system setup program) to control WiFi network connections. 

 NOTE: The Dell Wi-Fi Catcher Network Locator light appears only when the 
computer is turned off and wireless networking is activated in the system setup 
program. While working in a Microsoft Windows operating system, the light is 
designed not to appear.

Because the Wi-Fi Catcher Network Locator is disabled and not configured 
for use when your Tablet-PC is shipped to you, you must first use Dell 
QuickSet to enable and configure the switch to control WiFi network 
connections.

For more information on the Wi-Fi Catcher Network Locator and to enable 
the feature through Dell QuickSet, right-click the QuickSet icon in the 
taskbar and select Help.

Microsoft®Windows® Firewall
Windows Firewall provides basic protection from unauthorized access to your 
Tablet-PC while it is connected to the Internet. Windows Firewall is 
automatically enabled when you run the Network Setup Wizard.
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When Windows Firewall is enabled for a network connection, the Firewall 
icon appears with a red background in the Network Connections section of 
the Control Panel. 

To access options for enabling Windows Firewall: 

• In Windows Vista, click Start → Control Panel→ Security→ Windows 
Firewall. 

• In Windows XP, click Start → Control Panel→ Security Center→ 
Windows Firewall. 

 NOTE: Enabling Windows Firewall does not reduce the need for virus-checking 
software.

For more information, see "Windows Help and Support" on page 19.
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6
Securing Your Tablet-PC

Security Cable Lock
 NOTICE: Before you buy an antitheft device, ensure that it will work with the 

security cable slot on your Tablet-PC.

 NOTE: Your Tablet-PC does not ship with a security cable lock.

A security cable lock is a commercially available antitheft device. To use the 
lock, attach it to the security cable slot on your Tablet-PC. For more 
information, see the instructions included with the device.

Smart Cards and Biometric Readers
 NOTE: For information on how to secure your Tablet-PC while traveling, see 

"Traveling With Your Tablet-PC" on page 225.
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Smart cards are portable credit-card shaped devices with internal integrated 
circuits. Using smart cards can improve system security by combining 
something a user has (the smart card) with something only the user should 
know (a PIN) to provide more secure user-authentication than passwords 
alone. See "Smart Cards" on page 91 for more information.

A biometric reader is a strip sensor located on your Tablet-PC’s display. When 
you slide your finger over the reader, it uses your unique fingerprint to 
authenticate your user identity and help keep your Tablet-PC secure. 

 NOTE: You must purchase optional software in order to configure and use your 
biometric reader. See the documentation that ships with the biometric software for 
further information.

Passwords

About Passwords

 NOTE: Passwords are disabled when you receive your Tablet-PC.

A primary (or system) password, an administrator password, and a hard drive 
password all prevent unauthorized access to your Tablet-PC in different ways. 
The following table identifies types and features of passwords available on 
your Tablet-PC.

 NOTE: Some hard drives do not support hard drive passwords. 

Type of Password Features

Primary (or system) • Protects the Tablet-PC from unauthorized 
access

Administrator • Gives system administrators or service 
technicians access to Tablet-PCs for repair or 
reconfiguration

• Allows you to restrict access to system setup in 
the same way a primary password restricts access 
to the Tablet-PC

• Can be used instead of the primary password

Hard drive • Helps protect the data on your hard drive or 
external hard drive (if one is being used) from 
unauthorized access
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 NOTICE: Passwords provide a high level of security for data in your Tablet-PC or 
hard drive. However, they are not foolproof. If you require more security, obtain and 
use additional forms of protection, such as smart cards, data encryption programs, 
or PC Cards with encryption features. 

When using passwords, observe the following guidelines:

• Choose passwords that you can remember, but not ones that are easy to 
guess. For example, do not use the names of family members or pets for 
passwords.

• It is recommended that you do not write down passwords. If you do write it 
down, however, ensure that the password is stored in a secure place.

• Do not share passwords with other people.

• Ensure that people are not watching you when you type your password.

If you forget any of your passwords, contact Dell (see "Contacting Dell" on 
page 26). For your protection, Dell technical support staff will ask you for 
proof of your identity to ensure that only an authorized person can use the 
Tablet-PC.

Using a Primary (or System) Password
The primary password allows you to protect the Tablet-PC from unauthorized 
access.

When you first start your Tablet-PC, you must assign a primary password at 
the prompt.

If you do not enter a password within 2 minutes, the Tablet-PC returns to its 
previous operating state.

 NOTICE: If you disable the administrator password, the primary password is also 
disabled.

To add or change passwords, access User Accounts from the Control Panel. 

If you have assigned an administrator password, you can use it instead of the 
primary password. The Tablet-PC does not specifically prompt you for the 
administrator password.
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Using an Administrator Password
The administrator password is designed to give system administrators or 
service technicians access to computers for repair or reconfiguration. The 
administrators or technicians can assign identical administrator passwords to 
groups of computers, allowing you to assign a unique primary password.

To set or change administrator passwords, access User Accounts from the 
Control Panel.

When you set an administrator password, the Configure Setup option 
becomes available in system setup. The Configure Setup option allows you to 
restrict access to system setup in the same way that a primary password 
restricts access to the Tablet-PC.

The administrator password can be used instead of the primary password. 
Whenever you are prompted to enter the primary password, you can enter the 
administrator password.

 NOTICE: If you disable the administrator password, the primary password is also 
disabled.

 NOTE: The administrator password provides access to the Tablet-PC, but it does 
not provide access to the hard drive when a hard drive password is assigned. 

If you forget the primary password and do not have an administrator password 
assigned, or if you have both a primary and an administrator password 
assigned but forget them both, contact your system administrator or contact 
Dell (see "Contacting Dell" on page 26).

Using a Hard Drive Password
The hard drive password helps protect the data on your hard drive from 
unauthorized access. You can also assign a password for an external hard drive 
(if one is being used) that can be the same as or different from the password 
for the primary hard drive.

To assign or change a hard drive password, enter system setup (see "Using the 
System Setup Program" on page 141).

After assigning a hard drive password, you must enter it each time you turn on 
the Tablet-PC and each time you restore the Tablet-PC to normal operation 
from sleep, standby, or hibernate mode.

If the hard drive password is enabled, you must enter it each time you turn on 
the Tablet-PC: A message appears asking for the hard drive password.
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To continue, enter your password (with no more than eight characters) and 
press <Enter>. 

If you do not enter a password within 2 minutes, the Tablet-PC returns to its 
previous operating state.

If you enter the wrong password, a message tells you that the password is 
invalid. Press <Enter> to try again.

If you do not enter the correct password in three attempts, the Tablet-PC tries 
to start from another bootable device if the Boot First Device option in 
system setup is set to allow start-up from another device. If the Boot First 
Device option is not set to allow the Tablet-PC to start from another device, 
the Tablet-PC returns to the operating state it was in when you turned it on.

If the hard drive password, the external hard drive password, and the primary 
password are the same, the Tablet-PC prompts you only for the primary 
password. If the hard drive password is different from the primary password, 
the Tablet-PC prompts you for both. Two different passwords provide greater 
security.

 NOTE: The administrator password provides access to the Tablet-PC, but it does 
not provide access to the hard drive when a hard drive password is assigned. 

Trusted Platform Module (TPM)
 NOTE: Computers shipping into China are not equipped with the TPM feature. 

 NOTE: The TPM feature supports encryption only if the operating system supports 
TPM. For more information, see the TPM software documentation and the help files 
that came with the software.

TPM is a hardware-based security feature that can be used to create and 
manage computer-generated encryption keys. When combined with security 
software, the TPM enhances existing network and computer security by 
enabling features such as file protection capabilities and protected e-mail. 
The TPM feature is enabled through a system setup option.

 NOTICE: To secure your TPM data and encryption keys, follow the backup 
procedures documented in the Broadcom Secure Foundation Getting Started 
Guide. In the event of these backups being incomplete, lost, or damaged, Dell will 
be unable to assist in the recovery of encrypted data.
Securing Your Tablet-PC 115



book.book  Page 116  Tuesday, May 13, 2008  5:03 PM
Enabling the TPM Feature
1 Enable the TPM software:

a Restart the Tablet-PC and press <F2> during the Power On Self Test 
to enter the system setup program.

b Select Security→ TPM Security and press <Enter>.

c Under TPM Security, select On.

d Press <Esc> to exit the setup program. 

e If prompted, click Save/Exit.

2 Activate the TPM setup program: 

a Restart the Tablet-PC and press <F2> during the Power On Self Test 
to enter the system setup program.

b Select Security→ TPM Activation and press <Enter>.

c Under TPM Activation, select Activate and press <Enter>.

 NOTE: You only need to activate the program once.

d Once the process is complete, the Tablet-PC either restarts 
automatically or prompts you to restart your Tablet-PC.

Security Management Software
The security management software is designed to use four different features 
to help you secure your Tablet-PC:

• Log-in management

• Pre-boot authentication (using a biometric reader, smart card, or password)

• Encryption

• Private information management

Activating the Security Management Software

 NOTE: You must first enable the TPM in order for the security management 
software to have full functionality.

1 Enable the TPM feature (see "Enabling the TPM Feature" on page 116).

2 Load the security management software:

a Turn on (or restart) your Tablet-PC.
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b When the DELL™ logo appears, press <F2> immediately. If you wait 
too long and the Windows logo appears, continue to wait until you see 
the Windows desktop. Then shut down your Tablet-PC and try again.

c In the drop-down menu, select Wave EMBASSY Trust Suite and press 
<Enter> to create the icons for the software components on the 
Tablet-PC desktop.

d Press <Esc> to exit the setup program. 

e If prompted, click Save/Exit.

Using the Security Management Software
For information about how to use the software and the different security 
features, see the Getting Started Guide for the software. To access the Getting 
Started Guide: 

• In Windows® Vista®, click Start → All Programs→ Wave EMBASSY 
Trust Suite→ Getting Started Guide. 

• In Windows XP, click Start→ All Programs→ Security by Wave Systems→ 
Getting Started with EMBASSY Trust Suite. 

Computer Tracking Software
Computer tracking software may enable you to locate your Tablet-PC if it is 
lost or stolen. The software is optional and may be purchased when you order 
your Dell™ Tablet-PC, or you can contact your Dell sales representative for 
information about this security feature.

 NOTE: Computer tracking software may not be available in certain countries.

 NOTE: If you have computer tracking software and your Tablet-PC is lost or stolen, 
you must contact the company that provides the tracking service to report the 
missing Tablet-PC.

If Your Tablet-PC Is Lost or Stolen
• Call a law enforcement agency to report the lost or stolen Tablet-PC. 

Include the Service Tag in your description of the Tablet-PC. Ask that a 
case number be assigned and write down the number, along with the 
name, address, and phone number of the law enforcement agency. If 
possible, obtain the name of the investigating officer.
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 NOTE: If you know where the Tablet-PC was lost or stolen, call a law enforcement 
agency in that area. If you do not know, call a law enforcement agency where you 
live.

• If the Tablet-PC belongs to a company, notify the security office of the 
company.

• Contact Dell customer service to report the missing Tablet-PC. Provide 
the Tablet-PC Service Tag, the case number, and the name, address, and 
phone number of the law enforcement agency to which you reported the 
missing Tablet-PC. If possible, give the name of the investigating officer.

The Dell customer service representative will log your report under the 
Tablet-PC Service Tag and record the Tablet-PC as missing or stolen. If 
someone calls Dell for technical assistance and gives your Service Tag, the 
Tablet-PC is identified automatically as missing or stolen. The representative 
will attempt to get the phone number and address of the caller. Dell will then 
contact the law enforcement agency to which you reported the missing 
Tablet-PC.
Securing Your Tablet-PC 118



book.book  Page 119  Tuesday, May 13, 2008  5:03 PM
7
Cleaning Your Tablet-PC

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

Tablet-PC, Keyboard, and Display
 CAUTION: Before you clean your Tablet-PC, disconnect the Tablet-PC from the 

electrical outlet and, if necessary, the optional media base or battery slice. 
Remove any installed batteries. Clean your Tablet-PC with a soft cloth dampened 
with water. Do not use liquid or aerosol cleaners, which may contain flammable 
substances.

• Use a can of compressed air to remove dust from between the keys on the 
keyboard.

 NOTICE: To avoid damaging the Tablet-PC or display, do not spray cleaning 
solution directly onto the display. Only use products specifically designed for 
cleaning displays, and follow the instructions that are included with the product.

• Moisten a soft, lint-free cloth with either water or a display cleaner, and 
wipe the display until it is clean.

• Moisten a soft, lint-free cloth with water and wipe the Tablet-PC and 
keyboard. Do not allow water from the cloth to seep between the touch 
pad and the surrounding palm rest.

Touch Pad
1 Shut down and turn off your Tablet-PC.

2 Disconnect any attached devices from the Tablet-PC and from their 
electrical outlets.

3 If applicable, undock your Tablet-PC from the optional media base or 
battery slice.

4 Remove any installed batteries (see "Removing the Main Battery" on 
page 158).
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5 Moisten a soft, lint-free cloth with water, and wipe it gently across the 
surface of the touch pad. Do not allow water from the cloth to seep 
between the touch pad and the surrounding palm rest.

Optical Drives and Optical Drive Media
 NOTICE: Always use compressed air to clean the lens in an optical drive, and 

follow the instructions that come with the compressed-air product. Never touch the 
lens in the drive.

 NOTE: Unless you purchased either an optional external D/Bay or an optional 
media base with your Tablet-PC, you may not be able to use optical drives or optical 
drive media with your Tablet-PC.

If you notice problems, such as skipping, with the playback quality of your 
optical media, try cleaning the disc.

1 Hold the disc by its outer edge. You can also touch the inside edge of the 
center hole.

 NOTICE: To avoid damaging the surface, do not wipe in a circular motion around 
the disc.

2 With a soft, lint-free cloth, gently wipe the bottom of the disc (the 
unlabeled side) in a straight line from the center to the outer edge of the 
disc.

For stubborn dirt, try using water or a diluted solution of water and mild 
soap. You can also purchase commercial products that clean discs and 
provide some protection from dust, fingerprints, and scratches. Cleaning 
products for CDs are also safe to use on DVDs.
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8
Troubleshooting
Some of the tools you may be using as you troubleshoot problems on your 
Tablet-PC include:

• Dell Diagnostics

• Dell Support Utility (Windows Vista® only) 

• Windows® Hardware Troubleshooter 

Dell Diagnostics
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

 NOTICE: The Dell Diagnostics works only on Dell™ computers.

When to Use the Dell Diagnostics
If you experience a problem with your Tablet-PC, perform the checks in 
Lockups and Software Problems (see "Lockups and Software Problems" on 
page 130), and run the Dell Diagnostics before you contact Dell for technical 
assistance.

It is recommended that you print these procedures before you begin.

See "Using the System Setup Program" on page 141 to review your 
Tablet-PC’s configuration information, and ensure that the device that you 
want to test displays in the system setup program and is active.

Start the Dell Diagnostics from your hard drive or from the Drivers and 
Utilities media. 

 NOTE: The Drivers and Utilities media is optional and may not ship with your 
Tablet-PC.

Starting the Dell Diagnostics From Your Hard Drive
The Dell Diagnostics is located on a hidden diagnostic utility partition on 
your hard drive.
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 NOTE: If your Tablet-PC does not display a screen image, contact Dell (see 
"Contacting Dell" on page 26).

 NOTE: If the Tablet-PC is connected to a docking device (docked), undock it. See 
"Undocking Your Tablet-PC From the Media Base" on page 212 and "Undocking Your 
Tablet-PC From the Battery Slice" on page 220 for instructions if applicable.

1 Ensure that the Tablet-PC is connected to an electrical outlet that is 
known to be working properly.

2 Turn on (or restart) your Tablet-PC.

3 Start the Dell Diagnostics in one of the following two ways:

 NOTE: If you wait too long and the operating system logo appears, continue 
to wait until you see the Microsoft® Windows® desktop; then, shut down your 
Tablet-PC and try again.

– When the DELL™ logo appears, press <F12> immediately. Select 
Diagnostics from the boot menu and press <Enter>.

 NOTE: Before attempting the following option, the Tablet-PC must be 
powered down completely.

– Press and hold the <Fn> key while powering the Tablet-PC on.

 NOTE: If you see a message stating that no diagnostics utility partition has 
been found, run the Dell Diagnostics from the Drivers and Utilities media.

The Tablet-PC runs the Pre-boot System Assessment (PSA), a series of 
initial tests of your system board, keyboard, display, memory, hard drive, 
etc.

• During the assessment, answer any questions that appear.

• If failures are detected during the Pre-boot System Assessment, write 
down the error code(s) and contact Dell (see "Contacting Dell" on 
page 26).

If the Pre-boot System Assessment completes successfully, the following 
message appears: "Booting Dell Diagnostic Utility 
Partition.Press any key to continue."

4 Press any key to start the Dell Diagnostics from the diagnostics utility 
partition on your hard drive.

5 When the Dell Diagnostics Main Menu appears, select the test you want 
to run. See "Dell Diagnostics Main Menu" on page 123.
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Starting the Dell Diagnostics From the Drivers and Utilities Media
1 Insert the Drivers and Utilities media.

2 Shut down and restart the Tablet-PC.

When the DELL logo appears, press <F12> immediately.

 NOTE: If you wait too long and the operating system logo appears, continue 
to wait until you see the Microsoft® Windows® desktop; then, shut down your 
Tablet-PC and try again.

 NOTE: The next steps change the boot sequence for one time only. On the 
next start-up, the Tablet-PC boots according to the devices specified in the 
system setup program.

3 When the boot device list appears, highlight CD/DVD/CD-RW and press 
<Enter>.

4 Select the Boot from CD-ROM option from the menu that appears and 
press <Enter>.

5 Type 1 to start the CD menu and press <Enter> to proceed.

6 Select Run the 32 Bit Dell Diagnostics from the numbered list. If 
multiple versions are listed, select the version appropriate for your 
Tablet-PC.

7 When the Dell Diagnostics Main Menu appears, select the test you want 
to run.

Dell Diagnostics Main Menu
1 After the Dell Diagnostics loads and the Main Menu appears, click the 

button for the option you want.

 NOTE: It is recommended that you select Test System to run a complete test on 
your Tablet-PC.

Option Function

Test Memory Run the stand-alone memory test

Test System Run System Diagnostics

Exit Exit the Diagnostics
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2 After you have selected the Test System option from the main menu, the 
following menu appears:

 NOTE: It is recommended that you select Extended Test from the menu below to 
run a more thorough check of devices in the Tablet-PC.

3 If a problem is encountered during a test, a message appears with an error 
code and a description of the problem. Write down the error code and 
problem description and contact Dell (see "Contacting Dell" on page 26).

 NOTE: The Service Tag for your Tablet-PC is located at the top of each test 
screen. If you contact Dell, technical support will ask for your Service Tag.

4 If you run a test from the Custom Test or Symptom Tree option, click the 
applicable tab described in the following table for more information.

Option Function

Express Test Performs a quick test of devices in the 
system. This typically can take 10 to 20 
minutes.

Extended Test Performs a thorough check of devices in 
the system. This typically can take an 
hour or more.

Custom Test Use to test a specific device or 
customize the tests to be run.

Symptom Tree This option allows you to select tests 
based on a symptom of the problem you 
are having. This option lists the most 
common symptoms.

Tab Function

Results Displays the results of the test and any 
error conditions encountered.

Errors Displays error conditions encountered, 
error codes, and the problem 
description.

Help Describes the test and may indicate 
requirements for running the test.
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5 When the tests are complete, close the test screen to return to the Main 
Menu screen. To exit the Dell Diagnostics and restart the Tablet-PC, close 
the Main Menu screen.

6 Remove the Dell Drivers and Utilities media (if applicable).

Dell Support Utility for Windows Vista 
The Dell Support Utility, installed on your Tablet-PC, provides self-support 
information, software updates, and health scans of your computing 
environment.

Access the Dell Support Utility from the  icon in the Windows 
Notification area or from the Windows Vista® Start  menu.

Accessing the Dell Support Utility
If the Dell Support icon does not appear in your Windows Notification area:

1 Click Start → All Programs→ Dell Support→ Dell Support Settings.

2 Ensure that the Show icon on the Windows Notification area option is 
checked. 

 NOTE: If the Dell Support Utility is not available from the Windows Vista start 
button  menu, go to support.dell.com and download the software.

Configuration Displays your hardware configuration 
for the selected device.

The Dell Diagnostics obtains 
configuration information for all 
devices from system setup, memory, and 
various internal tests, and it displays 
the information in the device list in 
the left pane of the screen. The device 
list may not display the names of all 
the components installed on your 
Tablet-PC or all devices attached to 
your Tablet-PC.

Parameters Allows you to customize the test by 
changing the test settings.

Tab Function (continued)
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The Dell Support Utility is customized for your computing environment.

The  icon in the Windows Notification area functions differently when 
you click, double-click, or right-click the icon.

Clicking the Dell Support Icon
Click or right-click the icon to perform the following tasks:

• Check your computing environment 

• View the Dell Support Utility settings

• Access the help file for the Dell Support Utility

• View frequently asked questions

• Learn more about the Dell Support Utility

• Turn the Dell Support Utility off

Windows Hardware Troubleshooter
If a device is either not detected during the operating system setup or is 
detected but incorrectly configured, you can use the Hardware 
Troubleshooter to resolve the incompatibility.

To start the Hardware Troubleshooter:

1 Click Start  (or Start in Windows XP) and click Help and Support.

2 Type hardware troubleshooter in the search field and press 
<Enter> to start the search. 

In Windows XP, click Hardware Troubleshooter as displayed in the search 
results. 

3 Select the option that best describes the problem and follow the remaining 
troubleshooting steps.

Solving Problems
Follow these tips when you troubleshoot your Tablet-PC:

• If you added or removed a part before the problem started, review the 
installation procedures and ensure that the part is correctly installed.
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• If a peripheral device does not work, ensure that the device is properly 
connected.

• If an error message appears on the screen, write down the exact message. 
This message may help support personnel diagnose and fix the problem.

• If an error message occurs in a program, see the program’s documentation.

 NOTE: The procedures in this document were written for the Windows default 
view, so they may not apply if you set your Dell™ Tablet-PC to the Windows Classic 
view.

Hard Drive Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

E N S U R E  T H A T MI C R O S O F T ® WI N D O W S ® R E C O G N I Z E S  T H E  D R I V E —

• In Windows Vista, click Start  and click Computer.

• In Windows XP, click Start and click My Computer.
If the drive is not displayed, perform a full scan with your antivirus software to check 
for and remove viruses. Viruses can sometimes prevent Windows from recognizing the 
drive.

RU N C H E C K  D I S K —
1 Click Start → Computer. 

In Windows XP, click Start→ My Computer.
2 Right-click the local disk. 
3 Click Properties→ Tools→ Check Now.

In Windows Vista, the User Account Control window may appear. If you are an 
administrator on the Tablet-PC, click Continue; otherwise, contact your 
administrator to continue the desired action.

4 Follow the instructions on the screen.

TE S T  T H E  D R I V E — Insert another drive to eliminate the possibility that the original 
drive is defective.

RU N T H E WI N D O W S  H A R D W A R E  T R O U B L E S H O O T E R — See "Windows Hardware 
Troubleshooter" on page 126.

RU N T H E DE L L  DI A G N O S T I C S — See "Dell Diagnostics" on page 121.
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Optical Drive Problems

 NOTE: Unless you purchased either an optional external D/Bay or an optional 
media base with your Tablet-PC, you may not be able to use optical drives or optical 
drive media with your Tablet-PC.

 NOTE: High-speed optical drive vibration is normal and may cause noise, which 
does not indicate a defect in the drive or the media.

 NOTE: Because of different regions worldwide and different disc formats, not all 
DVD titles work in all DVD drives.

C L E A N  T H E  O P T I C A L  D R I V E  O R  O P T I C A L  D R I V E  M E D I A — See "Optical Drives and 
Optical Drive Media" on page 120.

C H E C K T H E C A B L E  C O N N E C T I O N S

A D J U S T  T H E  W I N D O W S V O L U M E  C O N T R O L —

• Click the speaker icon in the lower-right corner of your screen.

• Ensure that the volume is turned up by clicking the slidebar and dragging it up.

• Ensure that the sound is not muted by clicking any boxes that are checked.

R U N T H E  W I N D O W S H A R D W A R E  T R O U B L E S H O O T E R — See "Windows Hardware 
Troubleshooter" on page 126.

R U N T H E  D E L L  DI A G N O S T I C S — See "Dell Diagnostics" on page 121.

Problems writing to an optical drive

 NOTE: Unless you purchased either an optional external D/Bay or an optional 
media base with your Tablet-PC, you may not be able to use optical drives or optical 
drive media with your Tablet-PC.

C L O S E  O T H E R  P R O G R A M S — The optical drive must receive a steady stream of data 
during the writing process. If the stream is interrupted, an error occurs. Try closing all 
programs before you write to the optical.

TU R N O F F  S L E E P  M O D E  I N WI N D O W S  VI S T A  B E F O R E  W R I T I N G T O  A  D I S C — See 
"Configuring Power Management Settings" on page 79 or search for the keyword sleep 
in Windows Help and Support for information on power management modes.

E-Mail and Internet Problems 

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 NOTE: Do not plug a telephone cable into the network adapter connector (see 
"Back View" on page 36).
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CH E C K T H E  M I C R O S O F T OU T L O O K ® E X P R E S S S E C U R I T Y  S E T T I N G S — If you cannot 
open your e-mail attachments:

1 In Outlook Express, click Tools→ Options→ Security.
2 Click Do not allow attachments to remove the checkmark, as needed.

E N S U R E  T H A T Y O U A R E  C O N N E C T E D T O  T H E  I N T E R N E T — Ensure that you have 
subscribed to an Internet provider. With the Outlook Express e-mail program open, 
click File. If Work Offline has a checkmark next to it, click the checkmark to remove it 
and connect to the Internet. For help, contact your Internet service provider.

Error Messages

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

NOTICE: If the error message is not listed, see the documentation for the operating system or the 
program that was running when the message appeared. 

A F I L E N A M E  C A N N O T C O N T A I N  A N Y  O F  T H E  F O L L O W I N G C H A R A C T E R S :  \  /  :  *  ?  “  <  
>  | — Do not use these characters in filenames.

A R E Q U I R E D  .DLL F I L E  W A S N O T F O U N D — The program that you are trying to open 
is missing an essential file. To remove and then reinstall the program:

1 Click Start → Control Panel→ Programs→ Programs and Features.

In Windows XP, click Start→ Control Panel→ Add or Remove Programs.
2 Select the program you want to remove.
3 Click Uninstall (or Remove in Windows XP).
4 See the program documentation for installation instructions.

drive let ter  : \  I S  N O T  A C C E S S I B L E.  T H E  D E V I C E  I S  N O T  R E A D Y — The drive 
cannot read the disk. Insert a disk into the drive and try again.

IN S E R T  B O O T A B L E  M E D I A — Insert a bootable CD or DVD into the optional 
external D/Bay or the optional media base.

NO T  E N O U G H M E M O R Y  O R  R E S O U R C E S .  C L O S E  S O M E  P R O G R A M S  A N D T R Y  
A G A I N — Close all windows and open the program that you want to use. In some 
cases, you may have to restart your Tablet-PC to restore Tablet-PC resources. If so, run 
the program that you want to use first.

OP E R A T I N G S YS T E M  N O T  F O U N D — Contact Dell (see "Contacting Dell" on 
page 26).
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IEEE 1394 Device Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 NOTE: Your Tablet-PC supports only IEEE 1394a standard.

E N S U R E  T H A T  T H E  C A B L E  F O R T H E  IEEE 1394  D E V I C E  I S  P R O P E R L Y  I N S E R T E D I N T O 
T H E  D E V I C E  A N D I N T O  T H E  C O N N E C T O R O N T H E  TA B L E T-PC

E N S U R E  T H A T  T H E  IEEE 1394  D E V I C E  I S  E N A B L E D I N  S YS T E M  S E T U P — See 
"System Setup Screens" on page 142.

E N S U R E  T H A T  T H E  IEEE 1394  D E V I C E  I S  R E C O G N I Z E D  B Y  WI N D O W S —
1 Click Start → Control Panel→ Hardware and Sound.

In Windows XP, click Start→ My Computer→ View System Information→ 
Hardware.

2 Click Device Manager.

If your IEEE 1394 device is listed, Windows recognizes the device.

I F  Y O U  H A V E  P R O B L E M S W I T H  A  D E L L  IEEE 1394  D E V I C E — Contact Dell (see 
"Contacting Dell" on page 26).

I F  Y O U  H A V E  P R O B L E M S W I T H  A N IEEE 1394  D E V I C E  N O T  P R O V I D E D B Y D E L L —

Contact the IEEE 1394 device manufacturer.

Lockups and Software Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

The Tablet-PC does not start up

E N S U R E  T H A T  T H E  P O W E R  C A B L E  I S  F I R M L Y C O N N E C T E D T O  T H E  TA B L E T-PC A N D 
T O  T H E  E L E C T R I C A L  O U T L E T

The Tablet-PC stops responding

 NOTICE: You may lose data if you are unable to perform an operating system 
shutdown.

TU R N T H E  TA B L E T -PC O F F — If you are unable to get a response by pressing a key on 
your keyboard or touching your display with the pen or your finger, press and hold the 
power button for at least 8 to 10 seconds (until the Tablet-PC turns off), and then 
restart your Tablet-PC.
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A program stops responding

E N D T H E  P R O G R A M —
1 Press <Ctrl><Shift><Esc> simultaneously to access the Task Manager.
2 Click the Applications tab.
3 Click to select the program that is no longer responding.
4 Click End Task.

A program crashes repeatedly

 NOTE: Most software includes installation instructions in its documentation, or on 
a CD or DVD.

CH E C K T H E  S O F T W A R E  D O C U M E N T A T I O N — If necessary, uninstall and then reinstall 
the program.

A program is designed for an earlier Windows operating system

RU N T H E PR O G R A M  CO M P A T I B I L I T Y  WI Z A R D — The Program Compatibility 
Wizard configures a program so that it runs in an environment similar to previous 
versions of Windows. 

Windows Vista
1 Click Start → Control Panel→ Programs→ Use an older program with this 

version of Windows.
2 In the welcome screen, click Next.
3 Follow the instructions on the screen.

Windows XP 
1 Click Start→ Help and Support→ Fixing a problem→ Application and software 

problems.
2 Click Run Software that Worked with previous versions. 
3 In the welcome screen, click Next.
4 Follow the instructions on the screen.

A solid blue screen appears

TU R N T H E  TA B L E T-PC O F F — If you are unable to get a response by pressing a key on 
your keyboard or touching your display with the pen or your finger, press and hold the 
power button for at least 8 to 10 seconds (until the Tablet-PC turns off), and then 
restart your Tablet-PC. 
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Other software problems

C H E C K T H E S O F T W A R E  D O C U M E N T A T I O N  O R  C O N T A C T  T H E  S O F T W A R E  
M A N U F A C T U R E R  F O R T R O U B L E S H O O T I N G  I N F O R M A T I O N —

• Ensure that the program is compatible with the operating system installed on your 
Tablet-PC.

• Ensure that your Tablet-PC meets the minimum hardware requirements needed to 
run the software. See the software documentation for information.

• Ensure that the program is installed and configured properly.

• Verify that the device drivers do not conflict with the program.

• If necessary, uninstall and then reinstall the program.

B A C K U P  Y O U R  F I L E S  I M M E D I A T E L Y

U S E  A  V I R U S - S C A N N I N G P R O G R A M  T O C H E C K  T H E  H A R D D R I V E ,  CD S,  O R  DVDS

S A V E  A N D C L O S E  A N Y  O P E N F I L E S  O R  P R O G R A M S  A N D S H U T  D O W N Y O U R  
TA B L E T -PC T H R O U G H T H E ST A R T  M E N U

Memory Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

I F  Y O U  R E C E I V E  A N I N S U F F I C I E N T  M E M O R Y M E S S A G E —

• Save and close any open files and exit any open programs you are not using to see if 
that resolves the problem.

• See the software documentation for minimum memory requirements. If necessary, 
install additional memory (see "Installing a Memory Module" on page 169).

• Reseat the memory modules (see "Memory" on page 168) to ensure that your 
Tablet-PC is successfully communicating with the memory.

• Run the Dell Diagnostics (see "Dell Diagnostics" on page 121).

I F  Y O U  E X P E R I E N C E  O T H E R M E M O R Y  P R O B L E M S —

• Reseat the memory modules (see "Memory" on page 168) to ensure that your 
Tablet-PC is successfully communicating with the memory.

• Ensure that you are following the memory installation guidelines (see "Installing a 
Memory Module" on page 169).

• Ensure that the memory you are using is supported by your Tablet-PC. For more 
information about the type of memory supported by your Tablet-PC, see "Memory" on 
page 168.
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• Run the Dell Diagnostics (see "Dell Diagnostics" on page 121).

Network Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

CH E C K T H E  N E T W O R K  C A B L E  C O N N E C T O R — Ensure that the network cable is firmly 
inserted into the network connector on the back of the Tablet-PC and the network 
jack.

CH E C K T H E  N E T W O R K  L I G H T S O N T H E  B A C K O F  T H E  TA B L E T -PC — If the link 
integrity light is off, no network communication is occurring. Replace the network 
cable.

RE S T A R T  T H E  TA B L E T-PC A N D L O G O N T O T H E  N E T W O R K A G A I N

CH E C K Y O U R N E T W O R K S E T T I N G S — Contact your network administrator or the 
person who set up your network to verify that your network settings are correct and 
that the network is functioning.

RU N T H E HA R D W A R E  TR O U B L E S H O O T E R — See "Windows Hardware 
Troubleshooter" on page 126.

Power Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

IF  T H E  P O W E R  L I G H T  I S  B L I N K I N G B L U E — The computer is in sleep or standby 
mode. Press a key on the keyboard, move the mouse, or press the power button to 
resume normal operation.

I F  T H E  P O W E R  L I G H T  I S  O F F — The computer is either turned off or is not receiving 
power.

• Reseat the power cable in the power connector on the back of the computer and the 
electrical outlet.

• Bypass power strips, power extension cables, and other power protection devices to 
verify that the computer turns on properly.

• Ensure that any power strips being used are plugged into an electrical outlet and are 
turned on.

• Ensure that the electrical outlet is working by testing it with another device, such as a 
lamp.

I F  T H E  P O W E R  L I G H T  I S  S T E A D Y A M B E R — A device may be malfunctioning or 
incorrectly installed. Remove and then reinstall all memory modules (see "Memory" on 
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page 168).

E L I M I N A T E  I N T E R F E R E N C E — Some possible causes of interference are:

• Power, keyboard, and mouse extension cables

• Too many devices connected to the same power strip

• Multiple power strips connected to the same electrical outlet

Printer Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 NOTE: If you need technical assistance for your printer, contact the printer’s 
manufacturer.

C H E C K T H E P R I N T E R  D O C U M E N T A T I O N — See the printer documentation for setup 
and troubleshooting information.

E N S U R E  T H A T  T H E  P R I N T E R  I S  T U R N E D O N

C H E C K T H E P R I N T E R  C A B L E  C O N N E C T I O N S —

• See the printer documentation for cable connection information.

• Ensure that the printer cables are securely connected to the printer and the 
Tablet-PC.

TE S T  T H E  E L E C T R I C A L  O U T L E T — Ensure that the electrical outlet is working by 
testing it with another device, such as a lamp.

VE R I F Y  T H A T T H E  P R I N T E R  I S  R E C O G N I Z E D B Y WI N D O W S —
1 Click Start → Control Panel→ Hardware and Sound→ Printer.

In Windows XP, click Start→ Control Panel→ Printers and Other Hardware→ 
Printers and Faxes.

2 If the printer is listed, right-click the printer icon.
3 Click Properties and click Ports.
4 Adjust the settings, as needed.

R E I N S T A L L  T H E  P R I N T E R  D R I V E R — See the printer documentation for information 
on reinstalling the printer driver.

Scanner Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.
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 NOTE: If you need technical assistance for your scanner, contact the scanner’s 
manufacturer.

CH E C K T H E  S C A N N E R  D O C U M E N T A T I O N — See the scanner documentation for setup 
and troubleshooting information.

UN L O C K  T H E  S C A N N E R — Ensure that your scanner is unlocked (if the scanner has a 
locking tab or button).

RE S T A R T  T H E  TA B L E T-PC A N D T R Y  T H E  S C A N N E R  A G A I N

CH E C K T H E  C A B L E  C O N N E C T I O N S —

• See the scanner documentation for information on cable connections.

• Ensure that the scanner cables are securely connected to the scanner and the 
Tablet-PC.

VE R I F Y  T H A T  T H E  S C A N N E R  I S  R E C O G N I Z E D B Y  M I C R O S O F T  WI N D O W S —
1 Click Start → Control Panel→ Hardware and Sound→ Scanners and Cameras.

In Windows XP, click Start→ Control Panel→ Printers and Other Hardware→ 
Scanners and Cameras.

2 If the scanner is listed, Windows recognizes the scanner.

RE I N S T A L L  T H E  S C A N N E R  D R I V E R — See the scanner documentation for 
instructions.

Sound and Speaker Problems

 NOTE: The volume control in MP3 and other media players may override the 
Windows volume setting. Always check to ensure that the volume on the media 
player(s) has not been turned down or off.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

No sound from integrated speakers

AD J U S T  T H E WI N D O W S  V O L U M E C O N T R O L — Click or double-click the speaker icon 
in the lower-right corner of your screen. Ensure that the volume is turned up and that 
the sound is not muted.

RE I N S T A L L  T H E  S O U N D D R I V E R — See "Using the Drivers and Utilities Media" on 
page 147.

No sound from external speakers

E N S U R E  T H A T T H E  S U B W O O F E R  A N D T H E  S P E A K E R S A R E  T U R N E D O N — See the 
setup diagram supplied with the speakers. If your speakers have volume controls, 
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adjust the volume, bass, or treble to eliminate distortion.

A D J U S T  T H E  W I N D O W S V O L U M E  C O N T R O L — Click or double-click the speaker icon 
in the lower-right corner of your screen. Ensure that the volume is turned up and that 
the sound is not muted.

D I S C O N N E C T  H E A D P H O N E S F R O M  T H E  H E A D P H O N E  C O N N E C T O R — Sound from the 
speaker is automatically disabled when headphones are connected to the Tablet-PC 
headphone connector.

TE S T  T H E  E L E C T R I C A L  O U T L E T — Ensure that the electrical outlet is working by 
testing it with another device, such as a lamp.

E L I M I N A T E  P O S S I B L E  I N T E R F E R E N C E — Turn off nearby fans, fluorescent lights, or 
halogen lamps to check for interference.

R U N T H E  S P E A K E R  D I A G N O S T I C S

R E I N S T A L L  T H E  A U D I O  D R I V E R — See "Reinstalling Drivers and Utilities" on 
page 146.

R U N T H E  H A R D W A R E  TR O U B L E S H O O T E R — See "Windows Hardware 
Troubleshooter" on page 126.

No sound from headphones

C H E C K T H E H E A D P H O N E C A B L E  C O N N E C T I O N — Ensure that the headphone cable is 
securely inserted into the headphone connector (see "Right Side View" on page 34).

A D J U S T  T H E  W I N D O W S V O L U M E  C O N T R O L — Click or double-click the speaker icon 
in the lower-right corner of your screen. Ensure that the volume is turned up and that 
the sound is not muted.

Touch Pad or Mouse Problems
C H E C K T H E T O U C H P A D S E T T I N G S —

1 Click Start  (or Start in Windows XP)→ Control Panel→ Printers and Other 
Hardware→ Mouse.

2 Try adjusting the settings.

C H E C K T H E M O U S E  C A B L E — Shut down the Tablet-PC. Disconnect the mouse 
cable, check it for damage, and firmly reconnect the cable.

If you are using a mouse extension cable, disconnect it and connect the 
mouse directly to the Tablet-PC.
TO  V E R I F Y  T H A T  T H E  P R O B L E M I S  W I T H T H E  M O U S E ,  C H E C K T H E T O U C H P A D —

1 Shut down the Tablet-PC.
2 Disconnect the mouse.
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3 Turn on the Tablet-PC. 
4 At the Windows desktop, use the touch pad to move the cursor around, select an icon, 

and open it.

If the touch pad operates correctly, the mouse may be defective.

CH E C K T H E  S YS T E M S E T U P  P R O G R A M S E T T I N G S — Verify that the system setup 
program lists the correct device for the pointing device option. (The Tablet-PC 
automatically recognizes a USB mouse without making any setting adjustments.) For 
more information on using the system setup program, see "Using the System Setup 
Program" on page 141.

TE S T  T H E  M O U S E  C O N T R O L L E R — To test the mouse controller (which affects 
pointer movement) and the operation of the touch pad or mouse buttons, run the 
Mouse test in the Pointing Devices test group in the Dell Diagnostics (see "Dell 
Diagnostics" on page 121).

RE I N S T A L L  T H E  T O U C H P A D D R I V E R — See "Reinstalling Drivers and Utilities" on 
page 146.

Troubleshooting Stylus and Touch Problems
If you encounter a problem while using the pen or when touching the screen, 
the Tablet Settings window (i.e., Properties) and certain Windows 
Control Panel screens are useful to resolve the problem. 

Diagnostics

IN I T I A L I Z E  D I G I T I Z E R — In the system Control Panel, open the N-trig Tablet 
Settings icon and click the Restore defaults button to set the Tablet-PC pen 
and touch features to the factory default configuration. 

E X E C U T E  D I G I T I Z E R  S E L F- T E S T  D I A G N O S T I C S — In the system Control Panel, open 
the N-trig Tablet Settings icon and click the Trouble Shooting button to 
execute a diagnostic self test. This test verifies that the digitizer hardware is fully 
functional. During the test, the pop-up window provides instruction to the user and 
reports the test result. If the test result produces a diagnostic code, contact Dell (see 
"Contacting Dell" on page 26). 

E I T H E R  TO U C H O R  P E N M O D E  N O T  F U N C T I O N I N G — on the system Control Panel, 
open the N-trig Tablet Settings icon. Select the preferred mode of operation to enable 
Touch, Pen, Dual, or Auto (Windows Vista only). 

Touch Not Functioning 

VE R I F Y  T O U C H  I N P U T  I S  E N A B L E D — In the system Control Panel open the Pen 
and Input Devices icon. On the Touch screen, ensure that the option Use your 
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finger as an input device is checked. Select other settings on this screen 
as desired to configure how the Touch feature will perform. 

TO U C H  T U N I N G — In the system Control Panel, open the N-trig Tablet Settings icon 
and click the Digitizer Options tab. In the Touch Tuning frame, click 
the Reset button and follow the instructions provided. 

Pen Pressure Sensitivity Problems

E N A B L E  S T Y L U S P R E S S U R E  S E N S I T I V I T Y — In Windows Journal select the Tools 
drop-down menu and then select Options. In the Options window, click the 
Note Format tab, and then select the Pen Settings... button. In the 
Pen and Highlighter Settings window, ensure that the option Pressure 
sensitive is checked. 

Pen Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

The pen stops working

C H E C K T I P  I N S T A L L A T I O N —

• Replace the pen tip. See "Replacing the Pen Tip" on page 66.

• If this does not solve the problem, contact Dell. See "Contacting Dell" on page 26.

Display Problems

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

The screen is difficult to read

R O T A T E  T H E  D I S P L A Y T O  E L I M I N A T E  S U N L I G H T G L A R E  A N D  P O S S I B L E  
I N T E R F E R E N C E

A D J U S T  T H E  W I N D O W S D I S P L A Y  S E T T I N G S —
1 Click Start → Control Panel→ Hardware and Sound→ Personalization→ 

Display Settings.

In Windows XP, click Start→ Control Panel→ Appearance and Themes→ Display.
2 Adjust Resolution and Colors settings, as needed.
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If only part of the display is readable

CO N N E C T  A N E X T E R N A L  M O N I T O R —
1 Shut down your Tablet-PC and connect an external monitor to the Tablet-PC.
2 Turn on the Tablet-PC and the monitor and adjust the monitor brightness and 

contrast controls.

If the external monitor works, the Tablet-PC display or video controller may be 
defective. Contact Dell (see "Contacting Dell" on page 26).

When using a projector, the projected image is rotated and unreadable

RO T A T E  T H E D I S P L A Y  I M A G E  T O  A  R E A D A B L E  O R I E N T A T I O N U S I N G T H E  S C R E E N 
R O T A T E  B U T T O N — See "Using Tablet Buttons" on page 62 for more 
information on the Screen Rotate button. See "Using Your Tablet-PC With a 
Projector" on page 95 for more information on using the Tablet-PC with a 
projector. 

Power Lights
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

The power button LED ring, located on the Tablet-PC, display illuminates and blinks 
or remains solid to indicate different states:

• If the power light is blinking blue, the computer is in sleep or standby 
mode. Press a key on the keyboard, move the mouse, or press the power 
button to resume normal operation.

• If the power light is off, the computer is either turned off or is not 
receiving power.

– Reseat the power cable into both the power connector on the back of 
the computer and the electrical outlet.

– If the computer is plugged into a power strip, ensure that the power 
strip is plugged into an electrical outlet and that the power strip is 
turned on.

– Bypass power protection devices, power strips, and power extension 
cables to verify that the computer turns on properly.

– Ensure that the electrical outlet is working by testing it with another 
device, such as a lamp.
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• If the power light is blinking blue, the computer is receiving electrical 
power, but an internal power problem might exist.

• If the power light is steady amber, a device may be malfunctioning or 
incorrectly installed.

– Remove and then reinstall the memory modules (see "Memory" on 
page 168).

• Eliminate interference. Some possible causes of interference are:

– Power, keyboard, and mouse extension cables

– Too many devices on a power strip

– Multiple power strips connected to the same electrical outlet
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9
Using the System Setup Program

Overview
 NOTE: Your operating system may automatically configure most of the options 

available in the system setup program, thus overriding options that you set through 
the system setup program. (An exception is the External Hot Key option, which you 
can disable or enable only through the system setup program.) For more information 
on configuring features for your operating system, click Start  (or Start in 
Windows® XP) → Help and Support.

You can use the system setup program as follows:

• To set or change user-selectable features—for example, your Tablet-PC 
password

• To verify information about the Tablet-PC's current configuration, for 
example, the amount of system memory

After you set up the Tablet-PC, run the system setup program to familiarize 
yourself with your system configuration information and optional settings. 
You may want to write down the information for future reference.

The system setup screens display the current setup information and settings 
for your Tablet-PC, such as:

• System configuration

• Boot order

• Boot (start-up) configuration and docking-device configuration settings

• Basic device-configuration settings

• System security and hard-drive password settings

 NOTE: Unless you are an expert computer user or are directed to do so by Dell 
technical support, do not change the system setup settings. Certain changes might 
make your Tablet-PC work incorrectly. 
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System Setup Screens

Viewing the System Setup Screens
1 Turn on (or restart) your Tablet-PC.

2 When the DELL™ logo appears, press <F2> immediately. If you wait too 
long and the Microsoft® Windows® logo appears, continue to wait until 
you see the Windows desktop. Then shut down your Tablet-PC and try 
again.

 NOTE: For information about a specific item on a system setup screen, highlight the 
item and see the Help area on the screen.

On each screen, the system setup options are listed at the left. To the right of 
each option is the setting or value for that option. You can change settings 
that appear as white type on the screen. Options or values that you cannot 
change (because they are determined by the Tablet-PC) appear less bright.

The upper-right corner of the screen displays help information for the 
currently highlighted option; the lower-right corner displays information 
about the Tablet-PC. System-setup key functions are listed across the bottom 
of the screen.

Commonly Used Options
Certain options require that you reboot the Tablet-PC for new settings to take 
effect.

 NOTE: The information in this document may vary from the selections displayed on 
the system setup screens. Review the selections and instructions provided on the 
system setup screens for specific directions. 

Changing the Boot Sequence
The boot sequence, or boot order, tells the Tablet-PC where to look to find the 
software needed to start the operating system. You can control the boot 
sequence and enable or disable devices using the Boot Order page of the 
system setup program.

 NOTE: To change the boot sequence on a one-time-only basis, see "Performing a 
One-Time Boot" on page 143.
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The Boot Order page displays a general list of the bootable devices that may 
be installed in your Tablet-PC, including but not limited to the following:

• Modular Bay HDD

• Internal HDD

• Optical Drive

During the boot routine, the Tablet-PC starts at the top of the list and scans 
each enabled device for the operating system start-up files. When the 
Tablet-PC finds the files, it stops searching and starts the operating system. 

To control the boot devices, select (highlight) a device by pressing the down-
arrow or up-arrow key, and then enable or disable the device or change its 
order in the list.

• To enable or disable a device, highlight the item and press the space bar. 
Enabled items appear as white and display a small triangle to the left; 
disabled items appear blue or dimmed without a triangle.

• To reorder a device in the list, highlight the device and then press <u> or 
<d> (not case-sensitive) to move the highlighted device up or down.

Boot sequence changes take effect as soon as you save the changes and exit 
the system setup program.

Performing a One-Time Boot

You can set a one-time-only boot sequence without entering the system setup 
program. (You can also use this procedure to boot the Dell Diagnostics on the 
diagnostics utility partition on your hard drive.)

1 Shut down the Tablet-PC through the Start (  in Windows Vista®) 
menu.

2 If the Tablet-PC is connected to a docking device (docked), undock it. See 
the documentation that came with your docking device for instructions.

3 Connect the Tablet-PC to an electrical outlet.

4 Turn on the Tablet-PC. When the DELL logo appears, press <F12> 
immediately. 

If you wait too long and the Windows logo appears, continue to wait until 
you see the Windows desktop. Then shut down your Tablet-PC and try 
again.
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5 When the boot device list appears, highlight the device from which you 
want to boot and press <Enter>.

The Tablet-PC boots to the selected device.

The next time you reboot the Tablet-PC, the previous boot order is restored.
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10
Reinstalling Software

Drivers

What Is a Driver?
A driver is a program that controls a device such as a printer, mouse, or 
keyboard. All devices require a driver program.

A driver acts like a translator between the device and any other programs that 
use the device. Each device has its own set of specialized commands that only 
its driver recognizes.

Dell ships your Tablet-PC to you with required drivers already installed—no 
further installation or configuration is needed.

 NOTICE: The Drivers and Utilities media may contain drivers for operating systems 
that are not on your Tablet-PC. Ensure that you are installing software appropriate 
for your operating system.

Many drivers, such as the keyboard driver, come with your Microsoft® 
Windows® operating system. You may need to install drivers if you:

• Upgrade your operating system

• Reinstall your operating system

• Connect or install a new device

Identifying Drivers
If you experience a problem with any device, identify whether the driver is the 
source of your problem and, if necessary, update the driver.

1 Click Start , and right-click Computer. 

In Windows XP, click Start and right-click My Computer. 

2 Click Properties→ Device Manager.
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In Windows XP, click Properties→ Hardware→ Device Manager.

 NOTE: In Windows Vista®, the User Account Control window may appear. If 
you are an administrator on the Tablet-PC, click Continue; otherwise, contact 
your administrator to continue.

Scroll down the list to see if any device has an exclamation point (a yellow 
circle with a [!]) on the device icon.

If an exclamation point is next to the device name, you may need to reinstall 
the driver or install a new driver (see "Reinstalling Drivers and Utilities" on 
page 146).

Reinstalling Drivers and Utilities

 NOTICE: The Dell Support website at support.dell.com and your Drivers and 
Utilities media provide approved drivers for Dell™ computers. If you install drivers 
obtained from other sources, your Tablet-PC might not work correctly.

Using Windows Device Driver Rollback

If a problem occurs on your Tablet-PC after you install or update a driver, use 
Windows Device Driver Rollback to replace the driver with the previously 
installed version.

1 Click Start , and right-click Computer. 

In Windows XP, click Start and right-click My Computer. 

2 Click Properties→ Device Manager.

In Windows XP, click Properties→ Hardware→ Device Manager.

 NOTE: In Windows Vista, the User Account Control window may appear. If 
you are an administrator on the Tablet-PC, click Continue; otherwise, contact 
your administrator to enter the Device Manager.

3 Right-click the device for which the new driver was installed and click 
Properties.

4 Click the Driver tab→ Roll Back Driver.

If Device Driver Rollback does not resolve the problem, then use System 
Restore (see "Restoring Your Operating System" on page 148) to return your 
Tablet-PC to the operating state that existed before you installed the new 
driver.
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Using the Drivers and Utilities Media

If using Device Driver Rollback or System Restore (see "Restoring Your 
Operating System" on page 148) does not resolve the problem, then reinstall 
the driver from the Drivers and Utilities media.

1 Save and close any open files, and exit any open programs. 

2 Insert the Drivers and Utilities media.

In most cases, the CD/DVD starts running automatically. If it does not, 
start Windows Explorer, click your CD/DVD drive directory to display the 
CD/DVD contents, and then double-click the autorcd.exe file. The first 
time that you run the CD/DVD, it might prompt you to install setup files. 
Click OK, and follow the instructions on the screen to continue.

3 From the Language drop-down menu in the toolbar, select your preferred 
language for the driver or utility (if available).

4 At the welcome screen, click Next and wait for the CD/DVD to complete 
the hardware scan.

5 To detect other drivers and utilities, under Search Criteria, select the 
appropriate categories from the System Model, Operating System, and 
Topic drop-down menus.

A link or links appear(s) for the specific drivers and utilities used by your 
Tablet-PC.

6 Click the link of a specific driver or utility to display information about the 
driver or utility that you want to install.

7 Click the Install button (if present) to begin installing the driver or utility. 
At the welcome screen, follow the screen prompts to complete the 
installation.

If no Install button is present, automatic installation is not an option. For 
installation instructions, either see the appropriate instructions in the 
following subsections, or click Extract, follow the extracting instructions, 
and then read the readme file.

If instructed to navigate to the driver files, click the CD/DVD directory on 
the driver information window to display the files associated with that 
driver.
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Manually Reinstalling Drivers 

After extracting the driver files to your hard drive as described in the previous 
section, do the following:

1 Click Start , and right-click Computer. 

In Windows XP, click Start and right-click My Computer. 

2 Click Properties→ Device Manager.

In Windows XP, click Properties→ Hardware→ Device Manager.

 NOTE: In Windows Vista, the User Account Control window may appear. If 
you are an administrator on the Tablet-PC, click Continue; otherwise, contact 
your administrator to enter the Device Manager.

3 Double-click the type of device for which you are installing the driver (for 
example, Audio or Video).

4 Double-click the name of the device for which you are installing the driver.

5 Click Driver→ Update Driver→ Browse my computer for driver software.

 NOTE: In Windows XP, the Hardware Update Wizard may display. In this case, 
follow the wizard instructions instead of completing the remainder of this 
procedure. 

6 Click Browse and browse to the location to which you previously copied 
the driver files.

7 When the name of the appropriate driver appears, click the name of the 
driver→ OK→ Next.

8 Click Finish and restart your Tablet-PC.

Restoring Your Operating System
You can restore your operating system in the following ways:

• System Restore returns your Tablet-PC to an earlier operating state 
without affecting data files. Use System Restore as the first solution for 
restoring your operating system and preserving data files.

• Dell Factory Image Restore returns your hard drive to the operating state it 
was in when you purchased the Tablet-PC. All data on the hard drive and 
any programs installed after you received the Tablet-PC are permanently 
deleted. Use Dell Factory Image Restore only if System Restore did not 
resolve your operating system problem.
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• If you received an Operating System disc with your Tablet-PC, you can use 
it to restore your operating system. However, using the Operating System 
disc also deletes all data on the hard drive. Use the disc only if System 
Restore did not resolve your operating system problem.

Using Microsoft Windows System Restore
The Windows operating systems provide a System Restore option which 
allows you to return your Tablet-PC to an earlier operating state (without 
affecting data files) if changes to the hardware, software, or other system 
settings have left the Tablet-PC in an undesirable operating state. Any 
changes that System Restore makes to your Tablet-PC are completely 
reversible.

 NOTICE: Make regular backups of your data files. System Restore does not 
monitor your data files or recover them.

 NOTE: The procedures in this document were written for the Windows default 
view, so they may not apply if you set your Dell™ Tablet-PC to the Windows Classic 
view.

Starting System Restore

Use System Restore to return the system to a previous state. In the event that 
System Restore does not resolve the issue, you may undo the last system 
restore.

Windows Vista

1 Click Start .

2 In the Search box, type System Restore and press <Enter>.

 NOTE: The User Account Control window may appear. If you are an 
administrator on the Tablet-PC, click Continue; otherwise, contact your 
administrator to continue the desired action.

3 Click Next and follow the remaining prompts on the screen.

Windows XP 

1 Click Start→ Help and Support

2 In the Search box, type System Restore and press <Enter>.

3 Select Run the System Restore Wizard as displayed in the search results. 
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4 Click Next and follow the remaining prompts on the screen.

Undoing the Last System Restore

 NOTICE: Before you undo the last system restore, save and close all open files and 
exit any open programs. Do not alter, open, or delete any files or programs until the 
system restoration is complete.

Windows Vista

1 Click Start .

2 In the Start Search box, type System Restore and press <Enter>.

3 Click Undo my last restoration and click Next.

Windows XP 

1 Click Start→ Help and Support

2 In the Search box, type System Restore and press <Enter>.

3 Select Run the System Restore Wizard as displayed in the search results. 

4 Select Undo the last restoration. 

5 Click Next and follow the remaining prompts on the screen.

Using Dell Factory Image Restore

 NOTICE: Using Dell Factory Image Restore permanently deletes all data on the 
hard drive and removes any programs or drivers installed after you received your 
Tablet-PC. If possible, back up the data before using this option. Use Dell Factory 
Image Restore only if System Restore did not resolve your operating system 
problem.

 NOTE: Dell Factory Image Restore may not be available in certain countries or on 
certain computers.

Use Dell Factory Image Restore only as the last method to restore your 
operating system. These options restore your hard drive to the operating state 
it was in when you purchased the Tablet-PC. Any programs or files added 
since you received your Tablet-PC—including data files—are permanently 
deleted from the hard drive. Data files include documents, spreadsheets, e-
mail messages, digital photos, music files, and so on. If possible, back up all 
data before using Dell Factory Image Restore.
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1 Turn on the Tablet-PC. When the Dell logo appears, press <F8> several 
times to access the Vista Advanced Boot Options Window.

2 Select Repair Your Computer.

The System Recovery Options window appears.

3 Select a keyboard layout and click Next.

4 To access the recovery options, log on as a local user. To access the 
command prompt, type administrator in the User name field, then 
click OK.

5 Click Dell Factory Image Restore.

 NOTE: Depending upon your configuration, you may need to select Dell 
Factory Tools, then Dell Factory Image Restore.

The Dell Factory Image Restore welcome screen appears.

6 Click Next.

The Confirm Data Deletion screen appears. 

 NOTICE: If you do not want to proceed with Dell Factory Image Restore, click 
Cancel.

7 Click the checkbox to confirm that you want to continue reformatting the 
hard drive and restoring the system software to the factory condition, then 
click Next.

The restore process begins and may take five or more minutes to complete. 
A message appears when the operating system and factory-installed 
applications have been restored to factory condition. 

8 Click Finish to reboot the system.

Using the Operating System Media

Before you Begin

If you are considering reinstalling the Windows operating system to correct a 
problem with a newly installed driver, first try using Windows Device Driver 
Rollback. See "Using Windows Device Driver Rollback" on page 146. If 
Device Driver Rollback does not resolve the problem, then use System 
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Restore to return your operating system to the operating state it was in before 
you installed the new device driver. See "Using Microsoft Windows System 
Restore" on page 149.

 NOTICE: Before performing the installation, back up all data files on your primary 
hard drive. For conventional hard drive configurations, the primary hard drive is the 
first drive detected by the Tablet-PC.

To reinstall Windows, you need the following items:

• Dell™ Operating System media

• Dell Drivers and Utilities media 

 NOTE: The Dell Drivers and Utilities media contains drivers that were installed 
during the assembly of the Tablet-PC. Use the Dell Drivers and Utilities media to 
load any required drivers. Depending on the region from which you ordered your 
Tablet-PC, or whether you requested the media, the Dell Drivers and Utilities media 
and Operating System media may not ship with your Tablet-PC.

Reinstalling the Operating System 

The reinstallation process can take 1 to 2 hours to complete. After you 
reinstall the operating system, you must also reinstall the device drivers, virus 
protection program, and other software.

1 Save and close any open files and exit any open programs. 

2 Insert the Operating System media. 

 NOTE: When reinstalling Windows XP, insert the operating system media into an 
externally powered USB optical drive. 

3 Click Exit if the Install Windows message appears.

4 Restart the Tablet-PC.

When the DELL logo appears, press <F12> immediately.

 NOTE: If you wait too long and the operating system logo appears, continue to wait 
until you see the Microsoft® Windows® desktop; then, shut down your Tablet-PC 
and try again.

 NOTE: The next steps change the boot sequence for one time only. On the next 
start-up, the Tablet-PC boots according to the devices specified in the system setup 
program.

5 When the boot device list appears, highlight CD/DVD/CD-RW Drive 
and press <Enter>.
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6 Press any key to Boot from CD-ROM.

7 Follow the instructions on the screen to complete the installation.
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11
Adding and Replacing Parts

Before You Begin
This chapter provides procedures for removing and installing the components 
in your Tablet-PC. Unless otherwise noted, each procedure assumes the 
following:

• You have performed the steps in "Turning Off Your Tablet-PC" on page 155 
and "Before Working Inside Your Tablet-PC" on page 156.

• You have read the safety information in the Dell™ Product Information 
Guide.

Recommended Tools
The procedures in this document may require the following tools:

• Small flat-blade screwdriver

• #0 Phillips screwdriver

• #1 Phillips screwdriver

• Small plastic scribe

• Flash BIOS update program CD

Turning Off Your Tablet-PC

 NOTICE: To avoid losing data, save and close all open files and exit all open 
programs before you turn off your Tablet-PC.

1 Shut down the operating system:

• In Windows Vista:

Click Start , then click the arrow in the lower-right corner of the 
Start menu as shown below, and then click Shut Down.
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• In Windows XP: 

Click Start→ Turn Off Computer→ Turn Off. 

The Tablet-PC turns off after the operating system shutdown process 
is complete.

2 Ensure that the Tablet-PC and all attached devices are turned off. If your 
Tablet-PC and attached devices did not automatically turn off when you 
shut down your operating system, press and hold the power button for 
about 4 seconds to turn them off.

Before Working Inside Your Tablet-PC
Use the following safety guidelines to help protect your Tablet-PC from 
potential damage and to help to ensure your own personal safety.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions in the Product Information Guide.

 NOTICE: Handle components and cards with care. Do not touch the components 
or contacts on a card. Hold a card by its edges or by its metal mounting bracket. 
Hold a component such as a processor by its edges, not by its pins.

 NOTICE: Only a certified service technician should perform repairs on your 
Tablet-PC. Damage due to servicing that is not authorized by Dell is not covered by 
your warranty.

 NOTICE: When you disconnect a cable, pull on its connector or on its pull-tab, not 
on the cable itself. Some cables have connectors with locking tabs; if you are 
disconnecting this type of cable, press in on the locking tabs before you disconnect 
the cable. As you pull connectors apart, keep them evenly aligned to avoid bending 
any connector pins. Also, before you connect a cable, ensure that both connectors 
are correctly oriented and aligned. 

 NOTICE: To avoid damaging the Tablet-PC, perform the following steps before you 
begin working inside the Tablet-PC. 

1 Ensure that the work surface is flat and clean to prevent the Tablet-PC 
cover from being scratched.

2 Turn off your Tablet-PC (see "Turning Off Your Tablet-PC" on page 155).
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3 If the Tablet-PC is connected to a docking device (docked), undock it. See 
"Undocking Your Tablet-PC From the Media Base" on page 212, or 
"Undocking Your Tablet-PC From the Battery Slice" on page 220.

 NOTICE: To disconnect a network cable, first unplug the cable from your Tablet-PC 
and then unplug the cable from the network device.

4 Disconnect all network cables from the Tablet-PC.

5 Disconnect your Tablet-PC and all attached devices from their electrical 
outlets.

6 Close the display and turn the Tablet-PC upside-down on a flat work 
surface.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you service the Tablet-PC. 

7 Remove the main battery (see "Removing the Main Battery" on page 158).

8 Turn the Tablet-PC top-side up. 

9 Open the display. 

10 Press the power button to ground the system board.

 CAUTION: To guard against electrical shock, always unplug your Tablet-PC from 
the electrical outlet before opening the display.

 NOTICE: Before touching anything inside your Tablet-PC, ground yourself by 
touching an unpainted metal surface, such as the metal at the back of the 
Tablet-PC. While you work, periodically touch an unpainted metal surface to 
dissipate static electricity, which could harm internal components.

11 Remove any installed ExpressCards or Smart Cards from the appropriate 
slots (see "Removing an ExpressCard" on page 91).

12 Remove the hard drive (see "Removing the Hard Drive" on page 160).

Main Battery
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

 NOTICE: Only a certified service technician should perform repairs on your 
Tablet-PC. Damage due to servicing that is not authorized by Dell is not covered by 
your warranty.
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 NOTE: Your Tablet-PC’s Service Tag and Microsoft®Windows® License labels are 
located under the main battery in the battery bay of your Tablet-PC

Removing the Main Battery
1 Follow the procedures in "Before You Begin" on page 155.

2 Turn off your Tablet-PC (see "Turning Off Your Tablet-PC" on page 155).

3 If the Tablet-PC is connected to a docking device such as the optional 
Media Base or Battery Slice (docked), undock it. See "Undocking Your 
Tablet-PC From the Media Base" on page 212, or "Undocking Your 
Tablet-PC From the Battery Slice" on page 220.

 NOTICE: To disconnect a network cable, first unplug the cable from your Tablet-PC 
and then unplug the cable from the network device.

4 Disconnect all network cables from the Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you service the Tablet-PC. 

5 Close the display and turn the Tablet-PC upside-down on a flat work 
surface.

6 Slide the two battery-bay latch releases on the bottom of the Tablet-PC 
outward to each side.

7 Slide the main battery from the battery bay.
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Installing the Main Battery
1 Align the main battery with the sides of the battery bay.

2 Slide the main battery into the battery bay until you feel a click, ensuring 
that the battery is firmly and properly seated.

3 Turn the Tablet-PC top-side up on a flat work surface and open the display.

4 Connect any network cables.

5 Turn on your Tablet-PC by pressing the power button.

Hard Drive
 CAUTION: If you remove the hard drive from the Tablet-PC when the drive is hot, 

do not touch the metal housing of the hard drive.

 CAUTION: Before working inside your Tablet-PC, follow the safety instructions 
located in the Product Information Guide.

1 battery release latches (2) 2 battery

3 battery bay

1 2 3
Adding and Replacing Parts 159



1

book.book  Page 160  Tuesday, May 13, 2008  5:03 PM
 NOTICE: To prevent data loss, turn off your Tablet-PC (see "Turning Off Your 
Tablet-PC" on page 155) before removing the hard drive. Do not remove the hard 
drive while the Tablet-PC is on, in sleep, standby, or hibernate mode. 

 NOTICE: Hard drives are extremely fragile; even a slight bump can damage the 
drive.

 NOTE: Dell does not guarantee compatibility or provide support for hard drives 
from sources other than Dell.

Removing the Hard Drive
1 Follow the procedures in "Before You Begin" on page 155.

2 Turn the Tablet-PC over, and loosen the two captive screws on the metal 
bracket that holds the hard drive.

 NOTICE: When the hard drive is not in the Tablet-PC, store it in protective antistatic 
packaging. See "Protecting Against Electrostatic Discharge" in the Product 
Information Guide. 

1

2

3 4
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3 Holding the metal bracket by the sides, slide the bracket toward the back 
of the Tablet-PC to dislodge the bracket from the two metal clips and set 
the bracket aside.

4 Use the pull-tab to disconnect the hard drive cable from the system board 
connector and remove the hard drive from the Tablet-PC.

Installing the Hard Drive
1 Follow the procedures in "Before You Begin" on page 155.

1 captive screws (2) 2 metal bracket

3 hard drive 4 securing tabs (2)

1 pull-tab 2 hard drive

3 alignment ribs

1

2

3

Adding and Replacing Parts 161



1

book.book  Page 162  Tuesday, May 13, 2008  5:03 PM
 NOTICE: When the hard drive is not in the Tablet-PC, store it in protective antistatic 
packaging. See "Protecting Against Electrostatic Discharge" in the Product 
Information Guide.

2 Remove the new drive from its packaging.

Save the original packaging for storing or shipping the hard drive.

 NOTICE: Use firm and even pressure to slide the drive into place. If you use 
excessive force, you may damage the connector.

3 Place the hard drive into the hard drive bay, seating it firmly between the 
hard drive alignment ribs in the base.

4 Connect the hard drive cable to the system board connector.

5 Insert the two metal tabs of the metal bracket under the metal clips in the 
hard drive bay, then lower the bracket down over the hard drive.

6 Tighten the two captive screws on the metal bracket.

7 Use the Operating System media to install the operating system for your 
Tablet-PC. (See "Using the Operating System Media" on page 151.)

8 Use the Drivers and Utilities media to install the drivers and utilities for 
your Tablet-PC. (See "Using the Drivers and Utilities Media" on page 147).

Subscriber Identity Module (SIM) Card
 NOTICE: To protect the SIM card from electrostatic discharge (ESD), do not touch 

the SIM card connector. Also, take care when removing the card to slide the card 
completely out of the metal tabs before lifting the card out of the slot. The card is 
brittle and may easily break. 

 NOTE: The SIM card is located in the battery bay. You must remove the main 
battery before you can access the SIM card.

Removing the SIM Card
1 Follow the procedures in "Before You Begin" on page 155.

2 Push in the SIM card, then release the card.

3 Pull the SIM card from the SIM card slot and place it to one side.
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 NOTE: When you replace the SIM card, ensure that you insert the SIM card into 
the SIM card slot with the cut-off corner of the card facing toward the front of the 
Tablet-PC.

Installing the SIM Card
1 Insert the SIM card into the slot with the cut-off corner of the card facing 

toward the front of the Tablet-PC.

2 Push the card until it is firmly seated in the connector.

 NOTE: If the card extends out into the battery bay, it is not fully installed. 

Internal Card With Bluetooth® Wireless 
Technology

 CAUTION: Before performing the following procedures, follow the safety 
instructions in your Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC. 

1 SIM card 2 battery bay

2

1
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If you ordered an internal card with Bluetooth wireless technology with your 
Tablet-PC, it is already installed.

Remove the Internal Card Caddy
If your Tablet-PC has Bluetooth wireless technology, the Bluetooth card is 
installed in the internal card caddy. 

 NOTICE: Before touching anything inside your Tablet-PC, ground yourself by 
touching an unpainted metal surface, such as the metal at the back of your 
computer. While you work, periodically touch an unpainted metal surface to 
dissipate static electricity, which could harm internal components.

1 Follow the procedures in "Before You Begin" on page 155.

2 Close the display and turn your Tablet-PC top-down on a flat work 
surface. Orient the unit so that the front is toward you. 

3 Find the internal card caddy. It is located near the front left corner (see the 
picture below). 

2

3

4

5

6

1
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 NOTICE: Be careful when removing the card to avoid damaging the card, card 
cable, or surrounding components.

4 Loosen the captive screw and, lifting the end with the captive screw first, 
gently remove the card caddy from your Tablet-PC. If a card is installed in 
the card caddy, ensure that excessive force is not applied to the connecting 
cable. 

5 If a card is installed in the card caddy, disconnect the cable from the card. 
Remove the card from the card caddy by gently lifting the plastic securing 
tab and sliding the card out of the caddy. 

6 If no card was installed in the card caddy, find the cable in the space 
opened by removing the card caddy and gently lift the connector end out 
so that it is accessible. 

Installing a Bluetooth Card

 NOTICE: Before touching anything inside your Tablet-PC, ground yourself by 
touching an unpainted metal surface, such as the metal at the back of your 
Tablet-PC. While you work, periodically touch an unpainted metal surface to 
dissipate static electricity, which could harm internal components.

1 Seat the Bluetooth card into the card caddy, sliding the corner with the 
hole under the plastic securing tab. The connector end of the card should 
be pointing away from the card caddy end with the captive screw. 

2 Connect the Bluetooth card cable to the card.

3 Fold the excess cable as shown in the picture below and hold it next to the 
card. 

1 captive screw 2 card caddy

3 cable connector 4 plastic alignment tab

5 plastic securing tab 6 Bluetooth card
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4 Insert the tabbed-end of the card caddy into the base, then lower the screw 
end into the base. See the picture below. 
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5 Tighten the captive screw.

Installing the Main Battery
1 Align the main battery with the sides of the battery bay. 

2 Slide the main battery into the battery bay until you feel a click, ensuring 
that the battery is firmly and properly seated. Verify that the battery release 
tabs are positioned toward the middle of the unit. 

3 Turn your Tablet-PC top-side up on a flat work surface and open the 
display.

4 Dock and/or reconnect cables to your Tablet-PC as needed. 

5 Power on your Tablet-PC by pressing the power button. Verify that the 
operating system starts normally. 

Memory and Mini-Card Cover
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions located in the Product Information Guide.
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 NOTICE: To prevent damage to the system board, remove the main battery before 
you service the Tablet-PC. 

Removing the Memory and Mini-Card Cover
1 Follow the procedures in "Before You Begin" on page 155.

2 Turn the Tablet-PC upside-down, loosen the two captive screws on the 
memory and Mini-Card cover, and remove the cover.

Installing the Memory and Mini-Card Cover
1 Follow the procedures in "Before You Begin" on page 155.

2 Turn the Tablet-PC upside-down, fit the cover into place, and tighten the 
two captive screws on the memory and Mini-Card cover.

Memory
You can increase your Tablet-PC memory by installing memory modules on 
the system board. See "Specifications" on page 42 for information on the 
memory supported by your Tablet-PC. Install only memory modules that are 
intended for your Tablet-PC.
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 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions located in the Product Information Guide.

 NOTICE: To prevent damage to the system board, remove the main battery before 
you service the Tablet-PC. 

Removing a Memory Module
1 Follow the procedures in "Before You Begin" on page 155.

2 Remove the memory and Mini-Card cover. See "Removing the Memory 
and Mini-Card Cover" on page 168.

 NOTE: Memory modules purchased from Dell are covered under your Tablet-PC 
warranty.

 NOTICE: To prevent damage to the memory module connector, do not use tools to 
spread the memory-module securing clips.

3 Ground yourself by touching one of the metal connectors on the back of 
the Tablet-PC. 

4 Use your fingertips to carefully spread apart the securing clips on each end 
of the memory module connector until the module pops up. 

5 Remove the module from the connector and set aside.

Installing a Memory Module
1 Ground yourself by touching one of the metal connectors on the back of 

the Tablet-PC. 

 NOTE: If the memory module is not installed properly, the Tablet-PC may not boot 
properly. No error message indicates this failure.

2 Align the notch in the module edge connector with the tab in the 
connector slot.

3 Slide the module firmly into the slot at a 45-degree angle, and rotate the 
module down until it clicks into place. If you do not feel the click, remove 
the module and reinstall it.
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4 Replace the memory and Mini-Card cover, and tighten the two captive 
screws (see "Installing the Memory and Mini-Card Cover" on page 168).

 NOTICE: If the cover is difficult to close, remove the module and reinstall it. Forcing 
the cover to close may damage your Tablet-PC.

5 Insert the battery into the battery bay, or connect the AC adapter to your 
Tablet-PC and an electrical outlet.

6 Turn on the Tablet-PC.

As the Tablet-PC boots, it detects the additional memory and automatically 
updates the system configuration information.

To confirm the amount of memory installed in the Tablet-PC: 

• In Windows Vista, click Start , and right-click Computer→ Properties.

• In Windows XP, click Start, and right-click My Computer→ Properties.

Mini-Card
Your Tablet-PC supports a wireless wide area network (WWAN) card and a 
Wireless Local Area Network (WLAN) card; both Mini-Cards are installed 
the same way, although they have different connectors on the system board. If 
you ordered a Mini-Card with your Tablet-PC, the card is already installed.

 CAUTION: Before you begin any of the procedures in this section, follow the 
safety instructions located in the Product Information Guide.

1 tab 2 notch

1

2
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 NOTICE: To prevent damage to the system board, remove the main battery before 
you service the Tablet-PC.

Removing a Mini-Card
1 Follow the procedures in "Before You Begin" on page 155.

2 Remove the memory and Mini-Card cover. See "Removing the Memory 
and Mini-Card Cover" on page 168.

3 Ground yourself by touching one of the metal connectors on the back of 
the Tablet-PC. 

 NOTE: If you leave the area, ground yourself again when you return to the 
Tablet-PC. 

4 Disconnect the cables from the card.

 NOTE: The solid black and white cables belong to the WLAN Mini-Card if you have 
installed one, while the white-striped gray, white-striped black, and the solid gray 
cables belong to the WWAN Mini-Card you may have installed.

 NOTE: Depending on the type of Mini-Card you have, not all cables may be in use.

1 WWAN slot 2 WLAN slot

1 2
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5 Release the card by pushing the metal securing tab away from the card 
until the card pops up slightly.

1 antenna cable connectors (2) 2 Mini-Card

1

2
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6 Slide the card at a 45-degree angle out of its connector.

Installing a Mini-Card

 NOTICE: To avoid damaging the Mini-Card, never place cables on top of or under 
the card.

 NOTICE: The connectors are keyed to ensure correct insertion. If you feel 
resistance, check the connectors and realign the card.

 NOTE: Depending on the type of Mini-Card you have, not all cables may be in use.

 NOTE: Do not insert a Mobile Broadband (WWAN) network adapter into the WLAN 
card connector, or vice-versa.

 NOTE: The Mini-Card may have two or three connectors, depending on the type of 
card you ordered.

1 Move any cables out of the way to make space for the Mini-Card.

1 metal securing tabs (2) 2 Mini-Card

1

2
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2 Align the card with the connector at a 45-degree angle, and press the card 
into the connector until it clicks.

 NOTE: For more specific information about which cable to connect to which 
connector, see the documentation that came with your Mini-Card.

3 Connect the cables to the Mini-Card, ensuring that you route the cables 
correctly.

4 Replace the memory and Mini-Card cover, and tighten the two captive 
screws. See "Installing the Memory and Mini-Card Cover" on page 168.

Hinge Cover
 CAUTION: Before you begin any of the procedures in this section, follow the 

safety instructions in the Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching an unpainted metal surface (such as a 
connector on the back of the Tablet-PC).

 NOTICE: The hinge cover is fragile and can be damaged if extreme force is used. 
Be careful when removing the hinge cover. 

Removing the Hinge Cover
1 Follow the procedures in "Before You Begin" on page 155.

2 Turn the Tablet-PC top-side up, and then open the display all the way (180 
degrees) so that the display rests on your work surface.

 NOTICE: To avoid damaging the hinge cover, do not lift the cover on both sides 
simultaneously. Removing the hinge cover in a different way than described may 
cause the plastic to break.
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3 Starting on the right side of the Tablet-PC, use a plastic scribe to pry up 
the hinge cover. Lift the cover away from the Tablet-PC going from the 
right toward the left, and lay the cover aside.

Installing the Hinge Cover
1 Insert the left edge of the cover into place. 

2 Press from left to right until the cover snaps into place. 

Keyboard
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.

1 hinge cover 2 plastic scribe

3 indent

1

2

3
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 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching an unpainted metal surface (such as the 
back panel) on the Tablet-PC.

Removing the Keyboard
1 Follow the instructions in "Before You Begin" on page 155.

2 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

 NOTICE: The keycaps on the keyboard are fragile, easily dislodged, and time-
consuming to replace. Be careful when removing and handling the keyboard.

3 Remove the two M2 x 3-mm screws to either side of the rotating hinge at 
the top of the keyboard.

1 screws (2) 2 keyboard tabs (4)

3 palm rest 4 keyboard-cable pull-tab

5 keyboard-cable locking arm 6 track stick-cable locking arm

7 track stick cable

2

1

3

4

5

6
7

76 Adding and Replacing Parts



book.book  Page 177  Tuesday, May 13, 2008  5:03 PM
 NOTE: Lift the keyboard carefully in step 4 to ensure that you do not pull on the 
keyboard cable.

4 Rotate the keyboard up 45-degrees to gain access to the keyboard 
connector.

5 Lift the keyboard cable locking arm up to access the keyboard cable. Pull 
up on the keyboard cable pull-tab to remove the keyboard cable from the 
connector. (Do not pull on the keyboard cable pull-tab to disengage the 
locking arm. This will damage the connector and or the keyboard cable.)

6 Lift the connector locking arm up to access the track stick cable. Pull up on 
the track stick cable pull-tab to remove the track stick cable from the 
connector. (Do not pull on the track stick cable pull-tab to disengage the 
connector locking arm. This will damage the connector and or the 
keyboard cable.) 

7 Lift the keyboard from the computer and place it to one side.

Installing the Keyboard 

 NOTE: When you replace the keyboard, ensure that the keyboard tabs are 
completely in place to avoid scratching the palm rest.

1 Slip the track stick cable into the track stick cable connector on the system 
board and press the track stick-cable locking arm down to hold the cable in 
place. Use the pull-tabs on the track stick cable to install the track stick 
cable into the connector. 

2 Insert the keyboard cable into the keyboard cable connector on the system 
board and press the keyboard-cable locking arm down to hold the cable in 
place. Use the pull-tabs on the keyboard cable to install the keyboard cable 
into the connector. 

3 Holding the keyboard at a slight angle, insert the four metal tabs of the 
keyboard into the four metal slots of the palm rest.

4 Tighten the two M2 x 3-mm screws at the top of the keyboard.

5 Install the hinge cover (see "Installing the Hinge Cover" on page 175).

Coin-Cell Battery
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.
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 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC.

Removing the Coin-cell Battery
1 Follow the procedures in "Before You Begin" on page 155.

2 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

3 Remove the keyboard (see "Removing the Keyboard" on page 176).

4 Remove the coin-cell battery connector from the connector on the system 
board.

5 Using your fingers, pry the coin-cell battery from the system base.

Installing the Coin-Cell Battery
1 Place the battery into position, pressing firmly to affix the battery to the 

sticky tape on the base.

1 coin-cell battery connector 2 coin-cell battery

1

2
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2 Connect the coin-cell battery connector to the connector on the system 
board.

3 Install the keyboard (see "Installing the Keyboard" on page 177).

4 Install the hinge cover (see "Installing the Hinge Cover" on page 175).

Display Assembly
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC.

Removing the Display Assembly
1 Follow the procedures in "Before You Begin" on page 155.

2 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

3 Remove the keyboard (see "Removing the Keyboard" on page 176).

4 Remove any installed Mini-Cards (see "Removing a Mini-Card" on 
page 171).

5 Use the pull-tab to disconnect the display cable from the system board.
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6 Feed the Mini-Card antenna cables from the bottom through the cable 
channel to the top of the system.

7 Loosen the five M2.5 x 5-mm screws.

8 Turn the system upside-down and remove the base grip:

a Remove the two M2.5 x 5-mm screws.

1 display 2 M2.5 x 5-mm screws (5)

3 display connector pull-tab 4 display cable connector

5 antenna cables (3) 6 antenna channel

4

1

5
6

2

3
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b Pry the base grip from the back of the rotating hinge and set the base 
grip aside.

9 Turn the system top-side up, and remove the two M2.5 x 5-mm screws 
from the top of the rotating hinge.

1 base grip 2 M2.5 x 5-mm screws (2)

1

2
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10 Lift the display assembly from the base, and place the display assembly to 
one side.

Installing the Display Assembly
1 Place the display assembly on the base. 

2 Feed the Mini-Card antenna cables from the top through the antenna 
channel to the bottom of the system. 

Align the shrink tube that is wrapped around the antenna cables to the 
edge of the palm rest. Make sure the antenna cables are flat (contained 
within the recessed area) and do not overlap. Secure the antenna cables 
with the tape that was removed from the cables when removing the display 
assembly. 

 NOTE: If the cables do not lie flat in the recessed area or if they overlap the palm 
rest, then the keyboard will not sit flat on the palm rest. 

1 M2.5 x 5-mm screws (2)

1
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3 Connect the display cable to the system. When doing so, make sure that: 

• The pull-tab is lying flat in the recessed area. If the bale wire is not 
flush to the palm rest, the keyboard will not sit flat on the palm rest. 

• The LCD cable wires are flush to or below the palm rest surface so 
that the keyboard can sit flat on the palm rest. 

1 shrink tube 2 tape

3 tape recess 4 palm rest

1
2

3

4
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4 Tighten the five M2.5 x 5-mm screws.

5 Close the Tablet-PC and turn it around so that you can access the back of 
the rotating hinge.

6 Tighten the two M2.5 x 5-mm screws on the top of the rotating hinge.

1 display 2 M2.5 x 5-mm screws (5)

3 display connector pull-tab 4 display cable connector

5 antenna cables (3) 6 antenna channel

4

1

5
6

2

3
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7 Turn the Tablet-PC upside-down and install the base grip:

a Clip the base grip onto the back of the rotating hinge.

b Tighten the two M2.5 x 5-mm screws.

1 M2.5 x 5-mm screws (2)

1
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8 Install any applicable Mini-Cards (see "Installing a Mini-Card" on 
page 173).

9 Install the keyboard (see "Installing the Keyboard" on page 177).

10 Install the hinge cover (see "Installing the Hinge Cover" on page 175).

Palm Rest
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC.

Removing the Palm Rest
1 Follow the procedures in "Before You Begin" on page 155.

1 base grip 2 M2.5 x 5-mm screws (2)

1

2
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2 Remove the hard drive (see "Removing the Hard Drive" on page 160).

3 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

4 Remove the display assembly (see "Removing the Display Assembly" on 
page 179).

5 Remove the keyboard (see "Removing the Keyboard" on page 176).

6 Remove any installed Mini-Cards (see "Removing a Mini-Card" on 
page 171).

7 Disconnect the touch pad cable.

8 Turn the Tablet-PC upside down and remove the eleven M2.5 x 5-mm 
screws.

9 From the top side of the Tablet-PC, remove the four M2.5 x 5-mm screws 
labeled with a "P".
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10 Disengage the five snaps at the front of the system by using your fingers to 
pry the edge of the base away from the palm rest.

11 Turn the Tablet-PC top-side up and, lifting the front end slightly upward 
and moving in a clock-wise manner, disengage the snaps at the sides and 
back of the system.

1

2

3

4
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Installing the Palm Rest
1 Place the palm rest on top of the base, and engage the snaps around the 

palm rest edges by pressing with your fingers in a counter-clockwise 
manner.

2 Turn the Tablet-PC upside down and tighten the eleven M2.5 x 5-mm 
bottom screws.

3 Turn the Tablet-PC top-side up and tighten the five M2.5 x 5-mm screws 
labeled with a "P".

4 Connect the touch pad cable to the system board connector.

5 Install any Mini-Cards (see "Installing a Mini-Card" on page 173).

6 Install the keyboard (see "Installing the Keyboard" on page 177).

7 Install the display assembly (see "Installing the Display Assembly" on 
page 182).

8 Install the hinge cover (see "Installing the Hinge Cover" on page 175).

9 Install the hard drive (see "Installing the Hard Drive" on page 161).

System Board
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC.

Removing the System Board
1 Follow the procedures in "Before You Begin" on page 155.

2 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

1 palm rest 2 base

3 touch pad cable-locking arm 4 touch pad cable
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3 Remove the display assembly (see "Removing the Display Assembly" on 
page 179).

4 Remove the keyboard (see "Removing the Keyboard" on page 176).

5 Remove any installed Mini-Cards (see "Removing a Mini-Card" on 
page 171).

6 Remove the palm rest (see "Removing the Palm Rest" on page 186).

7 Remove the speaker from the base:

a Disconnect the speaker cable from the speaker system board 
connector.

b Lift the speaker from the base and set the speaker aside.

8 Disconnect the wireless switch cable from the system board.

1 system board 2 M2.5 x 5 screw

3 pen indicator cable 4 base

5 wireless-switch cable-locking arm 6 wireless switch cable

1 2 3

5
6

4
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9 Disconnect the pen indicator cable from the system board.

10 Remove the M2.5 x 5-mm screw marked with a silver triangle.

11 Remove the system board from the base, lifting from right to left, and set 
the system board aside.

Installing the System Board
1 Seat the system board into the base from left to right.

2 Tighten the M2.5 x 5-mm screw into the screw hole marked with a silver 
triangle on the system board.

3 Connect the pen indicator cable to the system board.

4 Connect the wireless switch cable to the system board.

5 Replace the speaker module:

a Lower the speaker into the base.

b Connect the speaker cable to the speaker system board connector.

6 Install the palm rest (see "Installing the Palm Rest" on page 189).

7 Install any Mini-Cards (see "Installing a Mini-Card" on page 173).

8 Install the keyboard (see "Installing the Keyboard" on page 177).

9 Install the display assembly (see "Installing the Display Assembly" on 
page 182).

10 Install the hinge cover (see "Installing the Hinge Cover" on page 175).

Fan
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC.

Removing the Fan
1 Follow the procedures in "Before You Begin" on page 155.
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2 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

3 Remove the display assembly (see "Removing the Display Assembly" on 
page 179).

4 Remove the keyboard (see "Removing the Keyboard" on page 176).

5 Remove any installed Mini-Cards (see "Removing a Mini-Card" on 
page 171).

6 Remove the palm rest (see "Removing the Palm Rest" on page 186).

7 Remove the system board (see "Removing the System Board" on 
page 189), and place it upside-down on a clean work surface.

8 Disconnect the fan cable from the system board.

9 Using a #0 Phillips screwdriver, remove the four M2 x 3-mm screws, and 
lift the fan from the system board.

2

1

3
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Installing the Fan
1 Seat the fan into the system board, and tighten the four M2 x 3-mm screw 

using a #0 Phillips screwdriver.

2 Connect the fan cable to the system board.

3 Install the system board (see "Installing the System Board" on page 191).

4 Install the palm rest (see "Installing the Palm Rest" on page 189).

5 Install the keyboard (see "Installing the Keyboard" on page 177).

6 Install the display assembly (see "Installing the Display Assembly" on 
page 182).

7 Install the hinge cover (see "Installing the Hinge Cover" on page 175).

8 Install any Mini-Cards (see "Installing a Mini-Card" on page 173).

Pen and Whip Antenna Assembly
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC.

Removing the Pen and Whip Antenna Assembly
1 Follow the procedures in "Before You Begin" on page 155.

2 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

3 Remove the display assembly (see "Removing the Display Assembly" on 
page 179).

4 Remove the keyboard (see "Removing the Keyboard" on page 176).

1 M2 x 3-mm screws (4) 2 fan

3 fan cable connector
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5 Remove any installed Mini-Cards (see "Removing a Mini-Card" on 
page 171).

6 Remove the palm rest (see "Removing the Palm Rest" on page 186).

7 Remove the system board (see "Removing the System Board" on 
page 189).

8 Remove the two M2 x 3-mm screws.

9 Remove the pen missing cable and whip antenna cable from their routing 
channels, then lift the pen assembly and whip antenna assembly from the 
base.

1

3

5

2

4

94 Adding and Replacing Parts



book.book  Page 195  Tuesday, May 13, 2008  5:03 PM
Installing the Pen and Whip Antenna Assembly
1 Seat the pen-missing cable and whip antenna cable into their routing 

channels. Route the pen-missing cable through the base hooks by the grip 
area. Use tape to hold the cable down through the base hooks.

2 Tighten the two M2 x 3-mm screws.

3 Install the system board (see "Installing the System Board" on page 191).

4 Install the palm rest (see "Installing the Palm Rest" on page 189).

5 Install the display assembly (see "Installing the Display Assembly" on 
page 182).

6 Install any Mini-Cards (see "Installing a Mini-Card" on page 173).

7 Install the keyboard (see "Installing the Keyboard" on page 177).

8 Install the hinge cover (see "Installing the Hinge Cover" on page 175).

Wireless Switch
 CAUTION: Before performing the following procedures, follow the safety 

instructions in your Product Information Guide.

 NOTICE: To avoid electrostatic discharge, ground yourself by using a wrist 
grounding strap or by periodically touching a connector on the back panel of the 
Tablet-PC.

 NOTICE: To avoid damaging the system board, you must remove the main battery 
before you begin working inside the Tablet-PC.

Removing the Wireless Switch
1 Follow the procedures in "Before You Begin" on page 155.

2 Remove the hinge cover (see "Removing the Hinge Cover" on page 174).

3 Remove the display assembly (see "Removing the Display Assembly" on 
page 179).

1 pen and whip antenna assembly 2 pen-missing cable

3 M2 x 3-mm screws (2) 4 whip antenna cable

5 base
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4 Remove the keyboard (see "Removing the Keyboard" on page 176).

5 Remove any installed Mini-Cards (see "Removing a Mini-Card" on 
page 171).

6 Remove the palm rest (see "Removing the Palm Rest" on page 186).

7 Remove the system board (see "Removing the System Board" on 
page 189).

8 Remove the M2.5 x 5-mm screw.

9 Lift the wireless switch from the base, and set the switch aside.

1 base 2 M2.5 x 5-mm screw

1

2
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Installing the Wireless Switch
1 Set the wireless switch into the base.

2 Tighten the M2.5 x 5-mm screw. Slide the wireless On/Off switch to 
confirm that the board is connected to the base correctly. If the switch is 
too tight, then the alignment of the board to the base shifted during 
assembly. Loosen the M2.5 x 5-mm screw and confirm that the alignment 
of the bracket hole to the base hole is concentric.

3 Install any Mini-Cards (see "Installing a Mini-Card" on page 173).

4 Install the keyboard (see "Installing the Keyboard" on page 177).

5 Install the display assembly (see "Installing the Display Assembly" on 
page 182).

6 Install the hinge cover (see "Installing the Hinge Cover" on page 175).
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12
Dell™ D/Bay

 CAUTION: Before performing any of the procedures in this section, follow the 
safety instructions in your Product Information Guide.

About the Dell D/Bay
You can install Dell Latitude™ D-Family devices such as a floppy drive, hard 
drive, or optical drive using the Dell D/Bay.

Setting Up and Using the D/Bay
Connect the D/Bay cable to the powered USB connector on your Tablet-PC 
or optional media base.
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Removing and Installing Devices When the 
Tablet-PC Is Turned Off 

 NOTICE: To prevent damage to devices, place them in a safe, dry place when they 
are not installed in the computer. Avoid pressing down on them or placing heavy 
objects on top of them.

1 Press the device latch release so that the latch release pops out.

2 Pull the device by the latch release to remove the device from the D/Bay.
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3 Insert the new device into the bay, push the device until you feel a click, 
and push the device latch release in so that it is flush with the bay.

4 Connect the D/Bay cable to the powered USB connector on your 
Tablet-PC or media base.

Removing and Installing Devices While the 
Tablet-PC Is Running

1 Double-click the Safely Remove Hardware icon on the Windows 
Notification area.

2 Click the device you want to eject.

 NOTICE: To prevent damage to devices, place them in a safe, dry place when they 
are not installed in the computer. Avoid pressing down on them or placing heavy 
objects on top of them.

3 Press the device latch release so that the latch release pops out.

4 Pull the device by the latch release to remove the device from the D/Bay.
Dell™ D/Bay 201



2

book.book  Page 202  Tuesday, May 13, 2008  5:03 PM
5 Insert the new device into the bay, push the device until you feel a click, 
and push the device latch release in so that it is flush with the bay.

Windows automatically recognizes the new device.

6 If necessary, enter your password to unlock your drive.
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13
Media Base (Optional)

Left View

USB C O N N E C T O R 

O P T I C A L  D R I V E — Allows you to use CD and DVD media.

1 USB connector 2 optical drive in media bay 

The USB 2.0-compliant connector allows you to connect 
USB devices, such as a mouse, keyboard, or printer.

1 2
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Right View

USB C O N N E C T O R 

TA B L E T-PC R E L E A S E  L E V E R — Releases the Tablet-PC from the media base if the 
media base is not secured by an antitheft device.

S E C U R I T Y  C A B L E  S L O T — Lets you attach a commercially available antitheft device 
to the media base. Instructions for installing antitheft devices are usually included 
with the device. For more information, see "Securing the Media Base" on page 210.

Back View

1 USB connector 2 Tablet-PC release lever

3 security cable slot

The USB 2.0-compliant connector allows you to connect 
USB devices, such as a mouse, keyboard, or printer.

1 2 3

1 2 3 4 5 6 97 108
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TA B L E T-PC R E L E A S E  L E V E R — Lets you undock the Tablet-PC from the media base 
(see "Undocking Your Tablet-PC From the Media Base" on page 212).

AC A D A P T E R  C O N N E C T O R

1 Tablet-PC release lever 2 AC adapter connector

3 audio connector 4 IEEE 1394

5 VGA video connector 6 digital video interface (DVI) connector

7 serial connector 8 USB connector

9 powered USB connector 10 network connector

Connects an AC adapter to the media base and to AC power 
to convert AC power to the DC power required by the media 
base. You can connect the AC adapter with your media base 
either turned on or off. For more information, see "Setting 
Up Your Media Base" on page 209.

 CAUTION: If you are using a multiple-outlet power 
strip, use caution when you plug the AC adapter power 
cable into the power strip. Some power strips may 
allow you to insert the connector incorrectly. Incorrect 
insertion of the power connector could result in 
permanent damage to your media base as well as 
electric shock and/or fire. Ensure that you insert the 
ground prong of the power plug into the mating ground 
contact of the power strip.

 NOTICE: When you disconnect the AC adapter from the 
media base, hold the adapter cable connector, not the 
cable itself, and pull firmly to avoid damaging the cable.
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A U D I O  C O N N E C T O R

IEEE 1394  C O N N E C T O R  

VGA V I D E O  C O N N E C T O R  

D I G I T A L- V I D E O I N T E R F A C E  (DVI)  C O N N E C T O R 

Connect headphones or speakers. The connector is a stereo 
output connector.

Connect FireWire devices such as a camera, external hard 
drive, or external CD-ROM drive. Supports hot swapping, 
multiple speeds on the same bus, and time-based data 
transfer, providing bandwidth for multimedia operation.

Connects an external VGA monitor.

 NOTE: When your Tablet-PC is docked, use the video 
connector on the media base.

Connects an external DVI-compatible monitor, such as a 
flat-panel monitor. With an adapter cable, you can also 
connect an external VGA-compatible monitor to the DVI 
connector.
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S E R I A L  C O N N E C T O R  

USB C O N N E C T O R 

P O W E R E D USB C O N N E C T O R  

Connects a serial device, such as a serial mouse or a 
handheld device.

Connect USB devices, such as a mouse, keyboard, or 
printer.

Connect optional external D/Bay device, or standard USB 
devices, such as a mouse, keyboard, or printer.
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N E T W O R K C O N N E C T O R  

Top View

Connects the computer to a network. The solid light on 
the connector provides link status information. Off 
indicates no link, green indicates a 10-Mb/sec link, orange 
indicates a 100-Mb/sec link, and yellow indicates a 1000-
Mb/sec link. The blinking yellow light on the connector 
indicates activity on the wired network connection.

For information on using the network adapter, see the 
network adapter documentation supplied with your 
computer under Windows Help and Support. To access 
Help and Support, see "Windows Help and Support" on 
page 19.

1 docking connector

1
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D O C K I N G C O N N E C T O R — Allows you to dock your Tablet-PC to the media base (see 
"Docking Your Tablet-PC to the Media Base" on page 211 and "Undocking Your 
Tablet-PC From the Media Base" on page 212).

Setting Up Your Media Base
 CAUTION: The AC adapter works with electrical outlets worldwide. However, 

power connectors and power strips vary among countries. Using an incompatible 
cable or improperly connecting the cable to the power strip or electrical outlet 
may cause fire or equipment damage.

 NOTICE: Always use the Dell AC adapter that came with the media base. If you use 
any other commercially available AC adapter—or the AC adapter from earlier 
models of Dell computers—you may damage the media base or the Tablet-PC.

 NOTICE: When you disconnect the Dell AC adapter cable from the Tablet-PC or 
media base, grasp the connector, not the cable itself, and pull firmly but gently to 
avoid damaging the cable. When you wrap the AC adapter cable, ensure that you 
follow the angle of the connector on the AC adapter to avoid damaging the cable.

1 Connect the AC adapter to the AC adapter connector on the media base 
and to an electrical outlet.

2 Before you dock your Tablet-PC to the media base for the first time, the 
Tablet-PC operating system must have completed its setup process. Do 
the following:
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a Ensure that the Tablet-PC is not connected to the media base or to 
the battery slice (docked).

b Turn on the Tablet-PC.

c Verify that the Microsoft® Windows® desktop appears. 

d Shut down the Tablet-PC (see "Turning Off Your Tablet-PC" on 
page 155).

Securing the Media Base
 NOTE: If the Tablet-PC is docked to the media base and an antitheft device is 

attached to the security cable slot on the media base, you cannot undock the 
Tablet-PC without first removing the antitheft device.

Attach a commercially available antitheft device to the security cable slot on 
the media base.

Antitheft devices usually include a segment of metal-stranded cable with an 
attached locking device and associated key. For instructions on installing this 
kind of antitheft device, see the documentation that accompanied the device.
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Docking Your Tablet-PC to the Media Base
 NOTE: If you are docking your Tablet-PC for the first time and have not completed 

the steps in "Setting Up Your Media Base" on page 209, complete them before 
proceeding to the next step.

 NOTE: After docking the Tablet-PC for the first time, the Tablet-PC battery or the 
Tablet-PC AC adapter connection can power the media base if the media base is 
not connected to an AC adapter.

 NOTE: Your Tablet-PC should be turned off when you dock it to the media base for 
the first time.

1 Ensure that your Tablet-PC is turned off if this is the first time it is being 
docked to the media base.

2 Align the back of the Tablet-PC with the back of the media base at an 
approximately 30-degree angle, and lower the front of the Tablet-PC onto 
the media base.

1 Tablet-PC 2 media base

1

2
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3 Press the Tablet-PC onto the media base until it clicks and the Tablet-PC 
is firmly seated.

4 Turn on the Tablet-PC.

The operating system recognizes the media base.

Undocking Your Tablet-PC From the Media Base
 NOTICE: Never undock the Tablet-PC without first preparing the Tablet-PC for 

undocking. If you undock before preparing the Tablet-PC, you will lose data and the 
Tablet-PC may not recover normal operation for several minutes, if at all.

1 Before you undock your Tablet-PC, save and close any open files, and exit 
any open programs.

2 Set your Tablet-PC power management settings so that the Tablet-PC 
does not enter sleep, standby, or hibernate mode when you close (lower) 
the display:

a Click the Windows Power  icon in the Notification area to display 
the Power icon pop-up window. 

b Click More power options.

c Under the When I close the lid drop-down menu, select Do nothing.

 NOTICE: If the Tablet-PC does not have a charged battery in the battery bay, you 
must shut down the Tablet-PC through the Windows Start menu and then undock 
the Tablet-PC. If you undock the Tablet-PC without a battery before shutting it down, 
you will lose data and the Tablet-PC may not recover normal operation for several 
minutes, if at all. 

3 If your media base is secured, remove the lock.

4 Remove the AC adapter connector from the media base

5 Pull the Tablet-PC release lever forward (see "Right View" on page 204) to 
release the Tablet-PC from the media base.
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6 Lift the back of the Tablet-PC up and slide the Tablet-PC out towards the 
back of the media base.

Installing the Optical Drive in the Media Base
1 Save and close any open files or programs, and turn off the Tablet-PC (see 

"Turning Off Your Tablet-PC" on page 155).

2 Insert the optical drive into the media bay on the media base (see "Left 
View" on page 203).

3 Insert the securing screw that holds the optical drive in place.

4 Turn on the Tablet-PC.

The operating system recognizes the new drive.

Removing the Optical Drive From the Media Base
1 Save and close any open files or programs, and turn off the Tablet-PC (see 

"Turning Off Your Tablet-PC" on page 155).
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2 Remove the securing screw that secures the optical drive and use your 
screwdriver to slide the drive out of the media bay.

Media Base Specifications

Physical

Height 12.8 mm (0.50 inches)

Width 295.31 mm (11.63 inches)

Depth 222.56 mm (8.76 inches)

Weight (without optical drive) 0.488 kg (1.076 lb)

Storage

DVD-ROM (optional)

DVD+RW (optional)
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Ports and Connectors

Network connector RJ-45 port for 10/100/1000 Mbits/second 
Ethernet

USB three 4-pin USB-2.0 compliant connectors

Powered USB one 9-pin USB-2.0 compliant connector

Video 15-pin VGA connector

DVI connector 24-hole connector

Serial 9-pin connector; 16550C-compatible UART 
with 16-byte buffer

Audio headphone/speaker (line-out) mini 
connector

IEEE 1394a 4-pin serial connector

Docking 100-pin connector
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14
Battery Slice (Optional)

Top View

1 docking connector 2 power status light

3 AC adapter connector 4 release lever

1 32 4
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Bottom View

Setting Up Your Battery Slice
 CAUTION: The AC adapter works with electrical outlets worldwide. However, 

power connectors and power strips vary among countries. Using an incompatible 
cable or improperly connecting the cable to the power strip or electrical outlet 
may cause fire or equipment damage.

 NOTICE: Always use the Dell AC adapter that came with your Tablet-PC. If you use 
any other commercially available AC adapter—or the AC adapter from earlier 
models of Dell computers—you may damage the battery slice or the Tablet-PC.

 NOTICE: When you disconnect the Dell AC adapter cable from the Tablet-PC, 
grasp the connector, not the cable itself, and pull firmly but gently to avoid 
damaging the cable. When you wrap the AC adapter cable, ensure that you follow 
the angle of the connector on the AC adapter to avoid damaging the cable.

1 battery-slice status LED

1
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Connect the AC adapter to the AC adapter connector on your Tablet-PC and 
to an electrical outlet.

Docking Your Tablet-PC to the Battery Slice
 NOTE: After docking the Tablet-PC to the battery slice, the Tablet-PC AC adapter 

will also charge the battery slice. 
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1 Align the back of the Tablet-PC with the back of the battery slice at 
approximately a 30-degree angle, and lower the front of the Tablet-PC 
onto the battery slice.

2 Press the Tablet-PC onto the battery slice until you feel a click and the 
Tablet-PC is firmly seated.

3 Turn on the Tablet-PC.

The operating system recognizes the battery slice.

Undocking Your Tablet-PC From the Battery Slice
1 Before you undock your Tablet-PC from the battery slice, save and close 

any open files, and exit any open programs.

1 Tablet-PC 2 battery slice

2

1
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2 Set your Tablet-PC power management settings so that the Tablet-PC 
does not enter sleep, standby, or hibernate mode when you close (lower) 
the display:

Windows Vista

a Click Start → Control Panel→ Mobile PC→ Power Options→ 
Change what closing the lid does.

b Under the When I close the lid drop-down menu, select Do nothing.

Windows XP

a Click Start→ Control Panel→ Performance and Maintenance→ 
Power Options→ Advanced.

b Under the When I close the lid of my portable computer, select Do 
nothing. 

3 Pull the Tablet-PC release lever (see "Bottom View" on page 218) to release 
the Tablet-PC from the battery slice.

4 Lift the back of the Tablet-PC up and slide the Tablet-PC out towards the 
back of the battery slice.
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Charging Your Battery Slice
You can recharge your battery slice independent of the Tablet-PC using the 
AC adapter that shipped with your Tablet-PC. Your battery slice will also 
recharge whenever it is docked to the Tablet-PC and the Tablet-PC is 
attached to the electrical outlet using the AC adapter. See "Battery Slice 
Power Status LED Codes" on page 222 for more information on the battery-
slice power-status codes.

Battery-Slice Power-Status LED
Your battery slice includes a power status LED that can indicate the following 
states:

Battery Slice Power Status LED Codes

Battery Slice Specifications

LED Codes Status

Blinking amber, off, blue, off, amber, 
off, blue, off

You are trying to use an unsupported, non-
Dell AC adapter to power your tablet-PC. 

Blinking amber, off, amber, off, 
amber, off, amber, off, long blue, long 
off

Temporary battery failure with AC adapter 
present.

Blinking amber, off, amber, off, 
amber, off, amber, off

Fatal battery failure with AC adapter 
present.

LED off Battery in full charge mode with AC adapter 
present.

Steady blue light Battery in charge mode with AC adapter 
present.

Physical

Height 8.5 mm (0.33 inches)

Width 295.32 mm (11.63 inches)

Depth 213.32 mm (8.4 inches)
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Weight 0.60 kg (1.32 lb)

AC Adapter

Input voltage 100–240 VAC

Input current (maximum) 1.5 A

Input frequency 50–60 Hz

Output current (maximum) 3.34 A

Output power 65 W

Rated output voltage 19.5 VDC

Dimensions and weight:

Height 28.3 mm (1.11 inches)

Width 57.8 mm (2.28 inches)

Depth 137.2 mm (5.40 inches)

Weight (with cables) 0.36 kg (.79 lb)

Ports and Connectors

Docking 100-pin connector

Physical
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15
Traveling With Your Tablet-PC

 NOTICE: To avoid damaging your display, ensure that your Tablet-PC is in notebook 
mode and that the display is closed when you travel.

Identifying Your Tablet-PC
• Attach a name tag or business card to the Tablet-PC.

• Write down your Service Tag and store it in a safe place away from the 
Tablet-PC or carrying case. Use the Service Tag if you need to report a loss 
or theft to law enforcement officials and to Dell.

• Create a file on the Microsoft® Windows® desktop called if_found. Place 
information such as your name, address, and phone number in this file.

• Contact your credit card company and ask if it offers coded identification 
tags.

Packing the Tablet-PC
• Remove any external devices attached to the Tablet-PC and store them in 

a safe place.

• To make the Tablet-PC as light as possible, replace any devices installed in 
the media bay with the Dell TravelLite™ module.

• Fully charge the main battery and any spare batteries that you plan to carry 
with you.

• Shut down the Tablet-PC.

• Disconnect the AC adapter.

 NOTICE: When the display is closed, extraneous items on the keyboard or palm 
rest could damage the display.

• Remove any extraneous items, such as paper clips, pens, and paper, from 
the keyboard and palm rest and close the display.
Traveling With Your Tablet-PC 225



2

book.book  Page 226  Tuesday, May 13, 2008  5:03 PM
• Use the optional Dell™ carrying case to pack the Tablet-PC and its 
accessories together safely.

• Avoid packing the Tablet-PC with items such as shaving cream, colognes, 
perfumes, or food.

 NOTICE: If the Tablet-PC has been exposed to extreme temperatures, allow it to 
acclimate to room temperature for 1 hour before turning it on.

• Protect the Tablet-PC, the batteries, and the hard drive from hazards such 
as extreme temperatures and overexposure to sunlight, dirt, dust, or 
liquids.

• Pack the Tablet-PC so that it does not slide around in the trunk of your car 
or in an overhead storage compartment.

Travel Tips
 NOTICE: Do not move the Tablet-PC while using the optical drive to prevent loss of 

data.

 NOTICE: Do not check the Tablet-PC as baggage.

• Consider disabling wireless activity on your Tablet-PC to maximize battery 
operating time. To disable wireless activity, use the wireless switch (see 
"Enabling/Disabling the Dell Mobile Broadband Card" on page 108).

• Consider changing your power management options to maximize battery 
operating time (see "Configuring Power Management Settings" on 
page 79).

• If you are traveling internationally, carry proof of ownership—or of your 
right to use the Tablet-PC if it is company-owned—to speed your passage 
through customs. Investigate the customs regulations of the countries you 
plan to visit, and consider acquiring an international carnet (also known as 
a merchandise passport) from your government.

• Find out what type of electrical outlets are used in the countries you will 
visit, and have appropriate power adapters.

• Check with your credit card company for information about the kinds of 
emergency travel assistance it offers to users of portable computers.
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Traveling by Air
 NOTICE: Do not walk the Tablet-PC through a metal detector. Send the Tablet-PC 

through an X-ray machine or have it hand-inspected.

• Ensure that you have a charged battery available in case you are asked to 
turn on the Tablet-PC.

• Prior to entering the airplane, verify that using a Tablet-PC is permitted. 
Some airlines forbid the use of electronic devices during flight. All airlines 
forbid the use of electronic devices during takeoff and landing.
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16
Appendix

FCC Notice (U.S. Only)

FCC Class B
This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the manufacturer’s instruction 
manual, may cause interference with radio and television reception. This 
equipment has been tested and found to comply with the limits for a Class B 
digital device pursuant to Part 15 of the FCC Rules. 

This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: 

1 This device may not cause harmful interference. 

2 This device must accept any interference received, including interference 
that may cause undesired operation. 

 NOTICE: The FCC regulations provide that changes or modifications not expressly 
approved by Dell Inc. could void your authority to operate this equipment. 

These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does 
cause harmful interference with radio or television reception, which can be 
determined by turning the equipment off and on, you are encouraged to try 
to correct the interference by one or more of the following measures: 

• Reorient the receiving antenna.

• Relocate the system with respect to the receiver.

• Move the system away from the receiver.

• Plug the system into a different outlet so that the system and the receiver 
are on different branch circuits. 

If necessary, consult a representative of Dell Inc. or an experienced 
radio/television technician for additional suggestions. 
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The following information is provided on the device or devices covered in this 
document in compliance with the FCC regulations: 

• Product name: Dell™ Latitude™ XT

• Model number: PP12S

• Company name:
Dell Inc.
Worldwide Regulatory Compliance & Environmental Affairs
One Dell Way
Round Rock, TX 78682 USA
512-338-4400

 NOTE: For further regulatory information, see your Product Information Guide. 

Macrovision Product Notice
This product incorporates copyright protection technology that is protected 
by method claims of certain U.S. patents and other intellectual property 
rights owned by Macrovision Corporation and other rights owners. Use of this 
copyright protection technology must be authorized by Macrovision 
Corporation, and is intended for home and other limited viewing uses only 
unless otherwise authorized by Macrovision Corporation. Reverse engineering 
or disassembly is prohibited.
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Glossary
Terms in this Glossary are provided for informational purposes only and may 
or may not describe features included with your particular Tablet-PC.

A
AC — alternating current — The form of electricity that powers your computer when 
you plug the AC adapter power cable in to an electrical outlet.

ACPI — advanced configuration and power interface — A power management 
specification that enables Microsoft® Windows® operating systems to put a computer 
in sleep or hibernate mode to conserve the amount of electrical power allocated to 
each device attached to the computer.

AGP — accelerated graphics port — A dedicated graphics port that allows system 
memory to be used for video-related tasks. AGP delivers a smooth, true-color video 
image because of the faster interface between the video circuitry and the computer 
memory.

AHCI — Advanced Host Controller Interface — An interface for a SATA hard drive 
Host Controller which allows the storage driver to enable technologies such as Native 
Command Queuing (NCQ) and hot plug.

ambient light sensor — A feature that helps to control display brightness.

antivirus software — A program designed to identify, quarantine, and/or delete viruses 
from your computer.

ASF — alert standards format — A standard to define a mechanism for reporting 
hardware and software alerts to a management console. ASF is designed to be 
platform- and operating system-independent.

B
battery life span — The length of time (years) during which a portable computer 
battery is able to be depleted and recharged.

battery operating time — The length of time (minutes or hours) that a portable 
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computer battery powers the computer.

biometric reader — A strip sensor that uses your unique fingerprint to authenticate 
your user identity to help secure your computer. 

BIOS — basic input/output system — A program (or utility) that serves as an 
interface between the computer hardware and the operating system. Unless you 
understand what effect these settings have on the computer, do not change them. Also 
referred to as system setup.

bit — The smallest unit of data interpreted by your computer.

Blu-ray Disc™ (BD)— An optical storage technology offering storage capacity of up 
to 50 GB, full 1080p video resolution (HDTV required), and as many as 7.1 channels 
of native, uncompressed surround sound.

Bluetooth® wireless technology — A wireless technology standard for short-range 
(9 m [29 feet]) networking devices that allows for enabled devices to automatically 
recognize each other.

boot sequence — Specifies the order of the devices from which the computer 
attempts to boot.

bootable media — A CD or DVD that you can use to start your computer. In case your 
hard drive is damaged or your computer has a virus, ensure that you always have a 
bootable CD or DVD available. Your Drivers and Utilities media is an example of 
bootable media.

bps — bits per second — The standard unit for measuring data transmission speed.

BTU — British thermal unit — A measurement of heat output.

bus — A communication pathway between the components in your computer.

bus speed — The speed, given in MHz, that indicates how fast a bus can transfer 
information.

byte — The basic data unit used by your computer. A byte is usually equal to 8 bits.

C
C — Celsius — A temperature measurement scale where 0° is the freezing point and 
100° is the boiling point of water.

cache — A special high-speed storage mechanism which can be either a reserved 
section of main memory or an independent high-speed storage device. The cache 
enhances the efficiency of many processor operations. See also L1 cache and L2 cache. 

CCFL — Cold Cathode Fluorescent Lamp— A type of bulb used to illuminate liquid 
crystal displays, such as those used in notebook computers. CCFLs are able to provide 
very bright white light without generating high temperatures detrimental to many 
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computer components.

carnet — An international customs document that facilitates temporary imports into 
foreign countries. Also known as a merchandise passport.

CD-R — CD recordable — A recordable version of a CD. Data can be recorded only 
once onto a CD-R. Once recorded, the data cannot be erased or written over.

CD-RW — CD rewritable — A rewritable version of a CD. Data can be written to a 
CD-RW disc, and then erased and written over (rewritten).

CD-RW drive — A drive that can read CDs and write to CD-RW (rewritable CDs) 
and CD-R (recordable CDs) discs. You can write to CD-RW discs multiple times, but 
you can write to CD-R discs only once.

CD-RW/DVD drive — A drive, sometimes referred to as a combo drive, that can read 
CDs and DVDs and write to CD-RW (rewritable CDs) and CD-R (recordable CDs) 
discs. You can write to CD-RW discs multiple times, but you can write to CD-R discs 
only once.

clock speed — The speed, given in MHz, that indicates how fast computer 
components that are connected to the system bus operate. 

CMOS — A type of electronic circuit. Computers use a small amount of battery-
powered CMOS memory to hold date, time, and system setup options. 

COA — Certificate of Authenticity — The Windows alpha-numeric code located on a 
sticker on your computer. Also referred to as the Product Key or Product ID.

Control Panel — A Windows utility that allows you to modify operating system and 
hardware settings, such as display settings.

controller — A chip that controls the transfer of data between the processor and 
memory or between the processor and devices.

CRIMM — continuity rambus in-line memory module — A special module that has 
no memory chips and is used to fill unused RIMM slots.

cursor — The marker on a display or screen that shows where the next keyboard, touch 
pad, or mouse action will occur. It often is a blinking solid line, an underline character, 
or a small arrow.

D
DDR SDRAM — double-data-rate SDRAM — A type of SDRAM that doubles the 
data burst cycle, improving system performance.

DDR2 SDRAM — double-data-rate 2 SDRAM — A type of DDR SDRAM that uses a 
4-bit prefetch and other architectural changes to boost memory speed to over 400 
MHz.
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device — Hardware such as a disk drive, printer, or keyboard that is installed in or 
connected to your computer.

device driver — See driver.

DIMM — dual in-line memory module — A circuit board with memory chips that 
connects to a memory module on the system board.

DIN connector — A round, six-pin connector that conforms to DIN (Deutsche 
Industrie-Norm) standards; it is typically used to connect PS/2 keyboard or mouse 
cable connectors.

disk striping — A technique for spreading data over multiple disk drives. Disk striping 
can speed up operations that retrieve data from disk storage. Computers that use disk 
striping generally allow the user to select the data unit size or stripe width. 

DMA — direct memory access — A channel that allows certain types of data transfer 
between RAM and a device to bypass the processor.

docking device — provides port replication, cable management, and security features 
to adapt your notebook to a desktop workspace.

DMTF — Distributed Management Task Force — A consortium of hardware and 
software companies who develop management standards for distributed desktop, 
network, enterprise, and Internet environments.

domain — A group of computers, programs, and devices on a network that are 
administered as a unit with common rules and procedures for use by a specific group 
of users. A user logs on to the domain to gain access to the resources.

DRAM — dynamic random-access memory — Memory that stores information in 
integrated circuits containing capacitors.

driver — Software that allows the operating system to control a device such as a 
printer. Many devices do not work properly if the correct driver is not installed in the 
computer.

DSL — Digital Subscriber Line — A technology that provides a constant, high-speed 
Internet connection through an analog telephone line. 

dual-core — A technology in which two physical computational units exist inside a 
single processor package, thereby increasing computing efficiency and multi-tasking 
ability.

dual display mode — A display setting that allows you to use a second monitor as an 
extension of your display. Also referred to as extended display mode.

DVD-R — DVD recordable — A recordable version of a DVD. Data can be recorded 
only once onto a DVD-R. Once recorded, the data cannot be erased or written over.

DVD+RW — DVD rewritable — A rewritable version of a DVD. Data can be written 
to a DVD+RW disc, and then erased and written over (rewritten). (DVD+RW 
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technology is different from DVD-RW technology.)

DVD+RW drive — drive that can read DVDs and most CD media and write to 
DVD+RW (rewritable DVDs) discs.

DVI — digital video interface — A standard for digital transmission between a 
computer and a digital video display.

E
ECC — error checking and correction — A type of memory that includes special 
circuitry for testing the accuracy of data as it passes in and out of memory.

ECP — extended capabilities port — A parallel connector design that provides 
improved bidirectional data transmission. Similar to EPP, ECP uses direct memory 
access to transfer data and often improves performance.

EIDE — enhanced integrated device electronics — An improved version of the IDE 
interface for hard drives and CD drives.

EMI — electromagnetic interference — Electrical interference caused by 
electromagnetic radiation.

ENERGY STAR® — Environmental Protection Agency requirements that decrease 
the overall consumption of electricity.

EPP — enhanced parallel port — A parallel connector design that provides 
bidirectional data transmission.

ESD — electrostatic discharge — A rapid discharge of static electricity. ESD can 
damage integrated circuits found in computer and communications equipment.

expansion card — A circuit board that installs in an expansion slot on the system 
board in some computers, expanding the capabilities of the computer. Examples 
include video, modem, and sound cards.

expansion slot — A connector on the system board (in some computers) where you 
insert an expansion card, connecting it to the system bus.

ExpressCard — A removable I/O card adhering to the PCMCIA standard. Modems 
and network adapters are common types of ExpressCards. ExpressCards support both 
the PCI Express and USB 2.0 standard.

Express Service Code — A numeric code located on a sticker on your Dell™ 
computer. Use the Express Service Code when contacting Dell for assistance. Express 
Service Code service may not be available in some countries.

extended display mode — A display setting that allows you to use a second monitor as 
an extension of your display. Also referred to as dual display mode.

extended PC Card — A PC Card that extends beyond the edge of the PC Card slot 
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when installed.

F
Fahrenheit — A temperature measurement scale where 32° is the freezing point and 
212° is the boiling point of water.

FBD — fully-buffered DIMM — A DIMM with DDR2 DRAM chips and an 
Advanced Memory Buffer (AMB) that speeds communication between the DDR2 
SDRAM chips and the system.

FCC — Federal Communications Commission — A U.S. agency responsible for 
enforcing communications-related regulations that state how much radiation 
computers and other electronic equipment can emit.

folder — A term used to describe space on a disk or drive where files are organized and 
grouped. Files in a folder can be viewed and ordered in various ways, such as 
alphabetically, by date, and by size.

format — The process that prepares a drive or disk for file storage. When a drive or 
disk is formatted, the existing information on it is lost.

FSB — front side bus — The data path and physical interface between the processor 
and RAM.

FTP — file transfer protocol — A standard Internet protocol used to exchange files 
between computers connected to the Internet.

G
G — gravity — A measurement of weight and force.

GB — gigabyte — A measurement of data storage that equals 1024 MB 
(1,073,741,824 bytes). When used to refer to hard drive storage, the term is often 
rounded to 1,000,000,000 bytes.

GHz — gigahertz — A measurement of frequency that equals one thousand million 
Hz, or one thousand MHz. The speeds for computer processors, buses, and interfaces 
are often measured in GHz.

graphics mode — A video mode that can be defined as x horizontal pixels by y vertical 
pixels by z colors. Graphics modes can display an unlimited variety of shapes and 
fonts.

GUI — graphical user interface — Software that interacts with the user by means of 
menus, windows, and icons. Most programs that operate on the Windows operating 
systems are GUIs.
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H
hard drive — A drive that reads and writes data on a hard disk. The terms hard drive 
and hard disk are often used interchangeably.

heat sink — A metal plate on some processors that helps dissipate heat.

hibernate mode — A power management mode that saves everything in memory to a 
reserved space on the hard drive and then turns off the computer. When you restart 
the computer, the memory information that was saved to the hard drive is 
automatically restored.

HTTP — hypertext transfer protocol — A protocol for exchanging files between 
computers connected to the Internet. 

Hyper-Threading — Hyper-Threading is an Intel technology that can enhance overall 
computer performance by allowing one physical processor to function as two logical 
processors, capable of performing certain tasks simultaneously.

Hz — hertz — A unit of frequency measurement that equals 1 cycle per second. 
Computers and electronic devices are often measured in kilohertz (kHz), megahertz 
(MHz), gigahertz (GHz), or terahertz (THz).

I
IC — integrated circuit — A semiconductor wafer, or chip, on which thousands or 
millions of tiny electronic components are fabricated for use in computer, audio, and 
video equipment. 

IDE — integrated device electronics — An interface for mass storage devices in which 
the controller is integrated into the hard drive or CD drive.

IEEE 1394 — Institute of Electrical and Electronics Engineers, Inc. — A high-
performance serial bus used to connect IEEE 1394-compatible devices, such as digital 
cameras and DVD players, to the computer. 

infrared sensor — A port that allows you to transfer data between the computer and 
infrared-compatible devices without using a cable connection.

integrated — Usually refers to components that are physically located on the 
computer’s system board. Also referred to as built-in.

I/O — input/output — An operation or device that enters and extracts data from your 
computer. Keyboards and printers are I/O devices. 

I/O address — An address in RAM that is associated with a specific device (such as a 
serial connector, parallel connector, or expansion slot) and allows the processor to 
communicate with that device.

IrDA — Infrared Data Association — The organization that creates international 
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standards for infrared communications.

IRQ — interrupt request — An electronic pathway assigned to a specific device so 
that the device can communicate with the processor. Each device connection must be 
assigned an IRQ. Although two devices can share the same IRQ assignment, you 
cannot operate both devices simultaneously.

ISP — Internet service provider — A company that allows you to access its host server 
to connect directly to the Internet, send and receive e-mail, and access websites. The 
ISP typically provides you with a software package, user name, and access phone 
numbers for a fee. 

K
Kb — kilobit — A unit of data that equals 1024 bits. A measurement of the capacity of 
memory integrated circuits.

KB — kilobyte — A unit of data that equals 1024 bytes but is often referred to as 1000 
bytes.

key combination — A command requiring you to press multiple keys at the same 
time.

kHz — kilohertz — A measurement of frequency that equals 1000 Hz.

L
L1 cache — Primary cache stored inside the processor. 
L2 cache — Secondary cache which can either be external to the processor or 
incorporated into the processor architecture.

LAN — local area network — A computer network covering a small area. A LAN 
usually is confined to a building or a few nearby buildings. A LAN can be connected to 
another LAN over any distance through telephone lines and radio waves to form a 
wide area network (WAN).

LCD — liquid crystal display — The technology used by portable computer and flat-
panel displays.

LED — light-emitting diode — An electronic component that emits light to indicate 
the status of the computer.

local bus — A data bus that provides a fast throughput for devices to the processor.

LPT — line print terminal — The designation for a parallel connection to a printer or 
other parallel device. 
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M
Mb — megabit — A measurement of memory chip capacity that equals 1024 Kb.

Mbps — megabits per second — One million bits per second. This measurement is 
typically used for transmission speeds for networks and modems.

MB — megabyte — A measurement of data storage that equals 1,048,576 bytes. 1 MB 
equals 1024 KB. When used to refer to hard drive storage, the term is often rounded to 
1,000,000 bytes.

MB/sec — megabytes per second — One million bytes per second. This measurement 
is typically used for data transfer ratings.

media bay — A bay that supports devices such as optical drives, a second battery, or a 
Dell TravelLite™ module.

memory — A temporary data storage area inside your computer. Because the data in 
memory is not permanent, it is recommended that you frequently save your files while 
you are working on them, and always save your files before you shut down the 
computer. Your computer can contain several different forms of memory, such as 
RAM, ROM, and video memory. Frequently, the word memory is used as a synonym 
for RAM.

memory address — A specific location where data is temporarily stored in RAM.

memory mapping — The process by which the computer assigns memory addresses to 
physical locations at start-up. Devices and software can then identify information that 
the processor can access.

memory module — A small circuit board containing memory chips, which connects to 
the system board.

MHz — megahertz — A measure of frequency that equals 1 million cycles per second. 
The speeds for computer processors, buses, and interfaces are often measured in MHz.

Mini PCI — A standard for integrated peripheral devices with an emphasis on 
communications such as modems and NICs. A Mini PCI card is a small external card 
that is functionally equivalent to a standard PCI expansion card.

Mini-Card — A small card designed for integrated peripherals, such as 
communication NICs. The Mini-Card is functionally equivalent to a standard PCI 
expansion card.

modem — A device that allows your computer to communicate with other computers 
over analog telephone lines. Three types of modems include: external, PC Card, and 
internal. You typically use your modem to connect to the Internet and exchange e-
mail.

module bay — See media bay.
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MP — megapixel — A measure of image resolution used for digital cameras.

ms — millisecond — A measure of time that equals one thousandth of a second. 
Access times of storage devices are often measured in ms.

N
network adapter — A chip that provides network capabilities. A computer may 
include a network adapter on its system board, or it may contain a PC Card with an 
adapter on it. A network adapter is also referred to as a NIC (network interface 
controller).

NIC — See network adapter.

notification area — The section of the Windows Notification area that contains icons 
for providing quick access to programs and computer functions, such as the clock, 
volume control, and print status. Also referred to as system tray.

ns — nanosecond — A measure of time that equals one billionth of a second.

NVRAM — nonvolatile random access memory — A type of memory that stores data 
when the computer is turned off or loses its external power source. NVRAM is used for 
maintaining computer configuration information such as date, time, and other system 
setup options that you can set.

O
optical drive — A drive that uses optical technology to read or write data from CDs, 
DVDs, or DVD+RWs. Example of optical drives include CD drives, DVD drives, CD-
RW drives, and CD-RW/DVD combo drives. 

P
parallel connector — An I/O port often used to connect a parallel printer to your 
computer. Also referred to as an LPT port.

partition — A physical storage area on a hard drive that is assigned to one or more 
logical storage areas known as logical drives. Each partition can contain multiple 
logical drives.

PC Card — A removable I/O card adhering to the PCMCIA standard. Modems and 
network adapters are common types of PC Cards.

PCI — peripheral component interconnect — PCI is a local bus that supports 32-and 
64-bit data paths, providing a high-speed data path between the processor and devices 
such as video, drives, and networks.
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PCI Express — A modification to the PCI interface that boosts the data transfer rate 
between the processor and the devices attached to it. PCI Express can transfer data at 
speeds from 250 MB/sec to 4 GB/sec. If the PCI Express chip set and the device are 
capable of different speeds, they will operate at the slower speed.

PCMCIA — Personal Computer Memory Card International Association — The 
organization that establishes standards for PC Cards.

pen — Input device used to enter data into a Tablet-PC or other slate device.

PIO — programmed input/output — A method of transferring data between two 
devices through the processor as part of the data path.

pixel — A single point on a display screen. Pixels are arranged in rows and columns to 
create an image. A video resolution, such as 800 x 600, is expressed as the number of 
pixels across by the number of pixels up and down.

Plug-and-Play — The ability of the computer to automatically configure devices. Plug 
and Play provides automatic installation, configuration, and compatibility with 
existing hardware if the BIOS, operating system, and all devices are Plug and Play 
compliant.

POST — power-on self-test — Diagnostics programs, loaded automatically by the 
BIOS, that perform basic tests on the major computer components, such as memory, 
hard drives, and video. If no problems are detected during POST, the computer 
continues the start-up.

processor — A computer chip that interprets and executes program instructions. 
Sometimes the processor is referred to as the CPU (central processing unit).

PS/2 — personal system/2 — A type of connector for attaching a PS/2-compatible 
keyboard, mouse, or keypad.

PXE — pre-boot execution environment — A WfM (Wired for Management) 
standard that allows networked computers that do not have an operating system to be 
configured and started remotely.

R
RAID — redundant array of independent disks — A method of providing data 
redundancy. Some common implementations of RAID include RAID 0, RAID 1, 
RAID 5, RAID 10, and RAID 50.

RAM — random-access memory — The primary temporary storage area for program 
instructions and data. Any information stored in RAM is lost when you shut down your 
computer.

readme file — A text file included with a software package or hardware product. 
Typically, readme files provide installation information and describe new product 
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enhancements or corrections that have not yet been documented.

read-only — Data and/or files you can view but cannot edit or delete. A file can have 
read-only status if:

• It resides on a physically write-protected CD or DVD.

• It is located on a network in a directory and the system administrator has assigned 
rights only to specific individuals.

refresh rate — The frequency, measured in Hz, at which your screen's horizontal lines 
are recharged (sometimes also referred to as its vertical frequency). The higher the 
refresh rate, the less video flicker can be seen by the human eye.

resolution — The sharpness and clarity of an image produced by a printer or displayed 
on a monitor. The higher the resolution, the sharper the image.

RFI — radio frequency interference — Interference that is generated at typical radio 
frequencies, in the range of 10 kHz to 100,000 MHz. Radio frequencies are at the 
lower end of the electromagnetic frequency spectrum and are more likely to have 
interference than the higher frequency radiations, such as infrared and light.

ROM — read-only memory — Memory that stores data and programs that cannot be 
deleted or written to by the computer. ROM, unlike RAM, retains its contents after 
you shut down your computer. Some programs essential to the operation of your 
computer reside in ROM.

RPM — revolutions per minute — The number of rotations that occur per minute. 
Hard drive speed is often measured in rpm.

RTC — real time clock — Battery-powered clock on the system board that keeps the 
date and time after you shut down the computer.

RTCRST — real-time clock reset — A jumper on the system board of some computers 
that can often be used for troubleshooting problems.

S
SAS — serial attached SCSI — A faster, serial version of the SCSI interface (as 
opposed to the original SCSI parallel architecture).

SATA — serial ATA — A faster, serial version of the ATA (IDE) interface.

ScanDisk — A Microsoft utility that checks files, folders, and the hard disk’s surface 
for errors. ScanDisk often runs when you restart the computer after it has stopped 
responding.

SCSI — small computer system interface — A high-speed interface used to connect 
devices to a computer, such as hard drives, CD drives, printers, and scanners. The 
SCSI can connect many devices using a single controller. Each device is accessed by an 
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individual identification number on the SCSI controller bus.

SDRAM — synchronous dynamic random-access memory — A type of DRAM that is 
synchronized with the optimal clock speed of the processor.

serial connector — An I/O port often used to connect devices such as a handheld 
digital device or digital camera to your computer.

Service Tag — A bar code label on your computer that identifies your computer when 
you access Dell Support at support.dell.com or when you call Dell for customer service 
or technical support.

setup program — A program that is used to install and configure hardware and 
software. The setup.exe or install.exe program comes with most Windows software 
packages. Setup program differs from system setup program.

shortcut — An icon that provides quick access to frequently used programs, files, 
folders, and drives. When you place a shortcut on your Windows desktop and double-
click the icon, you can open its corresponding folder or file without having to find it 
first. Shortcut icons do not change the location of files. If you delete a shortcut, the 
original file is not affected. Also, you can rename a shortcut icon.

SIM — Subscriber Identity Module — A SIM card contains a microchip that encrypts 
voice and data transmissions. SIM cards can be used in phones or portable computers.

smart card — A card that is embedded with a processor and a memory chip. Smart 
cards can be used to authenticate a user on computers equipped for smart cards.

S/PDIF — Sony/Philips Digital Interface — An audio transfer file format that allows 
the transfer of audio from one file to another without converting it to and from an 
analog format, which could degrade the quality of the file.

sleep mode — A power management mode that shuts down all unnecessary computer 
operations to save energy.

Strike Zone™ — Reinforced area of the platform base that protects the hard drive by 
acting as a dampening device when a computer experiences resonating shock or is 
dropped (whether the computer is on or off).

surge protectors — Prevent voltage spikes, such as those that may occur during an 
electrical storm, from entering the computer through the electrical outlet. Surge 
protectors do not protect against lightning strikes or against brownouts, which occur 
when the voltage drops more than 20 percent below the normal AC-line voltage level.

Network connections cannot be protected by surge protectors. Always disconnect the 
network cable from the network connector during electrical storms.

SVGA — super-video graphics array — A video standard for video cards and 
controllers. Typical SVGA resolutions are 800 x 600 and 1024 x 768.

The number of colors and resolution that a program displays depends on the 
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capabilities of the monitor, the video controller and its drivers, and the amount of 
video memory installed in the computer.

S-video TV-out — A connector used to attach a TV or digital audio device to the 
computer.

SXGA — super-extended graphics array — A video standard for video cards and 
controllers that supports resolutions up to 1280 x 1024.

SXGA+ — super-extended graphics array plus — A video standard for video cards and 
controllers that supports resolutions up to 1400 x 1050.

system board — The main circuit board in your computer. Also known as the 
motherboard.

system setup program— A utility that serves as an interface between the computer 
hardware and the operating system. System setup allows you to configure user-
selectable options in the BIOS, such as date and time or system password. Unless you 
understand what effect the settings have on the computer, do not change the settings 
for this program.

T
TAPI — telephony application programming interface — Enables Windows programs 
to operate with a wide variety of telephony devices, including voice, data, fax, and 
video.

text editor — A program used to create and edit files that contain only text; for 
example, Windows Notepad uses a text editor. Text editors do not usually provide 
word wrap or formatting functionality (the option to underline, change fonts, and so 
on).

TPM — trusted platform module — A hardware-based security feature that when 
combined with security software enhances network and computer security by enabling 
features such as file and e-mail protection.

travel module — A plastic device designed to fit inside the media bay of a portable 
computer to reduce the weight of the computer.

U
UAC — user account control— Microsoft Windows Vista® security feature that, when 
enabled, provides an added layer of security between user accounts and access to 
operating system settings.

UMA — unified memory allocation — System memory dynamically allocated to 
video.
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UPS — uninterruptible power supply — A backup power source used when the 
electrical power fails or drops to an unacceptable voltage level. A UPS keeps a 
computer running for a limited amount of time when there is no electrical power. UPS 
systems typically provide surge suppression and may also provide voltage regulation. 
Small UPS systems provide battery power for a few minutes to enable you to shut 
down your computer.

USB — universal serial bus — A hardware interface for a low-speed device such as a 
USB-compatible keyboard, mouse, joystick, scanner, set of speakers, printer, 
broadband devices (DSL and cable modems), imaging devices, or storage devices. 
Devices are plugged directly in to a 4-pin socket on your computer or in to a multi-port 
hub that plugs in to your computer. USB devices can be connected and disconnected 
while the computer is turned on, and they can also be daisy-chained together.

UTP — unshielded twisted pair — Describes a type of cable used in most telephone 
networks and some computer networks. Pairs of unshielded wires are twisted to protect 
against electromagnetic interference, rather than relying on a metal sheath around 
each pair of wires to protect against interference.

UXGA — ultra extended graphics array — A video standard for video cards and 
controllers that supports resolutions up to 1600 x 1200.

V
video controller — The circuitry on a video card or on the system board (in computers 
with an integrated video controller) that provides the video capabilities—in 
combination with the monitor—for your computer.

video memory — Memory that consists of memory chips dedicated to video functions. 
Video memory is usually faster than system memory. The amount of video memory 
installed primarily influences the number of colors that a program can display.

video mode — A mode that describes how text and graphics are displayed on a 
monitor. Graphics-based software, such as Windows operating systems, displays in 
video modes that can be defined as x horizontal pixels by y vertical pixels by z colors. 
Character-based software, such as text editors, displays in video modes that can be 
defined as x columns by y rows of characters.

video resolution — See resolution.

virus — A program that is designed to inconvenience you or to destroy data stored on 
your computer. A virus program moves from one computer to another through an 
infected disk, software downloaded from the Internet, or e-mail attachments. When 
an infected program starts, its embedded virus also starts.

A common type of virus is a boot virus, which is stored in the boot sectors of bootable 
media. If the bootable media is left in the drive when the computer is shut down and 
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then turned on, the computer is infected when it reads the boot sectors of the 
bootable media expecting to find the operating system. If the computer is infected, 
the boot virus may replicate itself onto all the bootable media that are read or written 
in that computer until the virus is eradicated.

V — volt — The measurement of electric potential or electromotive force. One V 
appears across a resistance of 1 ohm when a current of 1 ampere flows through that 
resistance.

W
W — watt — The measurement of electrical power. One W is 1 ampere of current 
flowing at 1 volt.

WHr — watt-hour — A unit of measure commonly used to indicate the approximate 
capacity of a battery. For example, a 66-WHr battery can supply 66 W of power for 1 
hour or 33 W for 2 hours.

wallpaper — The background pattern or picture on the Windows desktop. Change 
your wallpaper through the Windows Control Panel. You can also scan in your favorite 
picture and make it wallpaper.

WLAN — wireless local area network. A series of interconnected computers that 
communicate with each other over the air waves using access points or wireless routers 
to provide Internet access.

write-protected — Files or media that cannot be changed. Use write-protection when 
you want to protect data from being changed or destroyed.

WWAN — wireless wide area network. A wireless high-speed data network using 
cellular technology and covering a much larger geographic area than WLAN. 

WXGA — wide-aspect extended graphics array — A video standard for video cards 
and controllers that supports resolutions up to 1280 x 800.

X
XGA — extended graphics array — A video standard for video cards and controllers 
that supports resolutions up to 1024 x 768.

Z
ZIF — zero insertion force — A type of socket or connector that allows a computer 
chip to be installed or removed with no stress applied to either the chip or its socket.

Zip — A popular data compression format. Files that have been compressed with the 
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Zip format are called Zip files and usually have a filename extension of .zip. A special 
kind of zipped file is a self-extracting file, which has a filename extension of .exe. You 
can unzip a self-extracting file by double-clicking it.

Zip drive — A high-capacity floppy drive developed by Iomega Corporation that uses 
3.5-inch removable disks called Zip disks. Zip disks are slightly larger than regular 
floppy disks, about twice as thick, and hold up to 100 MB of data.
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